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&@Mulberry

Internat Mail from the Eﬂ::und

v4 ©Cyrus Daboo, 2006.

1. INTRODUCTION

Mulberry is a powerful, easyto use electronic mail (email) and calendar program that
allows you to send, access, and manage email and calendars. Mulberry also helps you
manage other related information, such ascontactinformation.

To ensure maximum compatibility with existing email servers, Mulberry usesinternet-
standard protocols: IMAP and POP3 for reading email messages, SMTP for sending email
messages, MIME for sending and receiving attachments within messages, IMSP and ACAP
for storage of preferencesand address books on a remote server, and LDAP for address
lookups. It also useshttp, WebDAV and CalDAV for storing and retrieving calendar data.

Mulberry hasbeendesigned to fully exploit the graphical user interface provided by the
Mac OS, Windows and Unix. For example, Mulberry supports drag and drop so that
selecteditems, such asmessagesaddresses,or any text, can be dragged onto other items
to facilitate copying of items from one location to another. Comprehensive ToolTips are
available throughout the program, aswell ascontextual menu support.
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2. GETTING STARTED

2.1 System Requirements

Hardware CPU

MAc OS X
Any PowerPC Mac!OS X computer.

WINDOWS
Any x86 or Pentium basedcomputer or

compatible that supports Windows NT 4,
Windows 2000or Windows XP (or higher).

UNIx
Any x86 running linux or Solaris 8, any

PowerPC running linux, or any SPARC
running Solaris 8.

Memory

Mac OS X

Mulberry requires a minimum of 7Mb when
running.

WINDOWS

Mulberry typically requires 6Mb when
running.

UNIX

Mulberry typically requires 8Mb when
running.

Network

Mulberry will work with any network
hardware that provides access to TCP/IP
services: a direct Ethernet connection, TCP/IP
running over a wireless connection, or a
modem using a protocol such as PPP or SLIP.

System Software  Version

Mac OS X

0OS X 10.3o0r later.

WINDOWS

Mulberry is supported for Windows NT 4,
Windows 2000 and Windows XP.

UNIx

Mulberry is supported for linux RedHat 5.x,
6.X, 7.X, LinuxPPC and Solaris 8.

16
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Networking MAac OS X

The standard TCP/IP stack provided with the
OS should sulffice.

WINDOWS

Mulberry requires a Win32 TCP/IP stack. The
standard TCP/IP stack provided with the OS
should suffice.

UNIX

The standard TCP/IP stack provided with the
OS should suffice.

Speech Mulberry canread aloud incoming messages
if suitable OText to SpeechO software is installe
on your system. If it is, Mulberry will display
a OSpeechO menu items in the Edit menu. If it i
not installed, the OSpeechO menu items will no
appear.

Mac OS X

The standard OTexto Speech@oftware can be
used to enable speechsupport in Mulberry.

WINDOWS

MicrosoftOsSpeechSDK software version 4.0
or 5.0is required.

UNIX
Speech is not currently supported on Unix.

2.2 Installing Mulberry

MAc OS X To install Mulberry, simply double-click the OMulberry InstallerO file on the
Mulberry CD-ROM, or the equivalent file that you downloaded from the
Internet. A standard installer will then run and give you options as to which
parts of the Mulberry distribution to install, as well as the location where it
will be installed. The OEasy InstallO option will install the application and all its
accompanying documentation. If you want to install other parts of the
distribution choose OCustom InstallO in the installer, and select the
components you want to install.

WiINDOW To install Mulberry, simply double-click the OMulberry Setup.exeQ file on the
Mulberry CD-ROM, or the equivalent file that you downloaded from the
Internet. A standard installer will then run and give you options as to which
parts of the Mulberry distribution to install, as well as the location where it
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will be installed. The OTypicalO option will install the application and all its
accompanying documentation. If you want to install other parts of the
distribution chooseOCustom( the installer, and selectthe components you
want to install.

UNIX

To install Mulberry copy the mulberry.tgz file suitable for your Unix
distribution from the CD-ROM, or the equivalent file that you downloaded
from the Internet, into your home directory. Decompressand untar it into
that directory. This will install the mulberry application into your home
directory, and also add the full set of plug-ins into the ~/.mulberry
directory.

2.3 Getting Help

Mac OS X

Mulberry makes extensive use of the Mac OS X help mechanism to provide
on-line help.

Mulberry also includes an online help facility to provide simple descriptions
of items while using the program. If the online help is not sufficient, then
consult this document for more detail.

WINDOWS

Mulberry makes extensive use Windows OToolTipsO to display brief
information about controls in windows when the cursor is positioned and
held over the control for a short while.

Mulberry also includes a Windows online help facility to provide simple
descriptions of items while using the program. If the online help is not
sufficient, then consult this document for more detail.

UNIX

Mulberry makes use of OToolTipsr buttons and other controls in the main
windows. These are displayed when the cursor is positioned and held over
the control for a short while. Mulberry also includes a basic online help
system, available via the Help menu, that displays support information and
afew common frequently asked questions. If the online help is not sufficient,
then consult this document for more detail.

2.4  Starting Mulberry

Mac OS X
WINDOWS

Mulberry can be started in one of two ways.

¥ Double-click on an existing Mulberry preferences file. This has the same
effect as dropping the preferences file onto the application icon. The
applicationOspreferencesare then taken from this file.

¥ Double-click the Mulberry application icon. If Mulberry is configured for
single-user mode, it will first look for a preferences file in the default
location. For Mac!OS X, the default location is the Library directory in the
current userOsiome directory. For Windows, the default location is the
Windows Registry. If no preferences file is found, Mulberry will present
you with an empty preferencesdialog (seepage!30),which must be
configured before Mulberry can be used. Pleaseconsult your network
supervisor or your Internet service provider (ISP)if you are unsure of

18
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the proper settings for Mulberry.

UNIX Mulberry can be started via the command line using the Omulberry®
command. Command line options can be used to launch it with documents
or URL information:

-h, --help
prints the list of command line options
-v, --version
prints the version number
-D <directory path> (default: user home directory)

location for .mulberry directory for default preferencesand
local storage of mailboxes etc

-p <file path> (default: ~/.mulberry/preferences.mbp)
preferencefile to use on startup

-u <url>
mailto url to generatea draft messageon startup

-d, --disconnect

prompt to start in disconnected mode if not already setto do
SO

If Mulberry is configured for multi-user mode, it will present a dialog (shown in Figure 1)
asking for personal details only. Your system administrator will have configured the other
preferenceinformation. After starting Mulberry in this mode, you can changethe
preferencesto suit your needsand savethem in afile for later use.

Mulberry hasbeendesigned for usein either a single-user or multi-user environment. The
majority of this guide will describe the features and preference settings available in
Mulberry in its default, single-user state. Mulberry hasa number of powerful
administrative options available to system administrators. These options are detailed in
the Mulberry AdministratorO$uide which is distributed aspart of the Mulberry
AdministratorOs Toolkgackage.

Note: If you are using a copy of Mulberry that has been pre-
configured by your system administrator or Internet service
provider, some of the features and preference settings described
in this guide may not be available to you.
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Version Mumber  4.0.0

Serial Number 51-000001
u r t Licensed to
Cyrus Daboo

Internet Mail from the Ground Urr Cyrusoft International, Inc.

Login to Server:
imsp.cyrusoft.com

User ID: vince

Password: esssssss

Connection: Secure: S5L (" Cancel ) f OK }

Figure 1 The multi-user login dialog box

Note: The multi-user login dialog may appear slightly different or
not be displayed at all depending on the preference information
set by your system administrator or Internet service provider.

2.5 Drag and Drop

Dragging and dropping is the same process you use to manipulate files and folders in the
Finder (Mac OS X) or Windows Explorer (Windows), only in Mulberry (and other
applications that support it) it canbe used to drag and drop other objectssuch astext or
graphics.

In MulberryOscase,any text that you can copy or edit can be dragged and dropped to any
other text area,be it in the samewindow, a different window or evenawindow in another
application that supports text drag and drop. You can also drag and drop items such as
messagesaddressesand groups, aswell asincoming or outgoing file attachments. For
example, a messagein a mailbox window can be dragged to another mailbox window to
copy it from one mailbox to another. There are many subtle usesof this feature in
Mulberry. For example, Mulberry can copy all the addressesin a messageinto an address
book if you drag the messageto the address book window.

For each action which you can accomplish with drag and drop, there is always an
equivalent method to achieve the sameresults. For example, text can be copied and pasted
between different locations, and messagescan be copied between mailboxes using a menu
command.
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2.6 Contextual Menus

Mulberry makes extensive use of contextual popup menus, which can be accessedoy
holding down the control key and clicking the mouse button (Mac!OS X), or by clicking
the right mouse button (Windows and Unix) in different areas of the main windows. Each
areahasits own associatedcontextual menu that can be used asa shortcut to several
frequently used menu commands.

2.7 Using a Network Connection

If Mulberry is performing atime consuming network task (for example reading alarge
message or opening a large mailbox), it will display a spinning '$ cursor (Mac!OS X), or
Ohour-glassO cursor (Windows and Unix). When this cursor is visible, you can cancel the
current network task by pressing either Escape or command-period (Mac!OS X) on the
keyboard. However, this will completely terminate the network connection with the
server. In the caseof IMAP servers (used to read email) or an IMSP server (used for
remote preferencesand address books), Mulberry will attempt to automatically log you
back in and recover its previous state. In the caseof an SMTP server, canceling the sending
of amessagewill leave the messagewindow open. You canthen attempt to send the
messageagain at a later time if you desire.
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3. BASIC CONCEPTS

Electronic mail messagesare a means of communicating text and other multimedia
information between different computers. While this may sound straightforward, the
processof getting an email messagefrom your computer to another personOsomputer is
actually quite complex. In the past, Internet email was limited to text messages.However,
modern Internet email systemsprovide for the sending of complex non-textual
information such as documents, graphics, sound, and video.

Throughout this document, the terms Oemail clientO and Oemail serverO will be used rather
frequently. An email client is simply a program, like Mulberry, that runs on your

computer and allows you to view and manipulate your email, aswell assend messagesto
other email users. An email server is a program that runs on another computer bmost
often one controlled by your network administrator or Internet service provider. The
email server, among other things, collects new messagesthat have been sentto your email
address since the last time that you read your email. The server also takes care of routing
your outgoing email to the appropriate person.

The interaction between an email client and email server is governed by a number of
different complex setsof rules, or protocols. In order for you to accessyour email, an
email client must communicate with an email server on a regular basis. The email client
sendsrequeststo the server (such as Osendme a list of new messagesO)and the server
sendsaresponseto that request. In order for this systemto work, it is essentialthat the
client and server speakthe sameOlanguageOl.lt is the responsibility of companies that
write email clients and serversto adhere to the various email-related protocols that have
beenestablished.

Similar considerations apply to managing calendaring data, and in particular sending
invitations between usersto setup a meeting.

The next few sections will describe in more detail the various ways in which Mulberry
interacts with different types of servers,aswell asthe protocols that Mulberry utilizes to
help you read, send, and manage email and calendar data effectively.

3.1 Modes of Operation

Internet clients operate in three different Omodes®hen interacting with servers.

A client is said to operate in an online mode when it maintains a constant connection to a
server. In this scenario, a userOsnailboxes or calendarsreside on the server. This mode of
operation requires that the client have constant accessto a network connection. As such,
this mode of operation may not be ideal for certain situations, such asa mobile user trying
to accesgheir data from alaptop while on an airplane. However, sincethe data is stored in
one central location, you can always accessall of it from different locations or different
computers.

Offline mode is used when the data accessed and manipulated by the client is stored on a
local computer, such as a laptop or desktop PC. A client operating in an offline mode only
needsaccessto a network connection in order to contact the server and ask for new items.
If the server has new data available for that user, it can be downloaded and stored in the
appropriate local store and the network connection is terminated. This approach is
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advantageous for userswho always accesstheir data from the same computer, or who
frequently find themselvesin situations where a network connection is not available.

Disconnected mode is a hybrid form of the online and offline modes described above. In a
disconnected mode scenario, the data exists both ason the server on alaptop or desktop
computer. The client can work in either an online mode, directly manipulating the data on
the server, or in an offline mode working with the local data. The key to disconnected
mode is that the client must also provide a meansof synchronizing server data with their
local equivalents. Becausethe two data storesare kept synchronized, disconnected mode
operations provide all of the advantages of offline and online operations.

3.2 The IMAP and POP Protocols: Accessing your Email

There are two widely-used protocols for reading and manipulating Internet email. The
major difference between thesetwo protocols lies in their support for the various modes of
operation, described in section 3.1. The IMAP protocol supports online, offline and
disconnected modes, while the POP protocol was designed to work only in an offline

mode.

3.2.1 The IMAP Protocol

The Internet MessageAccessProtocol (IMAP) is an Internet standard for the reading and
manipulation of electronic mail messages stored on a email server. An IMAP email client
such as Mulberry normally runs on a userOs personal computer, which contacts the IMAP
server and allows you to seeand manipulate your email messagesand mailboxes.

IMAP servers allow you to create and manipulate mailboxes. A mailbox is commonly a file,
stored on the IMAP server, which contains a set of messages.The IMAP server reads the
mailbox file and sends information about each message to the IMAP client, which then
displays the information to you in its own way. The IMAP server also allows a client to
read and manipulate messages in a mailbox.

Mailboxes are usually organized hierarchically on the IMAP server. This allows them to be
grouped logically according to topic. Mulberry allows you to specify different hierarchies

in which to look for mailboxes. This provides you with a method for quick accessto
groups of interesting mailboxes.

3.2.1.1 Subscriptions

IMAP clients such as Mulberry have the ability to mark a set of mailboxes as Osubscribed®
mailboxes. The IMAP client can send a specific request to the IMAP server to get the list of
subscribed mailboxes. It is up to the IMAP client to decide how to present this subscribed
mailbox list to you. Mulberry makes use of the subscribed mailboxes feature to allow you
to create a set of mailboxes that always appear at the top of the mailbox list. This is useful if
you have a setof mailboxes that you frequently use and want quick accesso in the server
window.

3.2.1.2 Extensions to IMAP

SomelMAP serverssupport avariety of standardized extensionsto the protocol. Among
the extensions Mulberry supports are accesscontrol for mailboxes, quota information for
mailboxes, and namespace information for display hierarchies.
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¥ AccessControl for mailboxes allows you to share mailboxes with other people that
have accessto your email server. You can setup privileges for mailboxes to determine
what levels of accessusershave.

¥ Quota information shows levels of resource usage on the server. For example, you
might be limited to a maximum amount of disk spaceor a maximum number of
messagesin eachmailbox.

¥ Namespace information allows Mulberry to detect all of the top-level display
hierarchies available on your email server. Mulberry has the ability to automatically list
these display hierarchies in the server window. Display hierarchies are discussed in
detail in section!5.4.4.4.

¥ Sort allows the client to have the server return the list of messagesin sorted order,
without the need for the client to download the necessarysort information required to
do the sort itself. This is a major benefit for large mailboxes. Not all the sorting methods
provided by Mulberry are available on the server, soin some casesMulberry will have
to do the sort itself, asit will if the server does not support sorting itself.

¥ Thread allows the client to have the server return the list of messagesin a hierarchical
thread order. A Othread(3 a sequenceof messagesthat are replies to an original
message.The thread sorting method groups messagesin the samethread together, and
indicates, via indentation, which messages are in reply to others in the thread, allowing
the full Oflow@f conversation on topics to be followed. As with sorting, the server-side
threading is a big advantage for large mailboxes. If threading is not available on the
server, Mulberry will do threading itself.

3.2.1.3 Disconnected Mode

While IMAP email clients typically operate in an online mode, some IMAP email clients,
such asMulberry, offer the ability to operate in disconnected mode aswell. Mulberry
allows you to specify which mailboxes from an IMAP server should be synchronized when
switching between online and disconnected modes. Mulberry will automatically create the
appropriate local mailboxes to OmirrorOthe selectedmailboxes on the IMAP email server,
as well as handle the synchronization of the local and server mailboxes automatically. Use
of disconnected mode in Mulberry is described in more detail in section!5.4.6.

3.2.2 The POP Protocol

The Post Office Protocol, version 3 (POP3) is a simpler Internet standard for downloading
email messagesfrom a email server. As mentioned previously, POP3was designed to
work only in offline mode. The only interaction that a POP3 client has with a POP3 email
server is in contacting the server and downloading new email messagesto a local disk. As
such, POP3mailboxes reside on your local computer rather than on the email server.

3.3 The MIME Protocol: Email is Not Just Text Anymore

Most users of modern email systems have received some sort of non-textual data with an
email messageban image, aword processing document, or some other type of file
attachment. The Multipurpose Internet Mail Extensions (MIME) protocol specifies a
method for encoding any data in such away that it can be transmitted from one computer
to another.
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Mac OS X Mulberry supports the use of MIME types and sub-types in conjunction with
Internet Config to ensure that files received via email are correctly mapped
to file types that the Mac!OS X will recognize.

WINDOWS Mulberry supports the use of MIME types and sub-types in conjunction with
the Windows Registry to ensure that files received via email are correctly
mapped with file extensions recognized on the local machine.

UNIx Mulberry supports the use of MIME types and sub-types provided via
configuration files in the OS.Check the Unix faq webpage for the current
details on this: http://www.mulberrymail.com/mulberry/unix/faq

3.4 The SMTP Protocol: Sending Email

The Simple Mail Transfer Protocol (SMTP) is the main Internet standard for the sending of
electronic mail messageslt doesnot provide any capability for aclient to read email
messagesMulberry usesSMTP to send email messagesthat you compose, regardless of
whether youOreusing IMAP or POP3to accessyour messages.

3.4.1 Extensions to SMTP

Some SMTP servers support various extensions,some of which Mulberry cantake
advantage of:

¥ SMTP AUTH provides a way for an SMTP client such as Mulberry to authenticate with
the SMTP server. This allows the SMTP server to know who is trying to send email and
to configure itself appropriately. A number of SMTP servers are setto prevent
Orelaying®the sending of messagesfrom someoneoutside of the Odomain®f the SMTP
server to someoneelsealso outside of the SMTP server Odomain(BMTP AUTH can be
used to verify outside sendersasbeing legitimate users of that server and turn on
relaying for those usersonly.

¥ Delivery StatusNotifications provides away for SMTP serversto notify the sender of a
messageasto the status of that message.Statusinformation is sent back to the original
sender of the messagein the form of a special notification messagethat caninclude the
whole original message,or just the headers of the original messageto help identify
which messageis being referenced. Statusinformation that can be returned is:

¥ OSuccessO!Plindicates that the message was successfully delivered to a recipientOs in-

coming mailbox.

¥ OFailureO b indicates that the message was rejected and not delivered to a recipientOs

mailbox.

¥ ObDelayO!Plindicatéisat the messagehas beendelayed en-route to the recipientOs
mailbox.

¥ SMTP SIZE provides away for the client to indicate the size of a messageabout to be
submitted, and away for the server to advertise the maximum size of messageit will
allow. If the maximum size reported by the server is larger than the size Mulberry
calculatesfor the message,Mulberry will generatean error and the messagewill not be
sent.
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3.5 The IMSP and ACAP Protocols: Remote Preference and Address Book
Storage

One of the many benefits of IMAP is that it allows you to accessall of your email, stored on
aremote server, from different locations and computers. For usersthat operate in this
mode, it also makes senseto have other email-related information stored on a remote
server. For example, having your email client saveits preferenceson a remote server
rather than on your local machine ensuresthat it will have the same settings no matter
where you are. By saving your address books on a remote server, you can guarantee that
the names, email addresses,and contact information typically stored in your addressbook
will be available to you everywhere.

The Internet MessageSupport Protocol (IMSP) is used to store preference and address
book information on aremote server. If you store your preferencesand address books on
an IMSP server, those resourceswill always be available to you, no matter what computer
you useto run Mulberry. This is particularly advantageousif you frequently use different
computers to read your email. Mulberry can be configured to use IMSP, if such a server is
available. If it is not available, preferencesand address books have to be stored locally on
eachcomputer used to run Mulberry.

In addition to storing addresseson aremote server, IMSP allows address books to be
searchedon the server and shared among groups of users. Shared address books make it
easyto setup acentralized addressbook for a group of individuals or aworkgroup, and
combined with server basedsearching, make it easyfor co-workers to find addressesof
other people in their group.

The Application Configuration Access Protocol (ACAP) is an emerging, standardized
replacement for the IMSP protocol. Like IMSP, ACAP allows for the storage and retrieval
of information such asaddressbooks and preferences,but in a more efficient and reliable
manner. Additionally, ACAP is designed to be a more general-purpose solution than
IMSP; that is, non-email applications such as web browsers can take advantage of ACAP
for remote storage of information such asbookmarks or configuration options.

When operating in disconnected mode, Mulberry hasthe ability to synchronize
preferencesand address books stored on IMSP and ACAP serverswith the equivalent local
files.

3.6 The LDAP Protocol: Directory Assistance

The Lightweight Directory Access Protocol (LDAP) allows information about individuals
and institutions to be stored and accessedrom a server. Mulberry allows you to perform
basic addresslookups using one or more specified LDAP servers.

3.7 Calendar Access

3.7.1 Introduction

Mulberry now supports calendaring and scheduling features in addition to its email and
address book capability. Calendaring was added to provide a more complete PIM
(personal information manager) solution, asoften schedulesare managed through email.
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This combination of featuresin a client is now seenasessentialin enterprise environments
to help manage activities.

As far aspossible, the calendar support in Mulberry hasbeendesigned to be consistent
with the existing email and contacts design, to provide a familiar experience for existing
users.

Mulberry usesthe iCalendar (RFC2445)data format for all local storage of calendar data,
and supplements that with XML metadata files as needed to maintain additional state
information, such as for disconnected synchronization etc. The iCalendar data files
produced by Mulberry can be used by any other calendar product that supports that
standard.

3.7.2 HTTP Web-Calendars

Mulberry supports access to calendars stored on a simple http server and accessed via http:
or webcal: URL schemes. These calendars are managed via a simple Opublish/subscribe®
model. That is, eachchangeto the calendar will overwrite the entire contents of the item
being changed, no synchronization of changesbetween the two will occur.

When webcal calendars are present, a OWeb CalendarsO account item will automatically
appear in the calendar store list, below the local account. If web calendars have never been
used, then the account will not be present, but will automatically appear the first time a
web calendar is required.

Mulberry can set itself up as the default webcal URL handler on the local machine it is
running on, in the same manner it sets itself up as the default mailto URL handler.

3.7.3 WebDAV Calendars

Mulberry supports accessto calendar hierarchies stored on a WebDAV server. Using
WebDAV it is possible to setup public, shared and private hierarchies of calendars on the
server to provide an Oenterprise€alendar solution.

Mulberry supports the WebDAV ACL (accesscontrol) capability to manage accessto the
calendar files directly on the server allowing calendars to be easily shared with others, if
needed.

Mulberry will allow disconnected operations with WebDAV calendars, so that changes can
be made to a calendar whilst offline, and then syncOdup to the server the next time an
internet connection is available.

3.7.4 CalDAV Calendars

CalDAYV is a new extension to WebDAYV that is currently being developed. It promises to
improve the performance of WebDAV stored calendars by using a new data layout (each
individual event etcis stored asa separateitem on the server) and new options to do smart
searching, event range retrieval etc on the server.

In addition, CalDAV will support server-based scheduling options, removing the need to
use email-based scheduling when usersreside on the sameserver.

Mulberry has support for CalDAV, including the use of ACLs.
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Mulberry will allow disconnected operations with CalDAV calendars, so that changes can
be made to a calendar whilst offline, and then syncOdup to the server the next time an
internet connection is available.

3.7.5 Sending and Receiving Invitations

Both events and tasks can be sentvia email to other people in a standard format that
should allow them to automatically add those items directly to their own calendars,
provided the software they use allows that - if they use Mulberry it will!

3.7.6 Calendar Disconnected Mode

Mulberry will allow you to work with calendar data whilst offline. Of course calendars in

the Local calendar account are always stored locally and accessible no matter what. http
calendar account data is also stored locally and refreshed from the server asneeded, either
automatically at sometimed interval, or manually at the explicit request of the user.
However, this processdoes not involve synchronization of data Bany changesresult in the
entire calendar being overwritten.

Both WebDAYV and CalDAV accounts support full two-way synchronization of data
between the client and server asneeded. This is enabled by turning on the OAllow
Disconnected OperatlonsOoptlon in the Options panel of the preferencesfor the account.
When this is on, all calendars in that account that are used (i.e. opened for display) will be
automatically synchronized as they are opened and used. This is different than the
approach used for email where eachmailbox can be synchronized independently of the
others. Also, the new approach meansthat an explicit OsynchronizenowOoperation is no
longer needed aslocal data is always up to date with the server.

The new model for disconnected support now also allows individual accounts to be used in
an offline mode, even when others are online. The OLoginO/OLogout@blbar button now
acts as a per-account connect/disconnect switch when the global state (as controlled via the
File menu commands) is connected. When the global state is disconnected, then all calendar
accountsare setto disconnected mode and the OLoginO/OLogoutéblbar button is disabled.

3.8 General Security Concepts

Many people donOt realize that common email protocols such as IMAP, POP3, and SMTP
dictate that personal information such asyour username, password, and the text of your
email messagesare transmitted over the Internet in clear text. A savvy Internet hacker has
the ability to intercept that information and use it for any number of illicit purposes. While
the chancesof that happening are rare, itOestto take advantage of security features
whenever possible. Mulberry offers security features in two important areas:
authentication, and PGP message security (via a separate PGP plugin). In addition, third-
party applications canbe used to provide encrypted communications between Mulberry
and any servers.

3.8.1 Authentication Security

Authentication refers to the processby which aemail client and server verify your identity.
Typically, you enter a username and password into a email client. The email client then
sendsthat information to the email server for verification. Unfortunately, this is
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commonly done using plain, unencrypted text. In addition to plain text, Mulberry offers
support for other popular authentication methods: Kerberos v4, GSSAPI (Kerberos v5),
CRAM-MD5, DIGEST-MD5 and NTLM. When you use one of these authentication
methods, your password is never transmitted in clear text over the Internet, making it
difficult (if not impossible) for a hacker to obtain this information by monitoring the traffic
between the client and server.

Mulberry supports different authentication methods by a seriesof plugins. New
authentication methods can be added by simply adding a new plugin to the Mulberry Plug-
ins folder. They will then automatically be available for use in Mulberry the next time it
starts up.

These alternate authentication methods are available for all the different protocols listed in
the sectionsabove. Note that in order to use any of thesealternative authentication
methods, your server(s) must support that method. Contact your server administrator if
youOrenot sure which authentication methods are supported by your email servers.

3.8.2 PGP Message Security

In conjunction with the Mulberry PGP or GPG Plugin, Mulberry offers seamlessintegration
with version 8 of PGP Corp.sCpopular PGP software, and the freeware GNUpg software.
In the context of email, PGP allows you to perform several important security operations.
When sending email, PGP provides mechanismsto encrypt messagesbefore sending them
as well as digitally OsignO messages so that the recipient can verify their authenticity. On
the receiving end, PGP allows you to decrypt messagesand verify a PGP signature
attached to a message. When the Mulberry PGP plugin is installed, various menu
commands and buttons will appear to provide seamless access to the signing and
encryption capabilities of PGP.

3.8.3 S/MIME Message Security

In conjunction with the Mulberry S/IMIME Plugin, Mulberry offers SIMIME cryptographic
capability. In the context of email, S/IMIME allows you to perform severalimportant
security operations. When sending email, S/MIME provides mechanisms to encrypt
messagesbefore sending them aswell asdigitally OsignOnessagesso that the recipient can
verify their authenticity. On the receiving end, S/IMIME allows you to decrypt messages
and verify an SIMIME signature attached to a message. When the Mulberry SIMIME

plugin is installed, various menu commands and buttons will appear to provide seamless
access to the signing and encryption capabilities of S/IMIME.

3.8.4 Encrypted Network Traffic (SSL)

In conjunction with the Mulberry PGP Plugin (available separately), Mulberry supports the
SecureSocketsLayer (SSL)v3 protocol and the Transport Layer Security (TLS) vl
protocols. This is the equivalent of the network security provided in web browsers and
typically used to secure financial transactions on the web.

Third-party products that run on the client and server can also provide an encrypted
Ochannelfdr sending data between a client program on one machine and a server program
on another. Such software uses a mechanism called Oport-forwardingO which allows the
third-part software to interact with the client or server program without the need for those
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programs to be specifically modified to work with them. Mulberry supports port-
forwarding software of this kind.

3.9 Read Receipts Requests

Internet email offers a standard option for sendersof email messagesto request a receipt
messagebe sent back to them when the recipient of a messagereadsit. The sender must
explicitly turn that option on in order for it to be processedby the recipient. Mulberry
supports this directly from its Draft window.

Recipients of read receipt requests can chooseat their option how to processthem.
Typically there will be three choices:never send a read receipt back (users may choosethis
if they have privacy concerns);always send a read receipt back; or provide a prompt each
time aread receipt requestis detected, allowing the user to choosewhether to send a
receipt back or not. Mulberry has preferencesto allow you to chooseeither of these
options for read receipt processing.

Sincethe return of areceipt is solely at the discretion of the recipient, there is no absolute
guarantee that if you request one, one will be returned to you when the messageis read.

3.10 Message Filtering

To cope with the large volumes of email that usersreceive these days, a popular
mechanism called filtering has been introduced and is in wide-spread use. Filtering is the
processwhereby messagesare automatically processedby some Oagentbasedon their
content, and certain actions taken. For example, messagesknow to be important, canhave
an important OflagOr indicator added to them. Messagesknow to be worthless can be
immediately deleted and removed before the user hasto seeor download them. Other
messagescan be automatically filed away into different mailboxes basedon category.

The OagentO that does the filtering is typically either the email client application, or some
process on the server. With client-side filtering, the client application has to download
enough information about the messagesto be able to determine whether and how they
should be processed.With server-side filtering, a program on the server processesthe
messagesasthey are being delivered. Server-sidefiltering takes place even when there is
no client connectedto it. The advantage of this is that the client doesnOhave to waste any
of its time doing the filtering.

Mulberry supports both client- and server-side filtering, as described in full in Section!O.
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4. CONFIGURING MULBERRY

Mulberry hasanumber of flexible configuration options. For the basic email user, the
simple preferencespanel allows quick configuration of a basic setof options necessaryto
get Mulberry up and running. More advanced email users will want to explore the
advanced preferences panel, which gives you access to all of MulberryOs powerful
configuration options b including multiple email servers, display fonts and styles, multiple
identities, and many other features.

The simple preferences panel is shown in Figure 2. The advanced preferences panel is
shown in Figure 3. For using the simple preferencesconsult the Mulberry QuickStartGuide

Someof the controls in the various preferencespanels may be disabled if Mulberry has
been pre-configured by your network administrator.
Preferences

Real Name: Vince Everrett]

Email Address:  vince@oyrusoft.com

User ID: vince
Mail Server: imap.cyrusoft.com
Server Type: @y mMaP () POP3 () Local
SMTP Server: smitp.cyruscft.com
Mew Mail Check: | Save User ID
) Never | Save Password
I!B Every: 1 mins. " Login at Startup
| Use Alert Higrarchy
separator:
Set Signature
E Copy Outgoing Messages
Default: INBOX.sent-miail [B

Figure 2 The preferencesdialog in simple mode
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— e e 1 s | Save Default |
Click a button Preference
hgre o see 3 panels are Cancel i
different panel shown here

Toopen a preferences file

from dizk, click here To save the current

preferences as the default

To save the current inthe System Folder,
preferences inafile, click here
click here

Figure 3 The preferencesdialog in advanced mode

The advanced preferencesdialog hastwo main areas:

¥ The central window pane is used for showing different panels that can be used to set
preferences.

MAc OS X To switch between panels, click on one of the buttons on the left hand

UNIX side of the dialog.

WINDOWS To switch between panels, click on one of the tabs at the top of the
dialog.
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¥ Theright hand side of the dialog contains controls used to open and save preferences
files, as well as change some universal settings.

Mulberry supports storage of preferenceseither locally, on alocal or shared hard drive, or
remotely on an IMSP or ACAP server. To switch between local and remote preferences,
click the Local or Remote radio buttons on the right-hand side of the dialog.

A setof preferencesstored in alocal file or remotely is called a OpreferenceetO.You can
have as many preference setsasyou like and switch between them by clicking the Open
button.

I For local preferences this will display a standard file dialog allowing you to choose a
local preferencefile to open.

I For remote preferencesthis will open a dialog showing you the available preference
setson the remote server, and allow you to pick one to open.

One local and one remote preference setcan be saved asthe OdefaultsetOThe default
preference setis the one opened when launching Mulberry by double-clicking its icon. To
savethe current preference setasthe default preference set,you can click the Save
Default button.

MAc OS X The default location for local preferences is the Library directory inside the
current userOfiome directory.

WINDOWS The default location for local preferencesis the Windows registry for the
current user.

UNIX The default location for local preferencesis the ~/.mulberry directory.

Closing the preferencesdialog by clicking the OK button will also savethe current
preference set. In this case,the preference setwill be savedin the samelocation from
which it was opened.

To savethe current preference setunder a different name, click the Save As... button.

I For local preferences this will bring up a standard file save dialog allowing you to
choosethe name and location for the preferencefile.

I For remote preferences,this will open adialog box listing the current preference
setsstored on the server, and allow you to enter a name for the new set.

Multiple preference setsallow you to quickly switch between setsof preferenceswhile
Mulberry is running. When you load a new preference setwhile Mulberry is running, all of
your current server connections are terminated, and new connections are established for
the various accounts defined in the new preferences file. You can switch preference sets
while Mulberry is running in two ways. First, you canusethe Open button in the
Preferencesdialog to load a new local or remote preferencefile. You canalso double-click a
local preferences file in the Finder (Mac!OS X) or the Windows Explorer (Windows).

There are currently fourteen different panelsto choosefrom in the advanced preferences
dialog, though some of these may not be present or are disabled depending on what
additional features are available to Mulberry. Each of these panels will be described in the
following subsections.
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4.1 Accounts Panel

Pleasecheck with your network supervisor or your Internet service provider (ISP)if you
are unsure of the proper settings for the Accounts panel.

Accounts Preferences
Account: imap

Type: IMAP Mailbox

cerver: |[imap.cynusoft.com

| Authentication = Options | Extras

Methad: | CRAM-MDS B

User ID: vince

: Save User ID
" | Save Password

Secure: | STARTTLS - TLSv] i+

| Use Client Certificate: =

E Match User ID and Password

Figure 4 The Accounts preference panel

The following four settings are available regardless of the type of account chosen:

Account Selectsan account for editing, createsa new account, renamesor
deletes the account currently displayed.

Type The type of account currently being displayed (not editable).
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Server The internet address of the server should be entered here. This canbe a
fully qualified name (e.g. imap.mulberrymail.com) or an IP address
(e.g.206.31.218.196)lo use a non-default port, add a O:and the port
number (e.g.imap.mulberrymail.com:146). The default port numbers
for the various protocols used by Mulberry are:

¥ IMAP D 143 (993 with SSLv3 security)
POP3 D 110 (995 with SSLv3 security)
IMSP B 406 (906 with SSLv3 security)
ACAP D 674

SMTP b 25 (993 with SSLv3 security)
LDAP B 389 (636 with SSLv3 security)
ManageSIEVE B 2000

CalDAV b 80 (443 with SSLv3 security)
¥ WebDAV D 80 (443 with SSLv3 security)

K K K K K K K

Match User ID and To have Mulberry usethe samepassword with a user ID that was used

Password before, turn this on. This allows you to enter your user ID and
password only oncewhen the user ID is the same,evenif logging in to
different types of servers.

Note: This option may produce undesirable results if
you use the sameusername but different passwords on
more than one server in the Accounts panel.

The remainder of the Accounts panel will vary depending on the type of account currently
being displayed.

4.1.1 IMAP Mailbox Account

4.1.1.1 Authentication Tab

The options available in the Authentication tab remain constant regardless of the account
type selected. The authentication methods described below are available for IMAP Mailbox
accounts and all other account types.
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[Authenticatiun Options " Extras

Method: | CRAM-MDS _*]

User ID: vince

Save User 10
Save Password

Secure: | STARTTLS - TLSv] j

E

| Use Client Certificate:

4

Figure 5 The Authentication tab for authentication methods requiring just a
user id and password

Method To choosethe authentication method to use with the current account,
click here. Mulberry currently supports Plain Text, CRAM-MD5,
DIGEST-MD5, Kerberos v4, and NTLM authentication methods. It also
supports ANONYMOUS login which does not require any additional
information.

Secure Allows you to choosebetween SSLv3and TLSv1 network security
protocols to securethe entire communications between Mulberry and
the server. You need to check with your server administrator asto
which of these options is applicable in your case.

Use Client Allows you to choose an x509 personal certificate to use with SSL to
Certificate authenticate via the SSL protocol itself. When this choice is selected you
should also select OSSL Client CertificateO in théethod popup.

The following options are only available when using an authentication method that
requires only a user id and password:

User ID The user ID required for you to log in to this server should be entered
here.

Save User ID To save the user ID in the preferences file so that it will be used the
next time Mulberry is launched with the current preferences file, turn
this on.
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Save Password To savethe your password in the preferencesfile sothat it will be used

the next time Mulberry is launched with the current preferences file,
turn this on.

WARNING: If this option is turned on, anyone with
accesso your preferencesfile will be able to read your
email. Passwords are saved in encrypted form in both
local and remote preference sets.

[Authenticatinn { Options " Extras

Method: ' Kerberos V4 ﬂ
E Use Default Server Principal
SEMVET
Principal:

@ Use Default User 1D
User ID:

Secure: | STARTTLS - TLSv] j

E

| Use Client Certificate:

4

Figure 6 The Authentication panel for Kerberos authentication

The following options are only available when using the Kerberos v4 authentication
method:

Use Default To have Mulberry discover the Kerberos server principal
Server Principal automatically, turn this on.

Server Principal The Kerberos realm of the server should be entered here.

Use Default User  To usethe default Kerberos user ID to login to the specified server
ID instead of the ID you specified in the OUser IDO field, turn this on.

User ID The user ID required for you to log in to this server should be entered
here, if OUse Default User IDO is turned off.
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4.1.1.2 Options Tab

Authentication Options Extras

" | Login at Startup

Hierarchy Separator:

"] Automatic Hierarchy List

E Allow Disconnected Operations

Figure 7 The Options tab for an IMAP Mailbox account

Login at Startup To automatically login to the selectedserver when you start Mulberry,

turn this on.
Directory The hierarchy separator character for mailbox hierarchies should be
Separator entered here (usually O/O or O.0O). If you do not fill in this field, Mulberry
will determine the correct separator.
Automatic To automatically list any display hierarchies returned by the server,
Hierarchy List turn this on. The display hierarchies will be shown in the server

window. This option only works if your server supports the IMAP
ONAMESPACEQO extension. Please see section!5.4.4.4 for a detailed
description of display hierarchies.

Allow To enable disconnected operations with this account, turn this on.

Disconnected Disconnected mode allows you to read and manipulate email from an

Operations IMAP Mailbox accountwithout being connectedto your email server.
Please see section!5.4.6 for a full description of disconnected mode
operations.
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4.1.1.3 Extras Tab

The options available in the Extras tab are available for IMAP Mailbox accounts as well as
POP3 and Local Mailbox accounts.

Authentication | Options | E:T.ms]

Account ldentity:
E Tie to ldentity

Identity: Default

48
Rl

Figure 8 The Extras tab for an IMAP Mailbox account

Tie to Identity Check this option to tie one of your identities to the selectedaccount.
For a complete description of identities, please see section!5.9.2.6.

This option allows you to specify an identity to use by default when
replying to or forwarding a messagestored in a particular email
account.

Note: You can also tie an identity to a specific mailbox. In
this case, the identity tied to the mailbox will override the
identity tied to the email account containing that mailbox.
Pleaseseesection!5.4.5.1for instructions on tying an identity
to a mailbox.
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4.1.2 POP3 Mailbox Account

4.1.2.1 Options Tab

Authentication | Options | Local " Extras

E Leave Mail on Server

" | Delete After: 0O days

| Delete after Local Expunge

" | Skip Messages Bigger than: 10 Kb

" Use APOP when Available

Figure 9 The Options tab for a POP3Mailbox Account

Leave Email on
Server

To prevent Mulberry from deleting your messagesfrom the POP3
server after downloading them, turn this on.

Delete After

If you selectthis option, Mulberry will remove messagesfrom the
selectedPOP3server after the specified number of days, rather than
deleting them immediately after downloading them.

Delete after Local
Expunge

If you selectthis option, Mulberry will remove a messagefrom the
selectedPOP3server only after the corresponding messagehas been
deleted and expunged from the local POP3 mailbox.

Skip Messages When this option is selected, Mulberry will not download messages

Bigger Than from the selected POP3 server that exceed the specified size.

Use APOP When To use the more secure APOP authentication mechanism, turn this on.

Available You must also have Plain Text selected as the authentication
mechanism for this POP3 server. APOP will only be used when the
server advertises that it is available.
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4.1.2.2 Local Tab

Authentication | Options | Local | Extras

: Use Default Location
I'E:"I specify Location:

I'E,“I Relative Path * Choose... |
: Absolute Path

Figure 10 The Local tab for a POP3Mailbox account

Use Default To store POP3 mailboxes for this account in the default location, click

Location here. The default mailbox location is determined by a setting in the
Disconnected tab of the Mailbox preference panel (seesection!4.5.3),
and can be either the Mulberry application folder or the user
documents folder defined by the operating system.

Specify Location To store POP3mailboxes in afolder other than the default location,

click here. You cantype a path in the location box or use the Choose
button to selecta directory.

Relative Path

If this item is selected,Mulberry interprets the pathname relative to the
default location. If you usethe Choose button to selecta directory,
Mulberry will determine whether relative or absolute is most
appropriate.

Absolute Path

If this item is selected,Mulberry interprets the pathname asan absolute
path. If you usethe Choose button to selecta directory, Mulberry
will determine whether relative or absolute is most appropriate.
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4.1.3 Local Mailbox Account

! Local | Extras

) Use Default Location

(@) Specify Location:

IE,"I Relative Path  Choose... |
: Absolute Path

File Format! Automatic e ]

Figure 11 The Local tab for a Local Mailbox account

Most of the options in the Local tab are identical to thosein the Local tab for a POP3
Mailbox account (seesection!4.1.2.2).However, there is one additional option available to
specify the format of the local mailboxes in this account type.

File Format Choosethe mailbox format to use for mailboxes under this account.
Available options are Automatic, Mac!OS, Windows, and UNIX. In
general, you will want to keep this setto Automatic. However, if you
set up the local mailbox account to access mailboxes on a shared disk
from a computer using a different operating system, you may need to
change the file format. Additionally, you can modify this setting if you
want to createlocal mailboxes in aformat that will allow easytransport
to a computer running a different operating system.
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4.1.4 SMTP Send Email Account

4.1.4.1 Options Tab

Authentication Dptions Local

E Use Local Quewes for Sending

Hold Messages when Added to Queue

Figure 12 The Options tab form an SMTP Send Email account

Use Local Queues
for Sending

Select this option to enable SMTP queuing. When this option is on,
Mulberry will createalocal mailbox to store outgoing email sent
through the selected SMTP account. Queued email is sent in the
background, allowing you to perform other operations within
Mulberry immediately after sending a message.

If you are operating in disconnected mode, the SMTP queue will hold
outgoing messagesuntil the next time you connectto a network. You
can manipulate the contents of the SMTP queue via the Outgoing
Queue window, described in Section!5.6.

Note: In order to use the selected SMTP account in
disconnected mode, you must have this option checked.

Hold Messages
when Added to
Queue

When this option is selected, messages will be assigned a status of
OHoldOwhen added to the SMTP queue, causing them not to be sent
immediately. For held messagesto be sent, you must manually
changethe status of the messagesin the Outgoing Queue window,
described in Section!5.6.
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4.1.5 IMSP Options Account
4.1.5.1 Options Tab

Authentication Options Sets

E Use Eemote Preferences at Startup

Figure 13 The Options tab for an IMSP Options account

Use Remote Selectthis option to usethe default preference seton the selected
Preferences on remote IMSP server instead of those stored in alocal file when starting
Startup up Mulberry.
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4.1.5.2 Sets Tab

Authentication | Options | Sats]

Remate Preference Sats

docs

gales print invoice
Single

sales

Backup

“ Refresh ' [ Rename... | [ Delete

Figure 14 The Setstab for an IMSP Options account

The Setstab allows you to view and manipulate the different preference setson the current
IMSP server. A listing of all available preference setsappearsin the Remote Preference
Setsbox. To update the listing of preference sets,click the Refresh button. The Rename
button allows you to changethe name of the currently selectedpreference set. The Delete
button will delete the currently selectedpreference set(s)from the server.

4.1.6 ACAP Options Account

The options available for an ACAP Options account are identical to those available when
using an IMSP Options account.
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4.1.7 IMSP Address Books Account

4.1.7.1 Options Tab
Authentication | Dptions ]

" | Login at Startup

@ Allow Disconnected Operations

Figure 15 The Options tab for an IMSP Address Book account

Login at Startup To set Mulberry to automatically login to the selected IMSP Address
Book server when you start the program, turn this on.

Allow To make address books in this account accessible while in disconnected
Disconnected mode, select this option. Please see section!5.4.6 for a full description of
Operations disconnected mode operations.

4.1.8 ACAP Address Books Account

The options available for an ACAP Address Book account are identical to those available
when using an IMSP Address Book account.
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4.1.9 LDAP Address Search Account

4.1.9.1 Options Tab

Authentication | Options | Attributes 1 [ Attributes 2

: Use with Address Expansion
E Lse when Searching

Figure 16 The Options tab for an LDAP Address Search account

Use with Address  To use this LDAP server when expanding addresses in Drafts, turn this
Expansion on.

Use when To use this LDAP server when doing Address searches, turn this on.
Searching
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4.1.9.2 Attr.1Tab

Authentication [ Opticns Attributes 1 Attributes 2

Root:

Mame: cn
Email: mail
Mick-name:
Address:

Company:

Figure 17 The Attributesl tab for an LDAP Address Searchaccount

Root Enter the root starting location for the LDAP search.

Name Enter the attribute value on the LDAP server that corresponds to the
name of the person being looked up. This will usually be OcnO.

Email Enter the attribute value on the LDAP server that corresponds to the
email address of the person being looked up. This will usually be OmailO

Nick-name Enter the attribute value on the LDAP server that corresponds to the
nick-name of the person being looked up.

Address Enter the attribute value on the LDAP server that corresponds to the
postal address of the person being looked up.

Company Enter the attribute value on the LDAP server that corresponds to the
company of the person being looked up.
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4.1.9.3 Attr. 2 Tab

Authentication [ Options [ Attributes 1 Attributes 2 !

Phane Waork:

Phone Home:
Fax:

URLs:

Motes:

"1 Put All Attributes in Motes

Figure 18 The Attributes? tab for an LDAP Address Searchaccount

Phone Work

Enter the attribute value on the LDAP server that corresponds to the
work telephone number of the person being looked up.

Phone Home

Enter the attribute value on the LDAP server that corresponds to the
home telephone number of the person being looked up.

Fax Enter the attribute value on the LDAP server that corresponds to the
fax number of the person being looked up.

URLs Enter the attribute value on the LDAP server that corresponds to the
URL of the person being looked up.

Notes Enter the attribute value on the LDAP server that corresponds to the
Notes field of the person being looked up. This field is disabled if you
checkthe OPutttributes in NotesQoption below.

Put Attributes in To have the full setof attributes returned by the LDAP server for an

Notes entry inserted into the address notes field, turn this on.

4.1.10 ManageSIEVE Filter Account

There are no options available for ManageSIEVEaccounts.
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4.1.11 CalDAV Calendar Account
4.1.11.1 Options Tab

Authentication | Options | Extras

E Login at Startup

E Allow Disconnected Operations

Path: fslide/files/calendars

Figure 19 The Options tab for a CalDAV Calendar account

Login at Startup To setMulberry to automatically login to the selectedCalendar server
when you start the program, turn this on.

Allow To make calendars in this account accessible while in disconnected
Disconnected mode, select this option. Please see section!5.4.6 for a full description of
Operations disconnected mode operations.

Path Enter the URL root path to the location on the server that is the top of

the calendar hierarchy.

4.1.12 WebDAYV Calendar Account

4.1.12.1 Options Tab

Same as CalDAV accounts.
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4.2 Alerts

Alerts Preferences

! Messages | Attachments .

Style: | Default - :]

’: Mever
=
__ Once on Startup

@ Every: 1 mins.

" | Use Foreground Alert

| Use Background Alert

@ Flash lcon in Background

@ Play Sound: Glass f

aw
4

@ speak: # new messages in ™
| Open Mailbox Window

Alert when Mailbox Contains:

E} Mew Messages
’: Any Messages

Apply to Cabinet: = Check Favourites I

aw
3

Figure 20 The Alerts preference panel

The Alerts preference panel allows you to define several different alert styles to apply to
different groups of mailboxes. For example, you may want to check your INBOX for new
email every five minutes, and receive notification via a sound and foreground alert. You
may also want to check another group of mailboxes, such asyour subscribed mailboxes,
lessfrequently and receive a different type of alert when new messagesarrive in those
mailboxes.

Alert styles work in conjunction with cabinets. Each alert style you create has a cabinet
associated with it. New email checking and notification takes place for mailboxes within
that cabinet according to the settings specified within the associated alert style. For a
complete description of cabinets, please see section!5.4.4.6.
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Style

This popup allows you to chooseamong the different alert styles
youOvecreated, aswell asmake changed to those styles. When you
selectan alert style using this menu, the settings for that style are
displayed. The New... option allows you to createand name a new
alert style. The Rename... option allows you to rename the currently
selectedalert style, and the Delete... option deletesthe selectedalert
style.

New Email
Checking

To enable automatic email checking, click the OEvery E minutesO option
and enter atime in minutes to specify the interval between automatic
email checks. If ONeverQ is selected, no automatic email checking will
take place. Selecting the OOnce on StartupO option causes mailboxes t
be checked only once, after you start Mulberry.

Use Foreground
Alert

To show an alert dialog when new email arrives and Mulberry is the
active application, turn this on.

Use Background
Alert

To show an alert dialog when new email arrives and Mulberry is in the
background, turn this on.

MAc OS X ONLY

Flash Icon in
Background

MAac OS X ONLY

To flash the application icon in the menu bar when new email arrives
and Mulberry is in the background, turn this on.

WINDOWS ONLY

Show Icon in Task
Bar

WINDOWS ONLY
To show the application icon in the taskbar, turn this on.

Play Sound To play a sound when new email arrives, turn this on. You can select
the sound from the list of installed system sounds using the popup
menu.

Open Mailbox To automatically open the mailbox window for any mailboxes that

Window contain new email, turn this on.

Alert when To present an alert only when amailbox is checkedand contains new

Mailbox Contains

messagesclick the New Messagesoption. To present an alert when a
mailbox is checked and contains any type of message, click the Any
Messagesoption. The type of alert presented will depend on the
settings above.

Apply To Cabinet

Select the cabinet to associate with this alert style. Mailboxes in this
cabinet will be checked at the interval specified and you will be notified
of new messagesaccording to the settings specified in the current alert
style.
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4.2.1 Attachments Tab

Messages | Attachments ]

| Use Alert
g Play Sound: Basso ﬂ
" | Speak:

This message has an attachment

Figure 21 The Attachments tab in the Alert preference panel

Use Alert To show an alert box when a messagewith attachmentsis opened,
turn this on.

Play Sound To play asound when a messagewith an attachment is opened, turn
this on. You can select the sound from the list of installed system
sounds using the popup menu.

MAc OS X & MaAc OS X & WINDOWS ONLY

WINDOWS ONLY
Speak

To generate a spoken alert when a messagewith an attachment is
opened, turn this on. You can specify the text to be spoken in the box
below the check box.
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4.3 Display

Display Preferences

! Server | Maibox [ Messaga [ Labels [ Quotes [ Styles
Colowr: Bold ftalc Sheiee Under

Logged in: [N M O O O

Logged out: | R M O O O

Een-'er:lzl E Colour Background
Eahinet::l E Colour Background
Hierarch :-.r:|:| E Colour Background

(" Reset Window Defaults ) @ Allow Single Key Shortcuts

Figure 22 The Display preference panel

In addition to the settings in the Display panel, Mulberry saves window position

information in your preferences. To facilitate easyuse between different computers,
different setsof window positions are saved for different monitor resolutions and different
operating system types.

Reset Window Resets all window positions to their default values
Defaults

Allow Single Key To usesingle key shortcut commands in mailbox or messagepanes,
Shortcuts turn this on.
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WINDOWS ONLY

Multiple Taskbar
Items

WINDOWS ONLY

To have each individual Mulberry window appear as a separate entry
on the taskbar, turn this on. To have a single taskbar entry for all
Mulberry windows, turn this off. This option is not available if you do
not have the Independent Windows option turned on. Changesonly
take effect after you quit and restart Mulberry.

4.3.1 Server Tab

The settings in this tab affect the text names of email servers, cabinets,and display
hierarchies appearing in the server window.

Logged In

To setthe color for displaying the text name of serversin the server
window for which you are currently logged in, click the colored box.
To selectatext style for the text namesof logged in servers,turn the
appropriate checkboxon or off.

Logged Out

To setthe color for displaying the text name of serversin the server
window for which you are not logged in, click the colored box. To
selecta text style for the text names of logged out servers,turn the
corresponding checkbox on or off.

Server

To setthe background color for serversin the server window, click the
colored box. To eliminate the background color, uncheck the OColor
BackgroundObox.

Cabinet

To setthe background color for mailbox cabinetsin the server
window, click the colored box. To eliminate the background color,
uncheck the OColoBackgroundObox.

Hierarchy

To setthe background color for mailbox display hierarchies in the
server window, click the colored box. To eliminate the background
color, uncheck the OColoBackgroundCbox.
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4.3.2 Mailbox Tab

All settings in this tab affect text names of mailboxes appearing in the server window.

Server M adboy Meszage . Labels . Quotes [ Styles

Colowr:

Rl:—n:ent:-
Llnseen:-
Elpen:-
Favnurite:-
Elc-s.ed:-

ftalc sS4 Under

AR E

E Use Recent State only for Recent and Unseen

Figure 23 The Mailbox tab in the Display preference panel

Recent

To setthe color for mailboxes with new messagesclick the colored
box. To selecta text style for mailboxes with new messagesturn the
corresponding checkbox on or off.

Unseen

To setthe color for mailboxes with unseen messagesclick the colored
box. To selecta text style for mailboxes with unseen messagesturn the
corresponding checkbox on or off.

Open

To setthe color for mailboxes that are currently open, click the colored
box. To selectatext style for open mailboxes, turn the corresponding
checkbox on or off.

Favorite

To setthe color for mailboxes that are marked as OFavorites@hose that
will be checked for new email), click the colored box. To select a text
style for favorite mailboxes, turn the corresponding checkbox on or
off.

Closed

To setthe color for ordinary mailboxes, click the colored box. To select
atext style for ordinary mailboxes, turn the corresponding checkbox
on or off.
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Use Recent State To use the Recentstyle for messagesthat have both recent and unseen
only for Recent flags set, as opposed to those only having the Recentflag set,turn the
and Unseen corresponding checkbox on.

4.3.3 Message Tab

All settings in this tab affect message captions appearing in mailbox windows.

E.er'.-er. Mailbox | Message | Labels [ Quotes [ Styles

Colouwr: Bold ftalc Shefee Under
Llnseen:- E
seen: || (]
Answered: [ (]
Irnp-;:urtant:- E
Deletec: [ |

Multiple Addresses:

(&[]

|
= I CIe

Hatched::l @ Colour Background

LUinmatched: "1 Colour Background

E Display Dates Adjusted to Local Timezone

Figure 24 The Messagetab in the Display preference panel

Unseen To setthe color for new messagesclick the colored box. To selecta text
style for new messagesjturn the corresponding checkbox on or off.

Seen To setthe color for messagesthat have beenseen,click the colored
box. To selecta text style for seenmessagesturn the corresponding
checkbox on or off.

Answered To setthe color for messagesthat have beenanswered, click the
colored box. To selecta text style for answered messagesturn the
corresponding checkbox on or off.

Important To setthe color for important messagesclick the colored box. To select
a text style for important messagesturn the corresponding checkbox
on or off.
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Deleted To setthe color for messagesthat have beendeleted, click the colored
box. To selectatext style for deleted messagesturn the corresponding
checkbox on or off.

Multiple Somemessagesn mailbox windows are addressedto multiple
Addresses recipients. To set a text style for displaying the address fields of such
messagesturn the corresponding checkboxon or off.

Matched To setthe background color for messagesthat meet the current
OMatchO criteria, click the colored box. To eliminate the background
color, uncheck the OColoBackgroundObox.

Unmatched To setthe background color for messagesthat do not meet the current
OMatchO criteria, click the colored box. To eliminate the background
color, uncheck the OColoBackgroundObox.

Display Dates To have dates displayed using the timezone you are currently in, turn
Adjusted to Local this checkboxon. To leave dates displayed using the timezone that
Timezone they were generatedin, turn this checkbox off.

4.3.4 Labels Tab

All settings in this tab affect message captions appearing in mailbox windows.

. Server [ Maidbox [ Message | Labels | Quotes [ Htyles .

Labeal Narme: Use Colowr: Use Bkgnd: Baold ftalc Shieilee Under
Label) MEER S0 0O 0O
Label2 - M O M

Label3 W
Label4 W I
Label5 o Il —
Labelf v I
Label? I
Label8 = —Z1 IsN_Eals

Figure 25 The Labels tab in the Display preferences panel
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Label Name Enter a name for one of the eight labels. Foreground and background
colors for messageshaving the corresponding label can be setby
turning them on with the appropriate checkboxand then choosing a
suitable color by clicking on the colored box. To setatext style for
displaying messageswith the corresponding label, turn the
corresponding checkbox on or off.

4.3.5 Quotes Tab

All settings in this tab affect message text appearing in a message window.

Server [ Mailbox [ Message [ Labels Quotes Styles

Colour: Baold ftalic  Under

sevet[ [ O O
};-Level:-

3 Leuel:| |
g W Use Multiple Colours
»xxz=level:

B Level:lzl

Recognised Quotes

Figure 26 The Quotes tab in the Display preference panel

Level Click on the Color box to specify a color for eachlevel of quoted text.
You can also use the checkboxesto the right of the first level to specify
different text styles for quoted text. Any selected text styles will apply
to all levels of quoted text.

Use Multiple To use different colors for eachlevel of nested quotes, check this box.
Colors If this box is not selected,you will only be allowed to specify one color
for all quoted text.
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Recognized Mulberry uses the characters in this box to determine which lines in the

Quotes text of a messageare quoted text. If aline of messagetext begins with
one of the listed characters,Mulberry assumesthat line contains
guoted text and applies the specified colors and styles to that text.

4.3.6 Styles Tab

All settings in this tab affect message text appearing in a message window.

Server [ Mailbox [ Message [ Labels [ Quotes | St'_l,l'|-E5-!
Colour: Bold ftalc LUnder

urL: [

URL Seen:-
Header:- E
style Tags: R |

L)
[

Recognise URL Schemes
http:// +
https:// ¥
mailta:
ftp:ss
file://
imap:s s
acap:/s 'y
Idap:// 1

Figure 27 The Styles tab in the Display preference panel

URL To set the color for displaying active URLS, click the colored box. To
selecta text style for URLSs, turn the corresponding checkboxon or off.

URL Seen To set the color for displaying followed URLSs, click the colored box. To
selecta text style for URLSs, turn the corresponding checkboxon or off.

Header To set the color for displaying message header fields, click the colored
box. To selectatext style for messageheader fields, turn the
corresponding checkbox on or off.

Style Tags To setthe color for displaying styled text tags, click the colored box. To
selectatext style for styled text tags, turn the corresponding checkbox
on or off.
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Recognize URL To have Mulberry recognize a particular type of URL and display it as
Schemes specified above, enter its scheme here. This should include any B
required directory charactersafter the O:(2.g.use Ohttp://O,not Ohttp:O).

4.4 Fonts
Font Preferences
Font: Size:
Lists: Genewva ?] 10 3
Plain Text: Monaco ?] 10 3
Printed Text: Courier a 10 3
Print Captions: Courier a 10 3
Styled Base: Palatino 3 12 a
Styled Fixed: Monaco 3 5 a
smallest Size Allowed in Styled Text: 12 ==
E Use Styled Fents in Formatted Messages
Figure 28 The Font preference panel

Lists Choosethe font face and size to use when displaying lists of items,
such asserversand mailboxes in the server window, messagecaptions
in amailbox window, and addressbooks in the address book manager
window.

Plain Text Choosethe font face and size to use when displaying messagetext in a
messagewindow or adraft window. You should try to choosea font
with afixed characterwidth (mono-spacing) so that text formatting
and alignment is preserved.

Printed Text Choosethe font face and size to use when printing plain text messages.
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Printed Captions

Choosethe font to use for the header and footer on printed pages.

Styled Base

Choosethe default font face and size to usefor displaying styled text in
text/enriched and text/html styled text messagesor drafts.

Styled Fixed

Choose the font face and size to use for displaying fixed-width text in
text/enriched or text/html styled text messages.

Smallest Size
Allowed for
Styled Text

Choosethe smallest font size you want to view styled text at.

Use Styled Fonts
in Formatted
Messages

To always use different fonts in messageswith styled text turn this on.
To only usethe Plain Text font in formatted messagesturn this off.
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4.5 Mailbox

Mailbox Preferences
! Basic = Advanced ' Disconnected |

Open Mailbox at: Processing Order:
’: First Message @ Oldest to Newest
’: Last Message ’: Mewest to Oldest

@ First New Message

"~ | Den't Preview New Message

"] Expunge on Close
| Wam on Expunge

E Warm wihen Marking All Messages as Seen

@ Open Mext with Mew Messages
@ Ask before Opening Mext

@ Move Read Messages in INBOX
Move to: POP3:seen @
E Wam when Moving

Figure 29 The Mailbox preference panel

4.5.1 Basic Tab

Open Mailbox at ~ Thesethree radio buttons determine whether mailbox windows are
opened with either the OFirstO, OLastO, or OFirst NewO message disple
The OFirstO and OLastO options will display the oldest and newest set of
messagesyespectively, when a mailbox window is opened. The OFirst
NewO option will cause the oldest unread message to be highlighted

when a mailbox window is opened.

Don’t Preview To prevent a new messagebeing previewed when first opening a

New Message mailbox, turn this on.
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Processing Order

Thesetwo radio buttons determine the direction in which Mulberry
will automatically move messageselectionsasyou are reading through
a mailbox. If you prefer to processmessagesin the order of oldest to
newest, turn the 'Oldest to Newest' radio button on. If you prefer to
processmessagesin the order of newest to oldest turn the 'Newest to
Oldest' radio button on.

Expunge on Close

To automatically expunge a mailbox after closing its window, turn this
on. Expunging permanently removes from the mailbox any messages
marked asdeleted.

Warn on Expunge

To display awarning before expunging a mailbox, turn this on.
Expunging permanently removes from the mailbox any messages
marked asdeleted.

Warn when
Marking All
Messages as Seen

To display awarning before marking all messagesasseen,turn this on.

Open Next with To automatically move to the next mailbox with new messagesn it

New Messages when you have read all messagesin the current mailbox, turn this on.

Ask before To show awarning before moving on to the next mailbox with new

Opening Next messagesturn this on.

Move Read This option allows you to automatically move messagesin your

Messages in INBOX that youOveread to another mailbox. Upon closing the INBOX

INBOX window, all Oseen@essagesare moved to the mailbox specified in the
OMove toO field (described next), and deleted messages are expunged
from the INBOX.

Move to When the INBOX is closed any messagesthat have beenseenwill be

automatically moved to this mailbox and the INBOX expunged. The
mailbox name should be the full path name for the mailbox. You can
click on the pop-up menu next to the field to selecta mailbox from
those currently known to Mulberry.

Warn when
Moving

To display awarning if any messagesare about to be automatically
moved out of the INBOX, turn this on.
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4.5.2 Advanced Tab

Basic | Advanced | Disconnected

MNew Messages:
IE‘I are Unseen

—

are Recent

" are Recent and Unseen

Cabinets:
: Use 'Copy Messages To" Cabinet
" | Use ‘Copy Drafts To' Cabinet

Maximum History: 30

Message Display Cache:

Remaote Mailboxes: Lacal Mailboxes:

Initial Download: 30 Initial Download: 30
£ Unlimited Total ) Unlimited Total

) Limit to: 200 ) Limit to: 100
I'E:"I Auto Increment IE"I Auto Increment

) Increment: 20 ) Increment: 50
Sort Warning: 200 Sort Warming: 1000

Figure 30 The Advanced tab in the Mailbox preference panel

New Messages

Thesethree radio buttons determine what type of messageis
considered to be a new message. Selecting OardJnseen®r OardRecentO
causesmessageswithout the seenflag setand messageswith the
recentflag set, respectively, to be considered asnew. The OardRecent
and UnseenO option causes messages without the seen flag AND with
the recent flag to be considered new.

Use “Copy To usethe list of mailboxes in the OCopyMessagesToCrabinet in the
Messages To’ OCopyToOnain menu and popup menu, turn this on.

Cabinet

Use ‘Copy Drafts  To usethe list of mailboxes in the OCopyDrafts ToCrabinetin the

To’ Cabinet

OAppend ToO main menu and popup menu, turn this on.

Maximum History

Enter the number of recently chosenmailboxes to be shown in the
OCopyToQor OAppendToQmain menu or popup menu when the menus
are setto display their respective cabinet contents.
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The next setof options determine the behavior of MulberryOsmessagedisplay caching.
Novice userswill probably want to usethe default settings. There are two setsof options,
one of which applies to mailboxes being accessedover a network connection to a server,
and the other of which applies to local mailboxes, including ones residing on a server that
are being accessed in disconnected mode.

Initial Download

Enter a number into this field. Mulberry will download a

corresponding number of messagecaptions automatically when you
first open a mailbox window. Setting this number too high when using
a slow network connection could result in poor performance.

Unlimited Total

To allow Mulberry to download an unlimited number of message
captions for a mailbox, select this option. If this option is not selected,
message caption information will be discarded as other captions need
to be downloaded. Selectingthis option when working with very large
mailboxes could result in a low memory situation.

Limit To

To allow Mulberry to discard information on messagesnot currently
displayed in a mailbox window, click here. When the number of
messagecaptions downloaded exceedsthe specified number, Mulberry
will discard previously downloaded message captions. Enter the
number of messagecaptions to remember in the box to the right.

Auto Increment

If this option is selected, Mulberry will automatically download a
number of new messagecaptions equivalent to the number of
messages displayed in the mailbox window.

Increment If this option is selected, Mulberry will automatically download a
number of new messagecaptions equal to the number entered.

Sort Warning Specifiesthe maximum number of messagesin a mailbox that
Mulberry will download to getinformation for sorting without
displaying a warning alert.
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4.5.3 Disconnected Tab

Basic ' Advanced | Discnrlnectad]

[ Options | Local

E Prompt on Startup if Required

E Automatic Modem Dial/Hangup
E Wam if Mailboxes do not Match

Use 05 Specific Default Locations

E Connect after Wake if Metwork Connections Found

Figure 31 The Disconnected tab in the Mailbox preference panel

Within the Disconnected tab, the Options tab allows you to specify various settings that
affect disconnected mode operations.

Prompt on Startup
if Required

When Mulberry is started, it will attempt to start up in the same state it
was in when it was last quit b either connected or disconnected mode.
In the casewhere Mulberry was previously in connected mode and no
network connection is available on startup, you can selectthis option to
have Mulberry prompt you to determine whether you want to
establish a connection or startup in disconnected mode instead. If you
donOthave this option turned on, Mulberry will always try to establish
its previous state on startup, and you will receive an error messageif a
network connection is required but not available.

Automatic Modem
Dial/Hangup

Select this option to have Mulberry automatically dial and hang up
your modem as necessarywhen moving between connected and
disconnected mode.
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Warn if Mailboxes
Do Not Match

In some rare cases, if an online IMAP mailbox has completely changed
since the last time it was synchronized with a disconnected mailbox,
Mulberry may not be able to perform some of the pending
synchronization options. Turning this option on will produce an alert if
this happens.

You will generally want to keep this option on.

Use OS Specific
Default Locations

To usethe default location for documents as specified by the current
operating system, select this option. The default location is usually the
user documents folder. If this option is off, the default location is the
Mulberry application folder.

This setting can potentially affect any local mailboxes, disconnected
mailboxes, POP3mailboxes, and local address books that are setto be
stored in the default location.

Connect after
Wake if Network
Connections
Found

To have Mulberry automatically recover network connections when
the computer wakes from sleep, provided an active network
connection is found, turn this on. When this is off, Mulberry will always
display a prompt after the computer wakes from sleep.

The items in the Local tab are identical to those in the Local tab for a POP3 mailbox account
(seesection!4.1.2.2)though the settings in this tab specify the location for the storage of
disconnected mailboxes.
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4.6 Message

Message Preferences

General | Options .

Creator for Saved Messages R*ch | " Choose...

.1

Print Captions: {7 Set._.

Wam when Opening a Message bigger than:
’: Mo Limit E}I Size: 20 Kbytes

Allow Choice of who to Reply to when:
’: Option Key is Down
IE} Opticn Key is not Down

" Allow Choice of Forward Options

o

@ Forward using Options:

E Quote Driginal
[ Include Headers in Quote

E_q Always Forward as Attachment
@ Use Embedded Message

Figure 32 The Messagepreference panel

4.6.1 General Tab

MaAc OS X ONLY MAc OS X ONLY
Creator for Saved Enter the creator code for messagessaved to disk. For example:

Messages OttxtO for TeachText/SimpleText
OMSWDO for Microsoft Word

If you donOtknow the proper creator code for the application you want
to use, you can click the Choose button and selectthe application you
want to handle saved messages. Mulberry will fill in the appropriate
creator code for you.
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WINDOWS &
UNIX ONLY

Extension for
Saved Messages

WINDOWS & UNIX ONLY

Enter the three character filename extension for messagessaved to
disk. For example:

.txt for a plain text file

.doc for a Microsoft Word document

Print Captions

Click the OSetEO button to define the header and footer that will appear
when you print a message.A dialog box (shown in Figure 34) will
appear. You can createdifferent headersfor regular messagesand

draft messages.

Warn when
Opening a
Message bigger
than

When this option is selected, a warning alert will be displayed before
opening a message exceeding the specified size. If ONo LimitO is selecte
no size warning occurs.

Allow Choice of
who to Reply to
when

This setting allows Mulberry to automatically display a dialog with a
choice of reply addresseswhen replying to a message. To have this
dialog always come up, select OOption Key is not DownO (Mac OS X) or
OAlt Key is not DownO (Windows) option. To have the dialog appear
only when you hold down the Option (Mac OS X), Alt (Windows) or
Control (Unix) key while selecting the Reply option, choose OOption
Key is DownO (Mac !0S), OAlt Key is DownO (Windows), OControl Key |
DownO (Unix).

All Choice of
Forward Options

When this option is selected, a dialog presenting options for
forwarding a messagewill appear when the Forward command is
used.

Forward using
Options

When this is selected, the forward options specified via the controls
below it are used to determine how messagesare forwarded, avoiding
the dialog.

Quote Original

When this is selectedthe text from the original messageis quoted in
the forwvarded message.

Include Headers
in Quote

When this is selected,the headersof the original messageare also
included in the forwarded message.

Always Forward
as Attachment

When this is selected, Mulberry will always attach the original message
to the forwarded message,evenif it only contains text which is also
quoted.

Use Embedded When this is selected, Mulberry will attach the original message as a

Message message/rfc822 part in the forwarded message.When this is not
selected,the parts of the original messageare attached to the
forwarded message Oin-lineO.

70 Mulberry Reference Guide v4



4.6.2 Options Tab

General | Dptions ]

show Message Header in Window

@ Show Styled Text Alternatives

Put Message Header in File when Saving

E Delete Message after Copy

E Allow Deleted Messages to be Opened
E Close Message when Deleted

: Reuse Dpen Message Window

@ Quote Selection Only

@ Quote whole Message if no Selection
E Dpen First Digest Message

E Expand Header for Multiple Addressees
: Expand Parts for Attachments

sender Read Receipt Requests
' Always Send Read Receipt
Never Send Read Receipt

()

Prompt to Send Read Receipt

Figure 33 The Options tab in the Messagepreference panel

Show Message To have the messageheader displayed at the top of eachmessage

Header in when opened, turn this on.

Window

Show Styled Text To display the styled text message part in a multipart/alternative

Alternatives message, turn this on. To always display the plain text part of a
multipart/alternative, turn this off.

Put Message To savethe messageheader along with the messagetext when a

Header in File
when Saving

messageis saved, turn this on.

Delete Message

To delete messagesafter copying from one mailbox to another, turn

after Copy this on.

Allow Deleted To allow messagesthat are marked asdeleted to be opened, turn this
Messages to be on. When off, messagesbeing deleted will have their message
Opened windows closed.
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Close Message
when Deleted

To close messagewindows when the messagethey are displaying is
deleted, turn this on.

Reuse Open
Message Window

To reuse the oldest open messagewindow when opening a message
from a mailbox window, selectthis option. Holding down the Option
(Mac!OS X), Alt (Windows) or Control (Unix) key when opening a
messagefrom the mailbox window will produce the opposite
behavior.

Quote Selection
Only

If this option is checkedand you reply to a message,only the text
currently selected in the original message will be automatically quoted
in the reply draft window.

Quote whole
Message if no

If this option is checked and you reply to a message,the complete text
of the original messagewill automatically be quoted in the reply draft

Selection window when no text is selectedin the original message.
Open First Digest To automatically open the first digest messagewhen a
Message multipart/digest message is opened, turn this on.
Expand Header for When this option is selected, if you open a message which contains
Multiple more than one address in an address field, Mulberry will automatically
Addresses expand that address field to show multiple lines when it is visible.
Expand parts for When this option is selected, Mulberry will automatically expand the
Attachments Parts section of a messagewindow (seeSection!5.8.2.1)f the contains
any attachments.
Sender Read Theseoptions determine how Mulberry will processread receipt
Receipt Requests  requeststhat have beensentto you.
¥ Always Send Read Receipt - an automatic read receipt will
always be sent whenever you read a messagethat contains a read
receipt request.
¥ Never Send Read Receipt - read receipts will never be
automatically sentevenif they are requested.
¥ Prompt to Send Read Receipt - when aread receipt requestis
detected on a messageyou have just started to read, Mulberry will
prompt you asto whether you want to send a read receipt back to
the sender of the message,or not.
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4.6.3 Editing Captions

You can create custom captions to appear on messageprintouts. Captions are created
using the OSet CaptionO dialog.

Set Caption
My Mame | Smart Mame | From Mame To Mame CC Mame Subject Page Mumber
My Email amart Email | From Email To Email CC Email Date Short
My Full amart Full From Full To Full CC Full Date Long
My First amart First | From First To First CC First Date Mow
Header Efl Message E Drraft E Draw Box E Print Summary Headers

Message: %smart-full on %sent-short
Subject: %subject

Footer Efl Message E Drraft E Draw Box
Page Xpage Printed for: ¥me-name on  %now
( Revert ) ( Cancel )

Figure 34 The SetCaption window

You can edit different headersand footers for regular messagesand draft messagesby
selecting either the OMessaged®d ODraft@adio buttons. The buttons at the top of the
window allow you to insert various fields from the messageyou are printing into the
printed header or footer. A description of eachfield button follows:

My Name Your real name. If you have not specified your real namein the
appropriate preference panel, your email address will be used instead.
My Email Your email address.
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My Full

Your real name and email address.

My First Your first name. If you have not specified your real name in the
appropriate preference panel, your email address will be used instead.

Smart Name The real name of the correspondent. If areal name is not specified, the
email address of the correspondent will be used instead.

Smart Email The email address of the correspondent.

Smart Full The real name and email address of the correspondent.

Smart First

The first name of the correspondent. If a real name is not specified, the
email address of the correspondent will be used instead.

From Name

The real name specified in the OFrom@ddress of the current message.If
a real name is not present, the email address will be used instead.

From Email

The email address specified in the OFromO address of the current
message.

From Full The real name and email address specified in the OFromO address of th
current message.

From First The first name specified in the OFrom@ddress of the current message.
If a real name is not present, the email address will be used instead.

To Name The real name specified in the OTo@ddress of the current message.If a
real name is not present, the email address will be used instead.

To Email The email address specified in the OToO address of the current message

To Full The real name and email address specified in the OToO address of the
current message.

To First The first name specified in the OTo@ddress of the current message.If a
real name is not present, the email address will be used instead.

CC Name The real name specified in the OCCE&ddress of the current message.If a
real name is not present, the email address will be used instead.

CC Email The email address specified in the OCCO address of the current messag

CC Full The real name and email address specified in the OCCO address of the
current message.

CC First The first name specified in the OCC@ddress of the current message.If a
real name is not present, the email address will be used instead.

Subject The subject of the current message.

Date Short A short version of the date and time the current messagewas sent.

Date Long A long version of the date and time the current messagewas sent.
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Date Now A short version of the current date and time.

Page Number The current page number.

To draw a box around either the header or footer, selectthe appropriate Draw Box
checkbox. The Revert button will changeall captions back to the state they were in when
the SetCaption window was first opened.

When used for setting print headersand footers, turn on the Print Summary Headers
checkboxto ensure a setof headersare always displayed at the top of the first printed

page.
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4.7 Outgoing

Outgoing Preferences

{ General | Options [ Styled |

Default Domain for
Dutgoing Mail:

Tab Width: 4 @ Use Spaces for Tabs
Wrap Length: 76

=,

Reply Prefix: | Caption: f Set...

Farward Prefix: Caption: [ set,.. *

Forward Subject: * { fwid)

Print Captions: (” set._

E Separate Bcc Message with Caption: [ set,, ©
save Draft

—

__ Always Save to Disk
" Always Save to Mailbox:

imap:INBOX. drafts .
@ Allow Choice of where to Save

e’

Figure 35 The Outgoing preference panel

4.7.1 General Tab

Default Domain If you enter an email address without the O@O character which is not a

for Outgoing nickname or a group name, this text will befilled in asthe rest of the

Email email address.If you are not sure what to enter here, you should leave
it blank.

Tab Width The character width to use for tab characters,or the number of spaces

to insert when typing atab in adraft window when the OUseSpacefor
TabQheckbox (described below) is on.

Use Spaces for To usearun of spacesrather than areal Tab character when typing a
Tabs tab in a draft window, turn this on. The number of spaces used is
determined by the OTalWidthOsetting, described above.
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Wrap Length

The number of charactersper line to which the text of a draft message
is wrapped when it is sent. This should normally be left at 76 characters
per line.

Reply Prefix

The string used to indicate a quotation of a messagebeing replied to.
This string followed by a space is inserted at the start of each line of the
guotation.

Reply Caption

To configure the text displayed before and after eachmessagebeing
replied to, click the OSetEO button. A dialog box (shown in Figure 34)
will appear.

Forward Prefix

The string used to indicate a quotation of a messagebeing forwarded.
This string followed by a space is inserted at the start of each line of the
guotation.

Forward Caption

To configure the text displayed before and after eachmessagebeing
forwarded, click the OSetEO button. A dialog box (shown in Figure 34)
will appear.

Forward Subject

The string used to configure the subjectused when forwarding a
message.An O*Characteris used to representthe original subject. Thus
a value of O* (fwd)O (the default) will append O (fwd)O to the original
subject. A value of OFwd: *O will prepend OFwd: O to the original subjec

Print Captions

Click the OSetEO button to define the header and footer that will appear
when you print amessage.A dialog box (shown in Figure 34) will
appear. You can create different headersfor regular messagesand

draft messages.

Separate Bcc
Message with
Caption

When this option is selected, Mulberry will send two copies of
messages which contain Bcc recipients. One copy is sent to the To and
Cc recipients only, the other to the Bcc recipients only. The Bcc copy
has some text automatically added to the top of the first text part in the
message. This is used to provide a warning to the Bcc recipients to
ensure they donOfaccidentally reply to other recipients and thus expose
the fact that they were a Bccrecipient.

Bcce Caption

Click the OSetEQ button to define the text that is automatically inserted
into the Bcccopy of a message.This option is only available when the
OSeparate Bcc Message with CaptionO option (described above) is
selected.

Always Save to
Disk

When this option is selected,the File menu Save command will allow
you to savedraft messagesto disk only. Drafts can still be appended to

a mailbox using the Append To or Append Now command in the
Draft menu.

Always Save to
Mailbox

When this option is selected,the File menu Save command will allow
you to savedraft messagesto the specified mailbox only. You can
choosethe mailbox via the popup to the right of the text field.
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Allow Choice of  \When this option is selected,the File menu Save command will
where to Save prompt you whether to savedraft messagesto disk or to a mailbox.

4.7.2 Options Tab

. General | Options | Styled |

@ Insert Signature Automatically

E Add Blank Line before Signature

E Add °-- " before Signature

E Remaowve Signatures from Reply Quotation
@ Wam if no Subject when Sending

@ Warn when Reply Subject is Changed

: Display From Address in ldentity Popup

" | Always Show Cc Field

" | Always Show Bce Field

E Only Show Attachments in Parts List

@ Append as Draft

: Copy INBOX Messages being Replied to

@ Add URL delimiters when Pasting Text

: Wrap Text while Composing

E Delete Drafts in Mailboxes after Sending
E Don't Delete Important Drafts after Sending
@ Always Use Unicode Character Set for non-ASCI Text

Figure 36 The Options tab in the Outgoing preference panel

Insert Signature To have the signature specified in the current identity automatically
Automatically added to the end of a new draft message,turn this on.

Add Blank Line To ensure that there is at least one blank line between the signature
Before Signature  and any text that precedesit, turn this on.

Add '-- ' before To add arecognizable signature indicator before the signature text,
Signature turn this on.
Remove To have recognizable signatures removed from text being quoted in a

Signatures from reply, turn this on.
Reply Quotation
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Warn if no Subject To have awarning displayed when sending a messagewith an empty

when Sending

subject line, turn this on.

Warn when Reply To have awarning when areply is sentwith adifferent subjectthan
Subject is the original, turn this on..

Changed

Display From To include the From address for the selected identity in the Identity
Address in popup, turn this on.

Identity Popup

Always Show Cc
Field

When this option is selected, all new Draft windows will always contain
a Cc: address field. When this option is off, the Cc address field will
initial be hidden in the Draft window, but it can be added by clicking
the Add Cc toolbar button in the window.

Always Show Bcc  When this option is selected, all new Draft windows will always contain

Field a Bcc: address field. When this option is off, the Bcc address field will
initial be hidden in the Draft window, but it can be added by clicking
the Add Bcc toolbar button in the window.

Only Show To display only attachments in the parts list, turn this on. When turned

Attachments in off, all parts of the draft will be displayed, including the text part being

Parts List edited.

Append as Draft To copy draft messagesinto a mailbox so that they will be opened as
draft messagesturn this on. Holding down the Option (Mac!OSX), Alt
(Windows) or Control (Unix) key while selecting the equivalent
command will produce the behavior.

Copy INBOX To automatically setthe OAlsccopy original message®©heckboxwhen

Messages being replying to a messagein the INBOX, turn this on.

Replied To

Add URL To automatically have <E> delimiters inserted around a URL when

Delimiters when  pasted into a Draft window, turn this on.

Pasting Text

Wrap Text while
Composing

To have text in adraft window wrapped to the OWrapLengthO,
described above, while composing a message,selectthis option. If this
option is not selected,text will be wrapped to the width of the compose
window, and re-wrapped to the specified OWrap LengthO when the
messageis sent.

Delete Drafts in
Mailboxes after
Sending

If adraft messageis opened from a mailbox, turn this on to have the
original draft messagedeleted after the draft has beensent, saved or
copied.

Don’t Delete
Important Drafts
after Sending

If the ODeleteriginal Draftf)option is on, turn this option on to prevent
draft messagesmarked as Olmportant@om being deleted. This allows
the use of Otemplate@raft messagesby marking such messagesas
Olmportant@ avoid them being deleted like ordinary draft messages.
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Always use

To always send messages with non-ASCII text using a Unicode

Unicode Character characterset,turn this on. When turned off, Mulberry will attempt to
Set for non-ASCII use an ISO-8859-x character set whenever possible, and Unicode in

Text

other cases.

4.7.3 Styled Tab

General | Options | Styled

Compose Text as: Plain _:]
Generate Altermatives:
Generate: Generate:
Compose Enriched: E Flain : HTMIL
Compose HTML: E Flain " | Enriched

E Send Plain Text Flowed

Figure 37 The Styled tab in the Outgoing preference panel

Compose Text as

To setthe default styled text format to use when composing draft
messageschooseone from the pop-up menu.

Composing
Enriched

80

To automatically generateatext/plain part alternative when
composing a text/enriched message, turn OPIlainO on. To automatically
generateatext/html part alternative when composing a text/enriched
message, turn OHTMLO on.
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Composing HTML To automatically generateatext/plain _part alternative when
composing a text/html message, turn OPlainO on. To automatically
generateatext/enriched part alternative when composing a text/html
message.turn OEnrichedon.

Send Plain Text When this option is on, outgoing text/plain messagesare sent using

Flowed the OflowedOformat. If the recipient of such a messageis using a email
client that supports flowed text, the message will automatically wrap to
the size of their viewing window. Users of email clients that do not
support flowed text will seethe messagetext wrapped to the OWrap
LengthO specified in the General tab of the Outgoing panel (see
section!4.7.1).
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4.8 Security

Note: The options in this preference panel are only available when you have the Mulberry
PGP, GPG or S/IMIME plugins installed and activated

Security Preferences

Preferred Plugin: PGP - using PGP Plugin

'

@ Use MIME Multipart Security with PGP
@ Always Encrypt to Self
@ Cache Passphrase while Running

@ Verify Signed Messages when Opened
@ Decrypt Messages when Opened

E Warmn wihen Responding without Encryption
: Motify Errors with an Alert Box

signature Verined OF MNotification:
1 Use Alert
- Play Sound:
@ speak:
Verfied digital signature

Manage Certificates...

Figure 38 The Security preference panel

Use MIME When this option is on, Mulberry generatesoutgoing messagesthat

Multipart Security are signed or encrypted with PGP as proper MIME multipart/signed or
multipart/encrypted messages.If this is off, messagesare sentas
regular text/plain parts with signing and/or encryption information in
the messagebody.

Always Encrypt to  When this option is on, any encrypted messagesgenerated will also be

Self encrypted to the signing key specified in the currently selected identity.
As an example, if you save copies of all outgoing messagesthis option
ensuresthat you can decrypt messagessent to other people.
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Cache Passphrase
while Running

To cachein memory the passphrase(s)for any signing key(s) you use
during the current Mulberry session,turn this on. PGP passphrasesare
never written to disk.

Verify Signed
Messages when
Opened

To automatically verify the signature on a signed messagewhen it is
opened, turn this on. This feature will only work for messagesn a
proper MIME multipart/signed format.

Decrypt Messages
when Opened

To automatically decrypt an encrypted messagewhen it is opened,
turn this on. This feature will only work for messagesin a proper
MIME multipart/encrypted format.

Warn when
Responding
without
Encryption

To display a warning when sending a an unencrypted reply to a
messagethat was encrypted, turn this on.

Notify Errors with

To display awarning when averify or decrypt operations produces an

an Alert Box error, turn this on.
Manage Click this button to display a dialog allowing S/MIME and SSL
Certificates certificates to be viewed, added or removed.
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4.9 Identity

Identity Preferences

[dantitias

Default

r

Add... !Ehange...x f DL.IpIiI:EItEE " Delete

E Use Tied Identities with Mew Drafts
: Choose Identity from Original Message
: Mailboxes Inherit Tied |dentities

Outgoing Addresses to Count as Mine
daboo@cyrusoft.com

Figure 39 The Identity preference panel

Identities Displays a list of the current set of identities. You can use drag and
drop to re-order identities in the list. The first identity is always

considered the Odefaultd identity.

Add To add a new identity to the list, click here.

Change... To edit the currently selected identities, click here.

Duplicate To duplicate the currently selected identities, click here.

Delete To delete the currently selected identities, click here.
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Use Tied Identities
with New Drafts

To automatically select a tied identity when creating a new draft, turn
this on. The tied identity is determined by the currently selected
mailbox, front most mailbox or messagewindow. Holding down the
Option (Mac!OSX), Alt (Windows) or Control (Unix) key when
creating a new draft will produce the opposite behavior.

Choose Identity
from Original
Message

To automatically selectthe identity for areply or forward message
basedon the addressesin the messagebeing replied to or forwarded,
turn this on.

Mailboxes Inherit

To have tied identities inherited from Oparent® mailboxes in a mailbox

Tied Identities hierarchy, turn this on.
Outgoing Enter addresses into this field, one on each line. The addresses
Addresses to displayed here are used to determine whether or not you are the

Count as Mine

sender of a message when a OSmart AddressO is displayed in a mailboy
window.

4.9.1 Editing Identities

Identity Edit
Identity Mame: |
Inherit from: Default ldentity ﬂ
SMTP Account! SMTP F+] [ inherit

[ From | Reply-To | Sender | Options ' Qutgoing ' Security

] Active

[ Cancel | { OK }

Figure 40 The Oldentity EditOdialog box
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The items in the Identity Edit dialog are:

¥ Oldentity NameO D A text string describing the current identity.

¥ OSMTP AccountO B The SMTP server to use for sending messages with this identity. The
popup menu includes all OSMTP Send EmailO accounts as defined in the OAccountsO panel.

¥ OFromO, OReply-ToO, OSenderd, OOptionsO, O0utgoingd and OSecurityd tabs D These tabs ari
used to specify more options for the current identity, and are described below

4.9.1.1 From Tab

Active To use a custom OFrom@ddress when the current identity is selected,
turn this on. If this checkboxis not selected,the inherited OFromO
address is used instead.

Single Address To enter a single address with separate fields for full name and email
address, click here.

Multiple To enter multiple addresses in a single field, turn this on. If this option

Addresses is selected, a single text box will be displayed in lieu of the ONameO and
OEmailO boxes described next.

Name The name to be used as part of the custom OFrom@ddress should be
entered here (e.g. OJo&JserO).

Email The email addressto be used as part of the custom OFrom@ddress

should be entered here (e.g. Ojoeuser@mulberrymail.comO).

4.9.1.2 Reply-To Tab

The OReply-ToO tab is identical to the OFromO tab. Address(es) entered into this tab will be
used as the Reply-To address when the current identity is selected.

Note: If you choose to use the OMultiple AddressesO option in
either the OFrom@r OReply-To@elds, the addressesyou enter
should be fully specified email addresses, e.g. "Mulberry Sales"
<sales@mulberrymail.com>.

4.9.1.3 Sender Tab

The OSenderO tab is identical to the OFromO tab, except the OMultiple AddressesO option is not
available. The address entered into this tab will be used as the Sender address when the
current identity is selected.
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4.9.1.4 Options Tab

From | Reply-To " Sender | Options | Outgoing [ Security
@Actiue
") Copy Ta: [I]

E‘EI Mo Copy To

) Choose Copy To

@ Active

: Also Copy Original Message

@ Active

Signatura

X-Header Lines

Figure 41 The Options tab of the Identity Edit dialog

Copy To Enter the mailbox in which copies of messages sent with this identity
are to be saved. Use this to keep a record of messagesthat you send.
The OActive@ox must be checked for sent messagesto be copied.

No Copy To When this item is selected, the OCopy To:O popup menu in the Draft

window will be set to ONoneO by default when the current identity is
used.

Choose Copy To

When this item is selected, the OCogy To:0 popup menu in the Draft
window will be setto OChooséaterCoy default when the current
identity is used.

Also Copy
Original Message

Selectthis option to copy the original messageinto the specified OCopy
ToO mailbox along with your reply. This option is only applicable when
you are composing a reply or forwarding a message.

X-Header Lines

To create your own custom header field lines for this identity, click this
button. A text box will open where you cantype the additional header
lines. The OReverthutton in the text box will causethe text box to
return to the state it was in when originally opened. If OActiveO is not
checked, the inherited OX-Header LinesO will be used instead.

Signature

To createyour own custom signature to use when sending messages
with this identity, click this button. A text box will open where you can
type your custom signature. The ORevertutton in the text box will
causethe text box to return to the stateit was in when originally

opened. If OActiveO is off, the inherited OSignatureO will be used insteac
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4.9.1.5 Outgoing Tab

From | Reply-To | Sender | Dptions Outgoing Security

[¥o| Cc | Boc | DSN

@ Active

IE:’I single Address
") Multiple Addresses

Mame:

Emnail:

Figure 42 The Outgoing tab of the Identity Edit dialog

The first three tabs allow you to specify one or more email addressesto automatically add
to the To, CC, or BCClline of an outgoing messagewhen the current identity is selected.
Addresses specified in these tabs are added to the appropriate header line when you select
the identity from the popup menu in the Draft window, and removed when you switch to
another identity.

The DSN tab allows you to request Delivery Status Notification information for all
messagessent using the current identity. Click the OActive®@ox to activate this feature.

Request DSN Check this box to request delivery status notification information for
all outgoing messages that use this identity.

Success Check this box to request a notification when the messageis delivered

Notification successfully.

Failure Check this box to request a notification when the messagesis NOT

Notification delivered successfully.

Delay Check this box to request a notification when there is a delay in

Notification delivering a message.

Return Whole Check this box to request that the entire original messagebe included

Message with any of the notifications that are selected.

Return Headers Check this box to request that only the headers of the original message

Only be included with any of the notifications that are selected.
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Note: Keepin mind that DSN notifications are not guaranteed. Theserequests
depend on the ability of the various SMTP serversthat handle your messageto
honor DSN requests. In some cases,you may not receive notifications evenif you
have these options turned on.

4.9.1.6 Security Tab

From | Reply-To | Sender | Options [ Qutgoing | Eecuﬁty.r]

@ Active

" | Sign Messages
" | Encrypt Messages

Sign with Key: Default Key ﬂ

Eey:

Figure 43 The Security tab of the Identity Edit dialog

This tab will only be available when the Mulberry PGP Plugin is installed.

Sign Messages To automatically sign messages generated when this identity is active,
turn this on.

Encrypt Messages To automatically encrypt messagesgenerated when this identity is
active, turn this on.
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Sign with Key

This popup menu allows you to choosethe PGP key you will use for
signing and encryption options when this identity is active. Available
options are:

¥ Default Key b uses the default key as specified within the PGP
application

¥ From Address Key Dusesakey with an email address matching the
OFromO address specified within this identity.

¥ Reply-To Address Key D uses a key with an email address matching
the OReply-ToO address specified within this identity.

¥ SenderAddress Key busesakey with an email address matching
the OSenderO address specified within this identity.

¥ Other Key busesa different key. When this option is selected,you
cantype astring in the OKey@ox. When you sign a message,
Mulberry will attempt to find a PGP key with a name or email
address that contains the specified string.
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4.10 Addresses

Address Preferences

Allow Choice of Addresses when:
: Option Key is Down
IE‘I Option Key is Mot Down

! Expansion | Capture " Local

: Use Expansion instead of Nick-names

E Expand when Nick-name Fails

E Expand using Full Mame
E Expand using Mick Mame
E Expand using Email Address

: skip LDAP if Address Book Results are Found

Figure 44 The Addresses preference panel

Allow Choice of  This setting allows Mulberry to automatically display a dialog with a

Addresses

choice of addresses when you click the Draft button in the Address
Book or Address Search window. The items in the dialog will
correspond to the items selectedin the window when you click the
Draft button. To have this dialog always come up, select the OOption
Key is not DownO (Mac!OS X) or OAIt Key is not DownO (Windows)
option. To have the dialog appear only when you hold down the
Option (Mac!OSX) or Alt (Windows) key while selecting the Draft

option, choose OOption Key is DownO (Mac!OS X) or OAIt Key is Down(

(Windows).

Mulberry Reference Guide v4 91



4.10.1 Expansion Tab

Use Expansion
instead of Nick-
names

To expand partial addresses via an address book search instead of
using nickname lookup, turn this on. This will cause Mulberry to
searchall address books marked for searching for matchesin the fields
specified below using the partial address as a search string.

Expand when
Nick-name Fails

To perform address expansion only after nickname resolution fails,
select this option.

Expand using Full To search for the partial address in the Full Name field of all address
Name book entries when doing expansion, turn this on.

Expand using To search for the partial address in the Nick-Name field all address
Nick-Name book entries when doing expansion, turn this on.

Expand using To search for the partial address in the Email Address field of all

Email Address address book entries when doing expansion, turn this on.

Skip LDAP if To prevent LDAP searchesoccurring when addresseshave beenfound
Address Book by searching only address books, turn this on.

Results are Found

4.10.2 Capture Tab

Capture to: imsp:vince

Expansion | Capture | Local

Display Edit Dialog on Capture

E Allow Choice when Capturing Multiple

92

" | Capture To Addresses

Capture when Reading a Message
Capture when Responding to a Message

In a Message

E Capture From Addresses

Capture Cc Addresses
Capture Reply-To Addresses

Figure 45 The Captions tab in the Address preference panel

Mulberry Reference Guide v4



Capture To:

Selectthe address book to be used for storing captured addresses.

Allow Choice
when Capturing
Multiple

To be prompted for which addressto capture when multiple addresses
in amessageare detected, turn this option on.

Capture when
Reading a
Message

To automatically capture addressesfrom any messagethat you read,
turn this option on.

Capture when
Responding to a
Message

To automatically capture addressesfrom any messagethat you
respond to (reply or forward), turn this option on.

Capture From
Addresses

To capture the addressesin the message'sFrom field, turn this on.

Capture Cc
Addresses

To capture the addressesin the message'sCc field, turn this on.

Capture Reply-to
Addresses

To capture the addressesin the message'sReply-to field, turn this on.

Capture To
Addresses

To capture the addressesin the message'sTo field, turn this on.

4.10.3 Local Tab

The items in the Local tab are identical to those in the Local tab for a POP3 mailbox account
(seesection!4.1.2.2)though the settings in this tab specify the location for the storage of

local address books.
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4.11 Calendar

Calendar Preferences

atart Week on: | Sunday i

i
pam—

Work Days are:

Sun | Mon | Tue | Wed | Thu | Fri ] Sat

Preset Hour Ranges for Day/Week Displays

Start on End at
Morning:  6:00AM - 12:00PM .
Afternoon: 12:00PM . C6:00PM .
Evening:  6:00PM . 12:00AM | .
Awake Period:  6:00 AM | - 12:00 AM -
Work Period: CB:00AM .  6:00PM .

Display Times in Event Labels

E Handle text/calendar Attachments Internally
E Automatically Send Email Invitations and R5WVFs

Figure 46 The Calendar preference panel

Start Week on

Selectwhich day of the week is to be considered asthe first day in a
week. When displaying items in Week view, the selected day is appears
in the first column.

Work Days are

Selectwhich days are Owork@ays. Non-work days are given a slightly
different background when displayed in calendar views.

Preset Hour
Ranges for
Day/Week
Displays

Selectranges of hours to be defined for usein restricting the OverticalO
time range displayed in day/week views.

Display Time in
Event Labels

To display the start time in events, turn this on.
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Handle To have calendar attachments handled directly by Mulberry when they
text/calendar are viewed, turn this on.

Attachments

Internally

Automatically To have calendar RSVPs automatically sent, turn this on.
Send Email

Invitations and

RSVPs
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4.12 Attachment

Attachment Preferences

Sending | Receiving

Ovemride MIME with: AppleDouble |

ar
)

: Always override MIME
@ Only overide when needed

: Check for mailte URL Handling on Startup
@ Wam when mailto URL Attaches Files
@ Check for webcal URL Handling on Startup

E Wam if Attachments are not Present in a Draft

E Check Subject as well as Text

Words in a Draft that Imply Attachments

attachment
attached

Figure 47 The Attachment preference panel.

4.12.1 Sending Tab

Override MIME The default encoding to use for files sentfrom this computer.

with

Mac OS X ONLY

This should normally be set to OAppleDoubleO so that files can be read
by userson other computer systems.

Always override  To always use the encoding method specified above regardless of the

MIME fileOs type, turn this on.
MAc OS X ONLY
This allows you to always send binary files to other Macintosh users
and ensure that the full file information is sent as well.
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Only override
when needed

Mac OS X ONLY

To only usethe encoding method specified above with binary files or
files which may have aresource fork, turn this on.

WINDOWS ONLY

To use MIME mappings determined by the Windows Registry for files
that do not need special processing, turn this on.

UNIX ONLY

To use MIME mappings determined by the mime.types file for files
that do not need special processing, turn this on.

Check for mailto
URL Handling on
Startup

To have Mulberry check whether it is the default mailto URL handler
on the machine it is running on, and prompt you to make it the default
handler if it is not, turn this option on.

Warn when mailto

To display a warning when a mailto URL causes files to be attached to a

URL Attaches draft, turn this on.

Files

Check for webcal  To have Mulberry check whether it is the default webcal URL handler
URL Handling on  on the machine it is running on, and prompt you to make it the default
Startup handler if it is not, turn this option on.

Warn if

Attachments are
not Present in

To display awarning when sending a messagewithout attachments,
but with text that implies an attachment should be present, turn this
on.

Drafts

Check Subjectas  To have the subject checked for attachment words aswell asthe
well as Text messagebody, turn this on.

Words in a Draft  Enter the list of words (one on eachline) which are used to determine
that Imply whether an attachment should be included in a draft.

Attachments
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4.12.2 Receiving Tab

Sending | Receiving ]

Double-click Attachment to:

|

) View it

H' Save it to Disk

ve to Disk:
I'E‘I Ask for Location
: Use Default Location:

Open after Save:

I'E‘I Always B
) Ask .=
H‘ NEvEer Sat Mappings

E Include Text Attachments

Figure 48 The Receiving tab in the Attachments preference panel

View it When this option is selected, double-clicking on an attachment in an
incoming message window, will result in the attachment being
temporarily savedto disk and then automatically opened with the
application suitable for displaying it.

Save it to Disk When this option is selected, double-clicking on an attachment in an

incoming messagewindow will result in the attachment being saved to
disk at the location specified by the options described below.

Ask For Location

To be given the choice of name and location when downloading an
attachment, turn this on.

Use Default To use a default name and save an attachment in a default folder when
Location downloading turn this on and enter the folder location in the text field.
Choose To choosethe location of the default download folder, click here.
Open After Save:  To have attachments automatically savedto disk after downloading,
Always turn this on.
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Open After Save:  To be given the choice of opening attachments saved to disk after

Ask downloading, turn this on.

Open After Save:  To prevent attachments saved to disk after downloading from being

Never opened, turn this on.

Include Text To have text attachments opened after downloading using the OOpen

Attachments After Save(ption, turn this on. To prevent text attachments from .
being opened after downloading irrespective of the OOperAfter SaveO
option, turn this off.

Set Mappings To edit the default MIME type to file type mappings, click here. This

brings up adialog box (shown in Figure 49)from which you can
specify a relationship between a MIME type/subtype and a Mac!OS file
creator and file type (Mac OS X) or a file extension (Windows). These
mappings canthen be used to correctly convert between Email
attachments and files on the local computer.
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4.12.3 Mappings

The mappings set in the explicit mappings dialog are used to override the default MIME to
file type mappings specified in Internet settings (Mac OS X), the Windows Registry

(Windows), or the mailcap files (Unix). These mappings are only used for incoming
attachments.

MIME to Mac O5 Mapping

MIME Type to Mac OS5 File Type Mappings:

MIME type/subtypa Mac OS5 Application Type
application/octet-stream xﬁ‘ EBEdit Lite 6.1 for 05 X TEXT
application/text -E" BEBEdit Lite 6.1 for 05 X TEXT
image/jpeg ﬂ:lﬁraphiccnnuerter JPEG

MNew... | x[hange...x * Delete

( Cancel ) { OK }

Figure 49 The attachments type mapping dialog

To add a new mapping to the list click the Add... button. This allows you to set the MIME
type and subtype and the corresponding file extension for the mapping. You can also

choose which option to use for opening a file when a matching MIME part is downloaded
to disk.

To edit an entry, selectthat entry in the table and click the Change... button.
To delete an entry, selectthat entry in the table and click the Delete button.
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4.13 Spelling

Spelling Preferences

! Options | Suggestions .

@ Case Sensitive

" Ignore Capitalised Words (e.q. Mulberry)

| lgnore All-Caps Words (e.g. IMAP)

@ lgnore Words with Mumbers (e.g. System32)
@ lgnore Words with Mixed Case (e.g. SpellCheck)
@ lgnore Domain Mames (e.q. XxyZ.com)

@ Report Doubled Words (e.g. the the)

E Auto Correct

E Automatically Position Dialog

: Always Check Spelling before Sending
E Check Spelling whilst Typing

E Use Colour for Errors: |:|

LA

Main Dictionary: American English -

Figure 50 The Spelling preference panel.

4.13.1 Options Tab

Case Sensitive To testwords case-sensitively,turn this on.

Ignore Capitalised To ignore words that are capitalized, turn this on.
Words

Ignore All-Caps  To ignore words that contain only capitalized letters, turn this on.
Words

Ignore Words To ignore words that are a mixture of letters and numbers, turn this
with Numbers on.
Ignore Words To ignore words that contain both lowercase and uppercase characters

with Mixed Case within it, turn this on.
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Ignore Domain To ignore words which look like internet addresses,turn this on.
Names

Report Doubled To generatea warning when aword appearstwice, turn this on.
Words

Auto Correct To automatically correct certain well known misspellings, turn this on.
Automatically To automatically position the spelling dialog above the text areabeing
Position Dialog checked, turn this on.

Always Check To have spelling checkedbefore sending, turn this on.

Spelling before

Sending

Check Spelling To have spelling checkedaswords are typed, turn this on.

whilst Typing

Use Colour for To use adifferent background colour for misspelled words, turn this
Errors on and choosea suitable colour.

Main Dictionary =~ Choosethe dictionary to be used to check words.

4.13.2 Suggestions Tab

Options Sugoestions ]

E Phonetic Suggestions
E Typographical Suggestions
E suggest Split Words

Suggestions:

IE‘I Fast but less Accurate
") Moderately Fast and Accurate

) Slow but Accurate

Figure 51 The Suggestionstab in the Spelling preference panel
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Phonetic

To have suggestionsthat sound similar to the misspelled word

Suggestions returned, turn this on.

Typographic To have suggestionsthat correspond to typing errors of the misspelled
Suggestions word returned, turn this on.

Suggest Split To have suggestionsthat can be more than one word, turn this on.
Words

Suggestions To determine whether the suggestions are returned quickly or more

accurately, choosethe appropriate option.
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4.14 Speech (Mac OS X Only)

This panel will only be available if the Mac!OS X Text-To-Speech software is installed on
your computer.

Speech Preferences

Automatic Speech:
: Speak Mew Messages in INBOX
: Speak Messages as they Amive

Message Speak:

= =

Incoming Outgoing

Maximum characters to speak: 4096

Empty Item: This field is blank

Figure 52 The Speechpreference panel.

Speak New To automatically have new messagesin your INBOX spoken after you
Messages in open the INBOX window, turn this on.
INBOX

Speak Messages as To have new messagesspoken when they arrive, turn this on. You can
they Arrive use this to have parts of new email messageread to you asthe
messagearrives (e.g.the name of the sender and the subject).

Speak New Email  To have the new email alert speaktext instead of beep, turn this on.
Alert
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Speak

Enter the text to be spoken when new email arrives if the previous
option is on. Use a single O#@ have the number of new messages
spoken for eachmailbox which hasnew email. Use a single O*t have
the name of the mailbox spoken for eachmailbox that has new email.
Use O## have the total number of new messagesin all mailboxes
with new email spoken. Use O**( have the names of all mailboxes
with new email spoken one after the other in turn.

Incoming

To edit which parts of anincoming messageare spoken, click here. This
brings up adialog box (shown in Figure 53)from which messageitems
and suitable text can be specified for speaking.

Outgoing

To edit which parts of a draft messageare spoken, click here. This
brings up adialog box (shown in Figure 53)from which messageitems
and suitable text can be specified for speaking.

Maximum
characters to speak

The maximum number of charactersin the body of a messagethat will
be spoken. Use this to limit the amount of text spoken.

Empty Item

The text to be spoken when afield in the messagebeing read is empty
should be entered here.

4.14.1 Speech Configuration

Configure Message Speech

Message Speech:

Iltem to Speak Text to Speak bafore Iteam
From {1st address) From
subject Sulbject

“ New... |

( Cancel ) f oK )

Figure 53 The dialog used to configure which parts of a messageare spoken

Mulberry Reference Guide v4 105



To add a new mapping to the list click the New button to createa new blank entry. This
will bring up the dialog box shown in that allows you to choose which message field is read
and to specify the text to be spoken before that item is spoken. To edit an entry, double-
click that entry in the table. To delete an entry, usethe delete key.

Edit Message Speech

aw

ltem: From {1st Address) f

Text: rru:.rrJI

( Cancel ) ( 0K )

Figure 54 The dialog used to edit items in the speechconfiguration dialog

You can selectwhich messageitem to speak from the pop-up menu shown in Figure 55.
The OTextfeld canbe setto text that will be spoken before the messageitem is read. The
ONoneflem can be used to speak some text at any point during the messagespeak process.

= From {15t Address)
From {All Addresses)

To {15t Address)
To (All Addresses)

CC {15t Address)
CC (Al Addresses)

Date
Subject
MNumber of Parts

Body (without Header)
Body (with Header)

None

Figure 55 The pop-up menu of message items that can be spoken
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5. USING MULBERRY

To help you read, compose,and manage your email and calendar data, Mulberry uses
several different windows. The bestway to becomefamiliar with Mulberry is to learn
about the information contained in eachmajor window. Eachsubsectionin this chapter
describesone of MulberryOsmain windows, dialogs and menus that might be encountered
in the window, and important conceptsto know when using the window.

5.1 Windowing Modes

5.1.1 3-Pane or Separate Windows

Mulberry supports two different window modes for organizing the information it hasto
display. A email client typically has three main categories of information to display for
incoming email: alist of mailboxes where email messagesare stored; the contents of a
mailbox showing the list of messagesin that mailbox; the content of a message.In the 3-
pane window mode, a single window is used to contain all three categories,whereasin the
separatewindows mode, eachcategory appearsin its own window. Thereis a similar setof
three categoriesrequired for displaying address information.

Mulberry defaults to using the 3-pane mode for new installations. It can be switched
between 3-pane mode and separatewindows mode at any time whilst it is running.

To switch into 3-panemode from separate | SelectUse 3-pane Window from the
windows mode Layout sub-menu in the Window menu

To switch into separatewindows mode SelectUse Separate Windows from the
from 3-pane mode Layout sub-menu in the Window menu

5.1.2 Window Action Options

Various windows and panesin Mulberry show lists of data. Someof that data represents
objectsthat can be 'opened’ or displayed in other windows or panes(e.g. mailboxes or
messages)Mulberry allows you to configure exactly what user 'action' can be used to
trigger the open/display operation in each of the various lists it displays.

The possible actions available are:
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Action

Description

Selection Change

The action is triggered when a single item in
the list is selected, either via a mouse click or
via the keyboard.

Single Click The action is triggered when the mouse is
clicked on a single item.

Double-Click The action is triggered when the mouse is
double-clicked on a single item.

Type a Key The action is triggered when the specified

key is typed on the keyboard, and it
operateson whatever is selectedin the list
when the key is typed.

Table 1 Possibletriggers for window actions.

For eachlist, there may be two possible setsof action that can be used. One controls the
'‘preview' behavior, the other the 'open' behavior. 'Preview' behavior is used to display the
chosen list item in the pane in the same window as the list that is being used for previewing
that type of data. For example, the messagepreview pane in the 3-panewindow is used to
display messagepreviews from the mailbox pane (which shows the list of messages).The
preview action will determine when the messagepreview pane is changedin responseto
an action in the mailbox pane.'Open' behavior is used for opening the chosenlist item into
its own window. For example, a messagewindow can be opened to display the content of
amessagein its own window. The open action will determine when the messagewindow
Is opened in responseto an action in the mailbox pane.
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Server Pane
To Preview a Mailbox

Selection Change

Single Click

%Dﬂuble Click
Type Key

Tpace

To Dpen a Mailbox Window
: Single Click
Double Click

Type Key

return

"_ Choose \

Selection Change

". Choose \

Window Options

{ Email | Contacts

Calendar |

Mailbox Pane
To Preview a Message

E Selection Change
Single Click
Double Click

__ Type Key

II Il

To Open a Message Window

" Selection Change
" _Isingle Click
%Dﬂuble Click

Type Key
retum

". Choose H

Options
W Use Tabbed Display
@ Restore Tabs on Start

Message Preview
Preview Options
E Show Address Bar
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Figure 56 The Window Options dialog.

The window action options can be configured separately for the 3-panewindow and for
separate windows, and for email related lists and contact related lists. The Window
Options dialog shown in Figure 56 can be used to setthese options.

5.1.3 Toolbars

Every major window in Mulberry contains atoolbar at the top of the window. The toolbar
contains buttons that causecertain actions to be executed depending on the button, the
window it is in, and whatever might be selected in that window.

ad

Create

|

Draft
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Figure 57 A typical toolbar in a window.
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Figure 57 shows atypical toolbar. On the far-left of the toolbar is a button that can be
clicked to 'collapse’ the toolbar to athin areathat doesnot show any buttons. When the
toolbar is collapsed, another button on the left can be clicked to expand it.

Toolbars in all windows canbe completely hidden by selecting the Hide Toolbar
command in the Toolbars sub-menu of the Window menu. Toolbars can be shown again
by selecting Show Toolbar from that same menu.

Toolbar buttons can contain an icon (large or small) and text. You can control whether
icons or text are shown or whether small or large icons are used using the Toolbars sub-
menu of the Window menu.

5.1.3.1 Changing Buttons on the Toolbar

The setof buttons in any toolbar can be customized by adding or removing buttons and
empty spaceor vertical dividers, or by moving existing items to re-order them. A context
menu is used to manage the toolbar.

Toolbars can contain three types of Ospaceréement:

¥ OsSeparatorO D this is a thin vertical line used as a divider between different groups of
buttons.

¥ OSpaceO b this is a blank space of fixed width used to increase the gap between buttons.

¥ OExpandable SpaceO b this is used to add space which fills the available space left in the
toolbar. Inserting an expandable spacebetween two setsof buttons results in the
second set appearing right-justified in the toolbar. Only one expandable space can be
presentin atoolbar.

To add anew item, bring up the context menu on the toolbar, choosethe Add Toolbar
menu item and selectthe appropriate button, divider or spacefrom the sub-menu.

To remove an item, bring up the context menu on that item and choosethe Remove item
from the menu.

To move an item, bring up the context menu on that item and choosethe Move item from
the menu. After releasing the mouse, the button will highlight and you can move the
mouse left or right to drag the toolbar item to a new location. Once the item is in the new
location, click the mouse button once to drop it in place.

The Reset to Default Buttons item in the context menu can be used to resetthe toolbar
to the default setof buttons built-in to Mulberry.
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5.2 3-Pane Window

Ne e Mulberry (Connected)
r? = o L] i ] P
A By = G % B ® QD
Draft Create Reply Forward Move to Delete  Expumge Match Select Chack  Search Deetails
{ Email | Contacts | Calendar | | /3% INBOX  read-mail | sent-mail } |
Name | & 95| & imap:INBOX.sent-mail X
INBOX 509 507 — =
v [ subscribed — =
- g / =
&3 INBOX.read-mail 1 0 |] |From. To |Date Sent |Thread
1 @ B vince@cyrusoft.com 2501 4:02 PM JP test
» ECompzny L & . - e e e s
- . - 2,-5 v IILTCVCITTLL T T UL T TT g =8
> &?f‘nends 3 L B Happy Customer 6/8/98 8:01 PM Re: Mulberry is Great!
=3 from the bass 4 (58w Hapoy Customer 5/5/03 4:03 PM Re: Mulberry is Great!
e jane - - 5@ B Vince Everrett 6/8/98 8:02 PM W are you?
&5 read-mail 1 0 (B P friend®domain.uk 6/8/98 2:01 PM Mulberry is Great!
&5 sent-mail g 0 7 @ B friend®domain.uk 29/5/03 11:50 PM  Re: Mulberry is Great!
& work B B 3] @ P vince everett 29/5/03 11:51 PM Test Message
9  PMailing List 29/5/03 11:52 PM I
Total: 9 Unseen: O Deleted: 1 Found: O
From: Vince Everett <vince®cyrusoft.coms To: Happy Customer <happy®domain.uks>, ... ©cis [y
Subject: Re: Mulberry is Great! Date: 6/8/98 8:01 PM
P Parts: 1 lEl Formatted | :] |A*IA_| All Quotes
> On Mon, Feb 28, 1995 3:17 pm "Happy Customer”™ <happy@domain.uks
= wrote
> I think Mulberry is great - don't you?
Yes - but I wrote it so what do vou expect?
Status: idla

Figure 58 The 3-pane window showing email information.

The 3-pane window displays either email or contact information in each of its resizable
panes. The window contains the following areas:

¥ The Tool Bar
Contains a set of buttons to control actionsin the various panes. The buttons will

operate on the 'active' pane in the window. The 'active' pane has a rectangular border
around it. To activate a pane, simply click anywhere in that pane.

¥ The List Pane

Contains a set of tab buttons at the top to switch between viewing Email , Contacts
or Calendar in the entire 3-panewindow. When setto Email, the list pane shows the

list of email accounts and lists of mailboxes within those accounts. When set to

Contacts, the list pane shows the list of address accountsand lists of address books
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within those accounts. When set to Calendar, the list pane shows the list of calendar
accounts and lists of calendars within those accounts.

¥ The ltems Pane

When setto Email, the items pane shows the content of one or more mailboxes. When
more than one mailbox is being displayed, eachhas an associatedtab button at the top
of the pane, and you can switch between viewing eachmailbox by clicking on the
corresponding tab. For more details about managing mailbox tabsin this pane, seethe
Referenc&uide When setto Contacts, the items pane shows the contents of a selected
address book. When setto Calendar, the items pane shows the view of subscribed
calendars.

¥ The Preview Pane

When setto Email, the preview pane shows a selectedmessageand associated
addressing and attachment information. When setto Contacts, the preview pane
shows information about a selectedaddressor group, which can be changed. When set
to Calendar, the preview pane shows details about the currently selectedevent or task.

To resize the panes, click on the areabetween them (the cursor will changeto a horizontal
or vertical bar when over that area) and drag the mouse.

You can show or hide any pane in the 3-panewindow by selecting the Show / Hide
List/ Items / Preview menu commands in the Window menu.

You can zoom a specific pane to fill the entire 3-panewindow areaby clicking on the zoom
button in the top-right corner of the relevant pane.

5.2.1 Layout Geometry

The 3-panewindow has eight different layouts for the three panesthat it contains. You can
selectdifferent layouts for Email or Contacts, if desired. The layout geometries are
enumerated in Table 2. To change layout geometry, selectthe appropriate item from the

Layout sub-menu in the Window menu.

List Vertical List Horizontal
ITEMS LIST

LIST
PREYEW ITEMS | PREWEW
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ltems Vertical Items Horizontal

LIST ITEMS
ITEMS
PREWMEW LIST FREWEW
Preview Vertical Preview Horizontal
LIST LIST ITEMS
PREYEW
ITEMS PREWEW
All Vertical All Horizontal
LIST
LIST [ITEMS |[PREVIEW ITEMS
PREYEW

Table 2 3-pane Window Layout Geometries

5.2.2 Email Toolbar

When setto view email details, the 3-panewindow toolbar contains the following items:

74

Draft

Create a new draft window to allow you to compose a new message.

Login or logout of the email server selectedin the server pane. This is

ME only meaningful for IMAP servers.
Legin

Createsa new mailbox in the server pane.
Create
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o
Cabinet

Allows you to toggle the display of cabinetitems in the server pane.

i

Reply

Createsareply to messagesselectedin the mailbox pane, or the
message in the preview pane, depending on which is focused.

&

Forwards the messagesselectedin the mailbox pane, or the message
in the preview pane depending on which is focused.

Foreard
- Copies or moves the messagesselectedin the mailbox pane, or the
(= message in the preview pane depending on which is focused.
Maowve to
s Deletesthe messagesselectedin the mailbox pane, or the messagein
the preview pane depending on which is focused.
Delete
Expunges (permanently removes) deleted messagesin the mailbox
f@l shown in the mailbox pane.
Expurnge
@ Turns on or off the mailbox view Match behavior.
Match
Selectsmessageswith the flag criteria (chosenfrom the popup menu)
% in the mailbox pane.
Selact
y Checksthe selectedmailboxes in the server pane for new email, or
VR checksfor new email in the mailbox shown in the mailbox pane
Chack depending on which is focused.
3 Searchesfor messagesin the selectedmailboxes in the server pane, or
—y the mailbox shown in the mailbox pane depending on which is
Sparch focused.
= Displays information about the mailboxes selectedin the server pane,
Ll-../' or the mailbox shown in the mailbox pane depending on which is
Details focused.
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Table 3 3-pane Window Email Toolbar
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5.2.3 Contacts Toolbar

When setto view contactsdetails, the 3-panewindow toolbar contains the following items:

Create a new draft window to allow you to compose a new message.

Createsa new address book.

Mew

T=1s Opens the address book selectedin the address book manager pane.
1

Open

E Deletesthe address books selectedin the address book manager

E i ! pane.
Delete

O Createsa new addressin the current address book shown in the
(e address book pane.

Single

. Createsa new group in the current address book shown in the

&_; address book pane.

Group

Q Deletesthe addressesor groups selectedin the address book pane.
e
D=lete

— Allows searching for addressesin address books.

% é.l
Search

. Shows details about the address books selectedin the address book

) 1 manager pane, or the address book shown in the address book pane.
Details

Table 4 The 3-pane Window Contacts Toolbar
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5.2.4 Calendar Toolbar

When setto view calendar details, the 3-panewindow toolbar contains the following items:

; Createsa new draft window. When an event or task is selected,the
M selected item is added to the draft as an attachment.

Changescalendar accounts between online and offline states.

Login
— Creates a new calendar or calendar container in a calendar account.
Create
E | Createsa new event.
Event
| | Createsa new to do item (task).
To Do
Changes the calendar view to display a single day.
(]
Diay
Changesthe calendar view to show the work days.
Work
Changesthe calendar view to show an entire week.
Weelk

Changesthe calendar view to show an entire month.

Changesthe calendar view to show an entire year.

Changes the calendar view to display a listing of events within a
specified time range.

SUITHTAY
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Shows or hides the tasks view.

Changesthe current event view so that the current day is displayed.

= -] =
] i
[ |«.'L
=
(1]

-
=]
=
(7]

T

Switches the current event view so that a chosen date is displayed.

I8

i
=
[=]

When a calendar or calendar account is selected, this will display a
dialog providing details about the selected item.

E..

Details

Table5 The 3-pane Window Calendar Toolbar

5.2.5 Server Pane

The server pane is used to display email accounts and mailboxes. A full description of the
pane can be found in Section!5.4where the Server Window is described.

5.2.6 Mailbox Pane

The mailbox paneis usedto display the content of a mailbox - the list of messagesn that
mailbox. The mailbox name is listed at the top of the pane. If the mailbox state cannot be
changed, the mailbox name will have the text (Read-Only) appended to it. Operations
such as deleting will not be possible in that state.
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5.2.6.1 Mailbox Tabs

(F&F INBOX  read-mail | sent-mail | work | friends | o
g imap:INBOX.sent-mail X
From == ]

e rom /70 Thread  |=

1 @ P vince@oyrusoft.com JP test

z E:j i Everrett fest

4 @ B Happw Custormar Re: Mulberry is Great!

[_.‘-'-' I encd®domain.uk Aulbermy is Gre

v @ P friend®domain.uk Re: Mulberry is Great!

a8 @ B vince everett Test Message

S CF  BMailing M
Total: 9 Uns=en: O Deleted: 1 Found: O

Figure 59 The Mailbox Pane with five tabs.

The 3-panewindow supports an optional ‘tabbed' mailbox pane, asshown in Figure 59-
which shows a mailbox pane with five tabs. This allows multiple mailboxes to be open
within the mailbox pane,with atab associatedwith eachat the top of the pane. Clicking on
atab will display the associatedmailbox content. Mulberry preservesthe 'view state'(scroll
position, selectedmessagesmessagebeing previewed) for eachmailbox tab when
switching back and forth between tabs. This allows 'browsing' of multiple mailboxes in an
efficient manner. The tab for a mailbox that contains new messageswill have a% icon

before the mailbox name.

The tabbed behavior is controlled via the Window Options dialog, accessedvia the
Options command in the Window menu. Two options are available:

Window Options item Description

Use Tabbed Display When this is on, the tabbed display behavior
is turned on. When it is off, tabs are disabled
sothat only a single mailbox canbe open
and displayed in the mailbox pane.

Restore Tabs On Start When this is on, any tabs that were
displayed at the time Mulberry was last quit
will be re-opened when Mulberry next starts

up.
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Right-clicking on atab brings up a context menu, asshown in Figure 60, that allows you to
changethe position of the tab, aswell assetcertain properties on the tab.

Move Left
Move Right
Move to Start
Mowve to End

Close
Close All
Close Others

Rename...

Lock
Lock All
Dynamic

Save Current Set
Restore Last Set

Figure 60 The Mailbox Panetabs' context menu.

Mailbox Tab menu item Description

Move Left Move the tab clicked on one position to the
left in the tab list.

Move Right Move the tab clicked on one position to the
right in the tab list.

Move to Start Move the tab clicked on to the start (far-left)
of the tab list.

Move to End Move the tab clicked on to the end (far-
right) of the tab-list.

Close Close the tab (and thus the mailbox) of the
tab clicked on. This may be disabled if the
tab is locked.

Close All Close all unlocked tabs (and thus all
mailboxes) in the mailbox pane. Tabsthat
are locked will not be closed.
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Close Others Close all unlocked tabs (and thus all
mailboxes) in the mailbox pane other than
the one being clicked on. Tabsthat are
locked will not be closed.

RenameE Change the name of the tab clicked on. This
allows an alternative to the mailbox nameto
be used in the tab, which helps avoid the
problem of duplicate names (e.g.two
INBOX mailboxes from different accounts).

Lock Locks the tab clicked on. Seebelow for more
details on locked tabs.

Dynamic Changesthe 'dynamic state’ of the tab
clicked on. Seebelow for more details on
dynamic tabs.

A 'Locked' tab is one that cannot be accidentally closed. The context menu close
commands, the File menu Close command and the tab Close button (far-right of the tab
area) are disabled for locked tabs. Locking is useful for mailboxes you always want to be
tabbed.

The 'Dynamic' tab is a tab that will be reused when a new mailbox is opened. Only one tab
in the entire list can be dynamic, but it is also possible to have no dynamic tabs. This
behavior is useful when you have afixed setof mailboxes you always want visible (locked)
but then want to 'browse' other mailboxes without adding more and more tabs for each.
The dynamic tab will be reused for eachof the additional mailboxes being browsed.

5.2.7 Message Preview Pane

The messagepreview pane, asshown in Figure 61is used to display a chosenmessage
from the mailbox currently on display in the mailbox pane.

From: Vince Everett <vince@cyrusoft.com>  To: Happy Customer <happy®@domain.uk>, ... [y
Subject: Re: Mulberry is Great! Date: 678798 8:01 PM
= Parts: 1 = Formatted ﬂ A“lA~ All Quotes _t]

------ 105 217 me “Harnu Cncdknmer®  shanmudoen s
- e - "N | i L L* i3 L L § i N .

[

Tes - but I wrote 1t so what do yvou expect?

Figure 61 The messagepreview pane.
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The messagepreview pane hasthree main sections:

¥ The Address Bar which is used to provide summary information about the message
(the From, To and CC addresses,the Subjectand Date).

¥ The Parts Toolbar which is usedto provide information about the parts in the message.
¥ The MessageText Display which shows the messagecontent
The Parts Toolbar and Message Text Display are described in more detail in Section!5.8.

The components of the messagepreview can be controlled via the Window Options
dialog, accessedvia the Options command in the Window menu.

Window Options item Description

Show Address Bar When this is on, the address bar summary
information is displayed in the preview
pane.

Show Summary Headers When this is on, summary messageheader

information is displayed at the top of the
Message Text Display in the preview pane.

Show Parts Toolbar When this is on, the parts toolbar will be
displayed in the preview pane.

5.2.7.1 Changing Seen State

When an unseen messageis opened into its own window, it is always marked asseen.
When a messageis previewed in apreview pane,you cancontrol whether the seenstateis
changed immediately, after a short delay (assuming the messageis still previewed after
that delay) or not at all. This is controlled via the Window Options dialog, accessed via the

Options command in the Window menu.

Window Options item Description

Mark it Seen When this is on, the message will always be
marked seenassoon asit is previewed.

Mark it Seen After: When this is on, the messagewill only be

marked seenafter the specified delay,
assuming it is still being displayed at that
time.

Don't Mark it Seen When this is on, the messagewill not have
the seenflag turned on when it is
previewed.
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5.2.8 Address Book Manager Pane

The address book manager pane is used to display address book accountsand their
associated address books. A full description of the pane can be found in Section!5.10 where
the Address Book Manager Window is described.

5.2.9 Address Book Pane

The address book pane is used to display the content of an address book - both the single
address entries and the group entries. A full description of the pane can be found in
Section!5.12 where the Address Book Window is described.

5.2.10 Address/Group Preview

The address/group preview pane is used to display an address or group. The address or
group can be edited directly in the preview pane. A full description of the pane can be
found in Section!5.12 where the Address Book Window is described.

5.2.11 Calendar Store Manager Pane

The calendar store pane is used to display calendar accounts and their associated calendars.
A full description of the pane can be found in Section!5.13 where the Calendar Store
Window is described.

5.2.12 Calendar View Pane

The calendar pane is used to display the content of one or more calendars. A full
description of the pane can be found in Section!5.14 where the Calendar Pane is described.

5.2.13 Event/task Preview Pane

The event/task preview pane is used to display a details about an event or task. A full
description of the pane can be found in Section!5.14 where the Calendar Pane is described.
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5.3 Status

Mac OS X
UNIX

The status line at the bottom of the 3-panewindow provides status
information about the Network operations currently in progress. It will also
give an indication of the progress of operations that may occasionally take a
long time to complete (for example sending large attachments or opening
large mailboxes).

In separatewindows mode, the status information appearsin its own
window. Clicking the close box will hide the window. To see the window

again selectthe Status item from the Window menu (seepage 311).The
location of the status window and its hidden/shown state are saved in the
current preferencesfile when Mulberry is closed, and then restored from
that preferences file when it is used to launch Mulberry again.

WINDOWS

The status line at the bottom of the main window provides status
information about the Network operations currently in progress. It will also
give an indication of the progress of operations that may occasionally take a
long time to complete (for example sending large attachments or opening
large mailboxes).
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5.4 Mailbox Server Pane/Window

! Email | Contacts = Calendar | R

Name By W

&3 INBOX 509 501
v [ subscribed

e INBOX. read-mail 1 0

> I:_=| Company
P &g friends 4 0

@ from the boss

G jane

G read-mai

g sent-mail 5

o work

Figure 62 The server pane.

The server pane, an example of which is shown in Figure 62, displays several different
entities, the most important being all of the email serversasdefined in the OAccountsO
preferences,aswell asthe mailboxes available on eachemail server.

Depending on how youOveconfigured Mulberry, the server pane/window candisplay a
simple list with your INBOX and a few mailboxes of interest, or a complex list of multiple
email servers, subscribed mailboxes, cabinets, and display hierarchies.

The server pane is divided into two main sections:

¥ Theitems in the Column Header section indicate what type of mailbox information is
displayed in the corresponding column in the Mailbox List section.

¥ The Mailbox List section displays lists of mailboxes, cabinets, email servers, and other
items.

5.4.1 Server Window Toolbar Buttons

The server window hasatoolbar associatedwith it, whereas the server pane in the 3-pane
window usesthe toolbar in the 3-pane window.

The server window toolbar contains the following items:
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Draft

Create a new draft window to allow you to compose a new message.
For more information on the compose window, seepage!224.

Login

Login or logout of the email server selectedin the server pane.
Logging in to an IMAP email server automatically generatesa list of
mailboxes available on the selected server, which includes your _
INBOX, any subscribed folders, and any display hierarchies youOve
previously specified. POP email servers and local mailbox accounts
are always OloggednOLogging out of a server causesMulberry to
terminate all connectionsto that server. Note that Mulberry
maintains a constant connection to an IMAP server when logged in.

If you only have one email server account setup, the Login button
will act on that server, and will always be available. If you have
multiple email server accountssetup, you must selectone of those
accountsin the OMailboxListOsection of the server window to make
this button active.

When you are already logged in to the selectedemail server, the
Login button will changeto a Logout button. Logging out of a
server causesMulberry to terminate all connectionsto that server.

Creates a new mailbox in a selected email account or within a selected
display hierarchy. When you click this button, you will be presented
with a OCreatéMailboxOdialog that allows you to enter a name for the

Create
new mailbox and specify where it will be created. This button is not
available unless a email server, display hierarchy or mailbox (that is
allowed to contain other mailboxes) is selected.Creating mailboxes is
covered in more depth on page!137.
— Allows you to toggle the display of cabinetitems in the server pane.
v More information on cabinetsis available on page!138.
Cabinat
R Checksthe selectedmailboxes in the server pane for new email.
I'I‘_il;,-"l
Chack
e Searchesfor messagesin the selectedmailboxes in the server pane.
— When you click this button, you are presented with a new search
Sparch window. The searchwindow is covered on page!167.
i Displays information about the mailboxes selectedin the server pane.
Details

Table 6 The Server Window Toolbar
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5.4.2 Column Headers

The column headers indicate what mailbox information is displayed in each column in the
mailbox list below it. The column indicates with text or an icon what the information is:

Name

The name of the displayed item.

= State

Icons representing the state of the corresponding mailbox. These
icons include:

ws Indicates that the mailbox is open and a corresponding
mailbox window is on screen.

L!.I Indicates that the mailbox is closed, but is marked for
automatic email checking.

s~ Indicates that the mailbox is closed, but it has new messages.
No icon meansthe mailbox is closed and hasno new messages.

& Total

The total number of messagesin the mailbox the last time it was
checked. If the mailbox has never been checked or opened, a dash
will appear.

™ Recent

The number of new messagesthat have arrived in the mailbox the
last time it was opened. If the mailbox has never beenchecked or
opened, a dash will appear.

(e

uUnseen

The number of unseenmessagesin the mailbox the last time it was
checked, or, if the mailbox is open, the current number of unseen
messagesn the mailbox window. This last value may be different
from the total number of unseen messagesin the mailbox if the
mailbox window is only displaying a subset of all the messages in
the mailbox. If the mailbox has never been checkedor opened, a
dash will appear.

u Favorite

A Odiamond®utton that can be clicked to turn on or off automatic
checking of the corresponding mailbox. If the mailbox is marked for
automatic checking the button will have a check mark:

o Indicates a mailbox not marked for automatic checking.

4 Indicates a mailbox marked for automatic checking.

Mailboxes marked asfavorites are automatically added to the
OCheckavoritesGcabinet. For more information on cabinets, see
page!138.
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Size The size of the mailbox. This information is available for locally-
stored mailboxes, such as mailboxes in a POP or Local Mailbox
account, or IMAP mailboxes cached for disconnected mode
operations.

For IMAP mailboxes in connected mode, the size hasto be manually
calculated. For mailboxes that have not had their size calculated the

button appears. Clicking this button will cause Mulberry to
calculate the mailbox size and then display it in place of the button.

f  Hierarchy This button is only available when a cabinet or display hierarchy is
Display Toggle selected. Items within cabinets and display hierarchies can be
= Button viewed as either a flat or hierarchical list. Clicking this button

toggles between thesetwo views.

Column headerscan be re-arranged, added, or deleted.

Mac OS X Hold down the control key and click the mouse button (ctrl-click) on a
column header to changethe column type, insert a new column, or delete

the column.
WINDOWS Click the right mouse button on a column header to changethe column
UNIx type, insert a new column, or delete the column.

When you do this, the menu shown in Figure 63 will appear.

State

v Total
Recent
Unseen
Favourite
S5ize

Insert Column after
Insert Column before
Delete Column

Figure 63 The pop-up menu for changing column headers in the server window

Note: The ONameO column, which displays the names of the various items in
the server pane/window, is always present and cannot be changed or
deleted. However, you caninsert columns before or after it. Additionally, the
hierarchy display toggle button cannot be changed or removed.
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5.4.3 Mailbox List

The main purpose of the mailbox list section of the server window is to display the various
mailboxes available to you. However, depending on the number and type of email servers
you have accessto, your list of interesting mailboxes may be quite large. In order to help
you categorize and organize your mailboxes, several types of entities other than mailboxes
can be displayed in the server window. The following icons represent thesedifferent
entities:

Servers
v/ An IMAP server account.
w An IMAP server account that is available for use in disconnected mode. This icon

is only shown when in disconnected mode.

A POP server account.

& &

A Local Mailbox account.

Mailboxes

A remote mailbox that can be opened.

A remote mailbox that cannot be opened or that failed to open in the past.
A remote mailbox that contains no new messages.

A remote mailbox marked asinteresting.

B0 XKE

A mailbox with messagesstored on the local disk. This can either be a mailbox
within a POP or Local Mailbox account, or an IMAP mailbox that has been
synchronized for usein disconnected mode.

(@

A mailbox whose contents are only available while in connected mode.

Note: Mulberry depends on responsesfrom the IMAP server to
decide which of the remote mailbox icons to display for a particular
mailbox. SomelMAP serversdo not communicate mailbox states,in
which case the first remote mailbox icon will be used for all
mailboxes.

Cabinet

Iﬁ A cabinet, which storesaliasesof mailboxes (seepage 138).

[

An alias to a mailbox, found within a cabinet
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Mailbox ‘containers’

& A folder, which may contain more mailboxes or other folders. Note that unlike a
mailbox, a folder does NOT hold email messages. It is simply used as a
placeholder within a hierarchical list of mailboxes.

= A display hierarchy, which may contain mailboxes or folders (seepage!133).

E] The subscribed mailbox list.

At the highest level, the mailbox list shows all of the email serversyou have defined in the
Accounts preferences panel, listed alphabetically, as well as any cabinets that you have
made visible. Within each email account, the INBOX is shown at the top, followed by the
list of subscribed mailboxes and any display hierarchies that have been defined, listed
alphabetically.

Figure 62 shows a simple server pane, with the default column headersand only one email
server defined. There are no subscribed mailboxes, and one display hierarchy is defined.
Notice that since only one email server account is defined in the Accounts preferences
panel, the name of the accountis shown in the title bar of the server window rather than in
the mailbox list area. Because only one display hierarchy is defined in this example, the
contents of the hierarchy are displayed directly in the mailbox list area.

A more complex server window is shown in Figure 64. The window shows multiple email
accounts and their contents. Since multiple email accounts are defined, the title of the

server window is simply OServers@nd the contents of eachserver account are displayed
under a collapsible header. The list of OSubscribedO mailboxes in the third email account (the
second IMAP account) is shown as a flat list, while the contents of the expanded display
hierarchy OINBOX.*O in the first IMAP account is shown as a hierarchical list.
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e 06 Servers (Connected)

A s @ Q| D

Draft | it Create Cabinet | Check Search | Details
| Name | &) F(E
¥ @imap i
INBOX 509 501 ;
b4 Subscribed
e INBOX. read-mail 1 0
v INBOX.
> I_'_=| Company
| e friends 4 0
@ from the boss
o jane
g read-mail 1
e sent-mail 5
g work
v (& ror3
& INBOX 0 0
v [@)Local
ﬁ Home - F

ﬁTest - . |4

ﬁ Work - - | ¥
4

Figure 64 The server window with multiple email accounts, multiple display
hierarchies and some subscribed mailboxes

Double-clicking on a server name will open anew window, similar to the server window,
but displaying only the contents of that email server account. Clicking or double-clicking a
mailbox in the list will open a mailbox window containing message captions for that
mailbox (seepage 158).

Note that several items in the server window, including email servers, cabinets, and all
hierarchies can be expanded and collapsed using disclosure buttons. This allows you to
organize a complex server window to show only the mailboxes of immediate interest.
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5.4.4 Working with the Server Pane/Window

5.4.4.1 Logging In To Servers

When you open an IMAP mailbox in connected mode, Mulberry must first log in to the
appropriate IMAP server if it hasnot already done so. When you checkfor new email in a
POP3 INBOX mailbox, Mulberry must login to the POP3 server. When a login is necessary,
the dialog shown in Figure 65 appears, allowing you to enter your user ID and password
for that server. If you wish, you can setyour preferencesto automatically login to all
IMAP email serverswhen you start Mulberry (seepage!38).

Note: Your user ID may be specified in the preferences,in which caseyou
will not be able to change it (as shown in Figure 65). Similarly, if you have
also setyour preferencesto savethe password for the current account, the

Login dialog may not appear at all. In addition, some authentication
mechanisms do not require the Login dialog.

Set User ID & Password

Login to IMAP Server:
I“_”I imap (imap.cyrusoft.com)

User ID: vince-1

dowmn

Password:

Method: CRAM-MDS5
Connection: Secure: S5L

[ Cancel | {_ Ok .}

Figure 65 The dialog usedto log in to a server

The login dialog will also appear when alogin is necessaryfor other types of servers,such
as an IMSP or ACAP preferences server. The icon in the login dialog is used to indicate
what type of accountis being logged in to. The server type icons are:

E j For an IMAP email server.

E::J For a POP email server.
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—

For an SMTP send email server.

For an IMSP or ACAP remote preferencesserver.

For an IMSP or ACAP remote address book server.

BO®E

For an LDAP remote addresslookup server.

S

For a ManageSIEVEsieve script server.

C

For a WebDAV or CalDAV calendar server

[

5.4.4.2 Modifying the List of Mailboxes

By default, Mulberry will always show your INBOX as the first item under each email
server account. The INBOX is usually where your incoming email is stored. In the case of
IMAP email accounts, any subscribed mailboxes will be automatically displayed after you
login, in the OSubscribedO hierarchy, immediately below the INBOX. Other mailboxes and
hierarchies are displayed only if you explicitly ask for them. This can be done in two ways:

¥ Open a mailbox directly. This is described in more detail on page 131.
¥ Add a new display hierarchy. This is described in more detail on page 133.

5.4.4.3 Opening Mailboxes

The simplest way to open a mailbox is to click/double-click on the icon of the desired
mailbox in the mailbox list. Alternatively, a mailbox canbe opened by selecting the Open

MailboxE option from the File menu (seepage 296).When you do this, the dialog shown
in Figure 66 is displayed.

In the Open Mailbox dialog, you canenter the full pathname of the mailbox to open in the
ONamee@xt box. If you have configured multiple email server accounts,you can selectthe
account on which the mailbox exists in the OAccountO popup menu. Clicking the BrowseE
button will produce a OBrowse MailboxO window with contents similar to the server
window, allowing you to select a mailbox to open. The Open MailboxE command is most
useful for directly opening mailboxes that arenOt listed in the server window.
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Open Mailbox

Account: Imap

A
e

Mame: |

( Browse... | ( Cancel )

Figure 66 The Open Mailbox dialog

Note: The server window must be the active window for the
Open Mailbox command to be active.

5.4.4.4 Display Hierarchies

Display hierarchies are a means of displaying a list of mailboxes within a particular
hierarchy. Theseare most useful in conjunction with IMAP servers,where mailboxes are
stored in hierarchies, but can also be used to view mailboxes in POP or Local Mailbox
accounts that you have organized hierarchically on disk.

The concept of display hierarchies are somewhat complicated by the fact that different
types of IMAP servers store mailboxes in different ways.

SomelMAP servers store mailboxes within a standard UNIX directory structure on the
server machine. For example, mailboxes can be stored in a userO$iome directory (usually
denoted as O~/O), or in a subdirectory of the home directory, such as O~/mail/O. Since IMAP
serversallow mailboxes to be shared among many users, interesting mailboxes may also
exist in directories outside of a userOs home directory, such as O~bob/mail/public/O or
O~public/O.

In contrast, other types of server maintain a completely separateemail store, which is often
not directly accessible to users except through IMAP. Users can create personal mailboxes
in the INBOX hierarchy, such as OINBOX.workO or OINBOX.friends.bobO. Other usersO
shared mailboxes may be available in a separate hierarchy such as Ouser.bob.publicO.

In order for Mulberry to display the mailboxes available in a particular location on an

IMAP server, a display hierarchy must be created. In simple terms, a display hierarchy is
simply a pointer to a particular location in a email store. For example, a display hierarchy
of O~/*O on the first type of server described above, will list all of the available mailboxes in
auserOsiome directory. An OINBOX.*@isplay hierarchy on the secondtype of server will
list all of a userOs personal mailboxes.

5.4.4.41 Configuring all Display Hierarchies

You can configure all display hierarchies in one go by using the Choose Mailbox Locations
dialog, which is accessedy selecting the Display Hierarchy>Reset All... command from
the Mailbox menu. This dialog, shown in Figure 67,allows you to seewhich hierarchies are
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advertised by the server (if there are any) and what other hierarchies you have specified
by hand.

Choose Mailbox Locations

Mulberry needs to know where to look for mailboxes on your IMAP server. The
sErver suggestions below, are mailbox locations suggested by vour server. You can
use any of these by clicking the button to the left of each entry. You can enter
other mailbox locations in the text area below the server suggestions, one on each
lime. You can alse add mailbox locations later, if you want.

Server Suggestions:

On | Mailbox Location | Type
9 INBOX. Personal
< user. Shared
3 «<«<Entire Hierarchyz== Public

select:  personal )  Shared ) (C Public Y Al Y (7 None )

2 Automatically Add Server Suggestions in Future

Places to Search for Mailboxes on the Server

Company.
demo.

(_Cancel ) 0K )

Figure 67 The Choose mailbox Location dialog box
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Server
Suggestions

Contains the list of display hierarchies advertised by the server via
the optional IMAP NAMESPACE extension. If the account being
changed is not an IMAP account, or is an IMAP account in
disconnected mode, or is an IMAP account on a server that does not
support NAMESPACE, then this list, and the buttons immediately
below it, will not appear.

The list shows the name of eachhierarchy on the left, and the type of
hierarchy on the right. Types are:

¥ Personalba list of mailboxes that belong to you alone.

¥ Sharedballist of mailboxes that belong to other users,
which have beenshared with you.

¥ Public b a list of mailboxes that are publicly accessible and
available to you.

To have Mulberry display or remove from display eachhierarchy,
simply click the diamond to the left of each name.

Personal

Clicking this button will select all the Personal display hierarchies
advertised by the server for display by Mulberry.

Shared

Clicking this button will select all the Shared display hierarchies
advertised by the server for display by Mulberry.

Public

Clicking this button will select all the Public display hierarchies
advertised by the server for display by Mulberry.

All

Clicking this button will select all display hierarchies advertised by the
server for display by Mulberry.

None

Clicking this button will deselect all display hierarchies advertised by
the server from the display in Mulberry.

Automatically
Add Server
Suggestions in
Future

When this option is selected, Mulberry will automatically insert all
display hierarchies advertised by the server into the display, each
time it logs in to that account after startup. To prevent display
hierarchies from automatically appearing, turn this option off, and
deselectthe display hierarchies you want to remove from display in
the list above.

Places to Search
for Mailboxes on
the Server

Enter a list of display hierarchies, one on each line, that you want
displayed by Mulberry. You do not need to add display hierarchies
already selected in the Server Suggestions list, if available.

5.4.4.4.2 Adding a Single Display Hierarchy

To simplify the process of creating display hierarchies, Mulberry provides the Display
Hierarchy dialog, which is accessed by selecting Display Hierarchy>New Display
Hierarchy... from the Mailbox menu. This dialog, shown in Figure 68, allows you to build
a new display hierarchy using a natural language query.
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Display Hierarchy

Search in account ' imap B

for mailboxes  in sub-hierarchy T‘

" Display Full Hierarchy
E‘} Display Top Level of Hierarchy Only

[ Cancel | {_ DK _,'r

Figure 68 The Display Hierarchy dialog box

Several options are available to assist you in finding available mailboxes:

Search in account | |f you have more than one email server account defined, choosethe
account you want to search using this popup menu.

For mailboxes This popup menu specifies the pattern you wish to use to find
available mailboxes. Each of these options works in conjunction with
a string that you type in the text box below the popup menu.
Available options are:

‘whose name starts with’ b find mailboxes with names that begin with
the specified text string.

‘whose name ends with’ D find mailboxes with names that end with
the specified text string.

‘whose name contains’ P find mailboxes with names that contain the
specified text string.

‘whose name is’ D find mailboxes with names that match the specified
text string exactly.

‘in sub-hierarchy”’ D find mailboxes in the hierarchy specified by the
text string

‘in entire hierarchy’ D find all mailboxes available on the specified
email server. The text box will not accept any input if you choose this
option.
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Display Full To have the full hierarchy matching the search pattern initially
Hierarchy displayed, choose this option. Selecting this option causes the names
of all mailboxes in the specified hierarchy to be fetched from the
server when logging in.

Note: This is only available when you are finding
mailboxes using the Oin sub-hierarchyO or Oin entire
hierarchyQoptions.

Display Top Level [ To have only the top level of the hierarchy matching the search

of Hierarchy Only | pattern initially displayed, choose this option. Selecting this option
causesMulberry to fetch only the names of the mailboxes at the top
level of the specified hierarchy when logging in.

Note: This is only available when you are finding
mailboxes using the Oin sub-hierarchyO or Oin entire
hierarchyQoptions.

Once you have created a display hierarchy, it will be shown under the appropriate email
server account in the server window until you delete it. To delete a display hierarchy, click
onceon the hierarchy and selectDisplay Hierarchy>Remove Display Hierarchy... from
the Mailbox menu. To edit adisplay hierarchy, selectDisplay Hierarchy>Edit Display
Hierarchy... from the Mailbox menu. A dialog box will appear asking you to specify a
new path for the display hierarchy. To refresh the contents of a display hierarchy, select
Display Hierarchy>Refresh from the Mailbox menu.

Note: If there is only one display hierarchy defined for a
particular server, only the contents of that display hierarchy will
be visible. To edit or remove a single hierarchy, you needto use
the Server Details window for the server (seepage!Error!
Bookmark not defined.).

Note that some display hierarchies may appear automatically under certain IMAP email
accounts. IMAP serversthat support the NAMESPACE extension (seepage!23)have the
ability to advertise a list of interesting display hierarchies to a email client. Mulberry will
automatically list these display hierarchies if the OAutomatic Hierarchy ListO option (see
page!38) is turned on for a particular IMAP email account.

5.4.4.5 Creating, Renaming, and Deleting Mailboxes

Once you have customized the mailbox list in the server window, you may want to create
your own mailboxes under one or more mail server accounts. You can createa new

mailbox by choosing CreateE from the Mailbox menu or by clicking the Create button
in the window tool bar. When you do this, the dialog shown in Figure 69 is displayed.

There are two types of mailboxes that you can create.One is a mailbox that contains
messagesthe other is a mailbox that is used asthe 'root' for a hierarchy of other mailboxes
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appearing below it. The later is similar to a'directory' in afile system, whereas the former
is similar to afile. You can selectwhich type of mailbox to createby clicking the Create a
Mailbox to Contain Messages or Create a Mailbox to Contain Mailboxes button.

You can chooseto enter the full pathname for the new mailbox (e.g. OINBOX.newbox®r
O~/mail/newboxO) by clicking the Full Pathname button. You can also chooseto create
the mailbox in an existing hierarchy by clicking the Create in Hierarchy button. In this
casejust enter the name of the mailbox (e.g. OnewboxOY.ou can chooseto have the server
automatically subscribe to the new mailbox by selecting the Subscribe when Created
checkbox. When you create a new mailbox, Mulberry will automatically insert it in the
correct location in the serverOsnailbox list and also open an empty mailbox window for
the new mailbox.

Create Mailbox
Eﬁ‘ Create a Mailbox to Contain Messages
__ Create a Mailbox to Contain Mailboxes

Mame:

“J Full Pathname
) Create in Hierarchy:
INBOX.

in Account: imap

| Subscribe when Created

[ Cancel | {_ Ok _}

Figure 69 The dialog used to createa new mailbox on the server

The default selections in the Create Mailbox dialog will vary depending on the item you

had selectedbefore executing the Create Mailbox command. For example, if you click on a
display hierarchy in the server window and then createa new mailbox, the dialog assumes
you meant to createthe new mailbox in that hierarchy. If you click on a server name in the
server window and then createa new mailbox, you will only be able to specify the new
mailbox name using a full pathname.

5.4.4.6 Cabinets

Cabinets provide a powerful mechanism for grouping setsof mailboxes together. In
simple terms, a cabinet is a collection of aliases to different mailboxes. The server window
displays cabinetsat the top of the mailbox list section, before any email serversor
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mailboxes. Cabinets can not be displayed in individual server windows, only the main
server window. You can control which cabinetsare displayed using the Cabinet popup
menu in the server window tool bar. To display a cabinet, click on the Cabinet popup
menu and selecta cabinet name. Cabinets that are currently displayed have a checkmark
in front of their name. To hide a cabinet, click on the popup menu and selectthe
appropriate cabinet name again. Figure 70 shows the server window with three cabinets
displayed:

eSO Servers (Connected)

-~ F = | 3 | =
78 wy @ W Q| D
Draft | it Create Cabinet | Check Search | Details

|Name | @Jl = |E

v [& check Favourite .
&5 imap:INBOX 0 1
s imap:INBOX. read-mail 1 T
s imap:INBOX.sant-rmail 5 o
&5 POP3:INBOX 509 509 |
&5 POP3:INBOX s09 509 ||
&5 CMU:INEOX }
@ dummy:INBOX }

v Mark Seen on Close {
E imap:lists.* "

hJ Mew Messages

s POP3:INBOX 509 509
v @jmap
&3 INBOX 0 0
v Subscribed
e INBOX. read-mail 1 0
v INBOX.
> F:lcnr"npany

Figure 70 The server window with cabinets displayed

Mulberry comeswith several pre-defined cabinets. You can also createas many of your
own cabinetsasyou like. The pre-defined cabinetsthat come with Mulberry are:
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Check Favorites

This cabinet contains a list of mailboxes marked for automatic
checking. This cabinet is used by the first alert style by default
(seepage!50).

Open After Login This cabinet contains a list of mailboxes that Mulberry should
open automatically after starting up.
Copy Messages To This cabinet contains a list of mailboxes that will appear in the

Copy To popup in the Messagewindow or the Copy to
Mailbox sub-menu under the Message menu. Note that the
contents of this cabinet are only used if the OUse&Copy Messages
To CabinetO option is checked in the Mailbox preference panel
(seepage!65).

Copy Drafts To

This cabinet contains a list of mailboxes that will appear in the
Copy To popup in the Draft window or the Append to Mailbox
sub-menu under the Draft menu. Note that the contents of this
cabinet are only used if the OUse&Copy Drafts To CabinetQoption
is checked in the Mailbox preference panel (see page!65).

Mark Seen on Close

Mailboxes listed in this cabinet will automatically have all
messagesmarked as seenwhen their mailbox windows are
closed.

Auto Synchronize

This cabinet contains a list of IMAP mailboxes that will be
synchronized automatically when switching between connected
and disconnected modes. For more information on disconnected
mode operations, seepage!151.

New Messages

This cabinet contains a list of all mailboxes that have been marked
for automatic checking, AND have beenfound to have new
messages since they were last opened. This is a fast and
convenient way to display alist of only those mailboxes that have
new messagesto be read. This cabinetis an example of an
OautomaticO cabinet that is maintained by Mulberry. The contents
of this cabinet can not be changed directly.

Subscribed

This cabinet contains a list of all mailboxes marked as subscribed
in all IMAP email accounts.

Cabinets can contain mailboxes from multiple email servers. When multiple email server
accountsare defined, Mulberry will prepend the server name and a colon (:) to the mailbox
nameswithin a cabinet. The contents of cabinets are always sorted, first by server name
and then either alphabetically or hierarchically.

To add a mailbox alias to a cabinet, first make sure the cabinet s visible at the top of the
server window. Then, simply find the mailbox(es) that you wish to add to the cabinet and
drag the icon for the mailbox(es) onto the appropriate cabineticon. Mulberry will add an
alias to the appropriate mailbox to the selectedcabinet.
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To remove a mailbox alias from a cabinet, highlight the mailbox alias you wish to remove
and pressthe delete key on your keyboard or choose Cabinets>Remove Item from the
Mailbox menu. Removing a mailbox alias just removes that item, it does not delete the
mailbox that it refers to.

Note: You cannot changethe contents of the ONewMessagesO
cabinet. The contents of this cabinet are managed automatically
by Mulberry.

To createyour own cabinet, selectNew... from the Cabinet popup menu or select
Cabinets>New Cabinet... from the Mailbox menu. Mulberry will prompt you for a
name for the new cabinet. User-defined cabinets are listed after the pre-defined cabinetsin
the order that they are created. You can createasmany cabinetsasyou like.

In addition to individual mailbox aliases, cabinets can also contain OwildcardO items. These
items allow you to quickly add the contents of an entire mailbox hierarchy to a cabinet.
For example, you might want all of the folders in your INBOX hierarchy to appear in the
OCopyMessagesToCabinet. One way to setthis up would be to selectall of the folders in
your INBOX hierarchy and drag them to the OCopyMessagesTo(rabinet. Unfortunately, if
you were to then createa new mailbox in your INBOX hierarchy, you would have to
remember to also add that new folder to the OCopyMessagesTo(rabinet. An elegant
solution for this problem is to place a single wildcard entry for the OINBOX.*O hierarchy into
the OCopyMessagesTo(cabinet. OWildcard@ntries are dynamic Devery time they are
needed, the full list of matching mailboxes is determined and substituted for the OwildcardO
entry. Thus any changesto the mailbox hierarchy will always be picked up by the
OwildcardO entry.

To add a OwildcardO entry to a cabinet, click once on the appropriate cabinet and select
Cabinets>New Wildcard Item... from the Mailbox menu. You will be presented with a
dialog box like the onein Figure 71.

Cabinet Entry List

Match mailboxes in account All

anywhere in hierarchy g 1

| Cancel | { DK }

Figure 71 Cabinet wildcard item dialog box

The options in this dialog box are very similar to those in the Display Hierarchy dialog,
described on page!133.
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You can modify a wildcard item within a cabinet by clicking once on the wildcard item and
selecting Cabinets>Edit Wildcard Item... from the Mailbox menu, or by double-clicking
on the wildcard item. A dialog box will appear, allowing you to specify a new path for the
wildcard item.

Note that the mailbox aliaseswithin a cabinet function in amanner very similar to the
actual mailboxes they represent. Double-clicking on a mailbox alias will open a separate
mailbox window for the associatedmailbox. If you attempt to remove a cabinet item using
the Delete... command from the Mailbox menu, you will be asked whether you want to
delete the mailbox alias or the actual mailbox associated with the alias.

5.4.4.7 Closing the Server Pane/Window

Clicking the closebox on the 3-panewindow or the server window will automatically log
you out from any IMAP servers. A dialog box will also appear asking if you would like to
quit Mulberry, or just hide the server window. Mulberry will not operate without the 3-
pane window (in 3-panewindow mode) or the server window (in separatewindows
mode), sothe window will only be hidden if you chooseto closethe window.

Note: Logging out of an IMAP server will close all mailbox and
messagewindows that belong to that server.

To seethe server window again, selectthe appropriate item from the Window menu (see
page 311), which contains a list of all available windows.

Note: Since the server window is hidden, its name appears in
bracketsin the Window menu.

The location and size of server windows are savedin any existing current preferencesfile
when Mulberry is closed, and then restored from that preferences file if it is used to launch
Mulberry again.

5.4.5 Getting Information on Email Servers and Mailboxes

Mulberry allows you to view detailed information on the various email serversthat you
have configured in your Accounts preferences, as well as details about individual
mailboxes. This information will be of most interest to experienced usersand system
administrators.

To get information on a server, click oncein a server pane on the server name or a mailbox
in the server account you want to examine, and click the Details toolbar button, or select
Details... from the Edit menu.

To get information on a mailbox, click once on the mailbox and click the Details button in
the server pane tool bar or selectDetails... from the Edit menu. You will be presented
with the Mailbox Details dialog box, which is shown in Figure 72.
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The Details dialog can have up to five different panels displaying different information
about the server or mailbox. The five possible panels are:

¥ Options
¥ Details
¥ Server
¥ Access *
¥ Quota”
Mailbox: INBOX
- Options e
&4 Options A
gy Details E Check for New Mail with style: Default == ] U
"i..':' Sarver @ Open after Login
|| Use for Copying Messages
S Access (] Use for Drafts or Sent Messages
() Quota || Mark Seen on Close
@ synchronise on Disconnect

Identity
E Tie to ldentity

Identit'_.r." Deefault |

aw
pa—

¢ oK )

Figure 72 The Mailbox Details dialog showing the OOptions'panel

* Note: The OAccessO and OQuotaO panels are only available when
you are communicating with an IMAP email server that
supports the ACL or QUOTA extensions, respectively.
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5.4.5.1 Details: Mailbox Options

Options

E Check for New Mail with style: Default ﬂ
E Open after Login

: Use for Copying Messages

: Use for Drafts or Sent Messages
" | Mark Seen on Close

E synchronise on Disconnect

Identity
E Tie to ldentity

Identity: Default

a8
e

Figure 73 The Mailbox Details OOptions@anel

This panel allows you to setseveral different options for a given mailbox. The available
options are:

¥ OCheck for New Email with styleQ: If turned on, the mailbox will be checkedfor new
messagesat the interval specified by the alert style selectedin the popup (seepage 50).

¥ OOpen After LoginO:  This option tells Mulberry to automatically open this mailbox
after the program is launched and you have successfully logged into the IMAP server
containing the mailbox.

¥ QUsdor Copying MesgagesO:Tbis option lets you add the selected mailbox to the list of
mailboxes used in the OCopyToQmenu in the Messagewindow.

¥ OQuUse for Drgfts@t’his option lets you add the selected mailbox to the list of mailboxes
used in the OCopy ToO menu in the Drafts window.

¥ OMarkSeenon CloseQ: This option tells Mulberry to automatically mark all messages in
the selectedmailbox asseenwhen you closethe mailbox window.

¥ OSynchronize on DisconnectOThis option tells Mulberry to automatically add the
selected mailbox to the list of mailboxes that will be synchronized when disconnecting.

¥ QOTie to IdentityOIf turned on, the identity chosen in the popup menu will be OtiedO to the
selectedmailbox. When creating new drafts, or replying to messagesn the selected
mailbox, Mulberry may automatically select the OtiedO identity in the new draft window.
For more information on tied identities seepage!229.
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5.4.5.2 Details: Mailbox Details

Details e
Name: INBOX P,
server:  imap.cynusoft.com

Hierarchy:
Hierarchy
Separator:
Messages:
Total: O Eecent: 0 Unseen: 0 Deleted:
synchronised State: Full: Partial: Missing:
Size: “ Calculate

Status: Subscribed
WD Validity: 863984863

synchronised:

Figure 74 The Mailbox Details ODetails@anel

The items in this panel are:

¥ ONameO The full pathname of the mailbox.

¥ OServerOThe Internet address of the server on which this mailbox is located.
¥ OHierarchy®  The hierarchy that the folder belongsto, if any.
¥

OHierarchySeparatorO The character that signifies a new level of hierarchy in the
mailbox name.

¥ OMessagesO
b OTotald The total number of messagesin the mailbox.

b ORecentd The number of new messagesin the mailbox the last time it was
checked. This is the number of messageshat have arrived since the last
time the mailbox was open.

b OuUnseenO The number of unseen messagesin the mailbox the last time it was
checked, or, if the mailbox is open, the current number of unseen
messagesin the mailbox window. This last value may be different from
the total number of unseenmessagesin the mailbox if the mailbox
window is only displaying a subset of all the messages in the mailbox.

b ObDeletedO The number of messagesmarked asdeleted in the mailbox, if open. If
the mailbox is closed this value will be empty.
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P OFull®  The number of messagesn an IMAP mailbox that are completed cached
locally for use in disconnected mode.

b OPartiald The number of messages in an IMAP mailbox that are partially cached
locally for use in disconnected mode.

b OMissingd The number of messagesin an IMAP mailbox that are not cachedlocally
for usein disconnected mode.

¥ 0Sized Shows the size of the mailbox in bytes.

+K

OcalculateO Clicking this button causes the mailbox size to be re-calculated.
¥ OstatusO Shows various status information about the mailbox:
O0pend Indicates that the mailbox is open and has a window on-screen.

b

b OSubscribedO Indicates that the mailbox is subscribed to.

b ONdHierarchyO Indicates that the mailbox does not have a sub-hierarchy.
b

OcCannot OpenOlndicates that the mailbox cannot be opened.

v,

Olnterestingd  Indicates that the server has marked the mailbox as OinterestingO.

¥ OUID ValidityD A number that is unique to this mailbox and provided by the server.
This value is only available for IMAP4 and later version servers.

¥ OSynchronizedOShows the date and time that the IMAP mailbox was last synchronized
with a disconnected mailbox on this machine.

5.4.5.3 Details: Server

Mulberry allows you to view detailed information on the various email serversthat you
have configured in your Accounts preferences. This information will be of most interest to
experienced users and system administrators.

To getinformation on a server, click once on the server name or a mailbox in the server
accountyou want to examine, in the server window and click the Details button in the
server window tool bar, or selectDetails... from the Edit menu. The dialog shown in
Figure 75will appear. Click on the Serversbutton to display the server information. The
Server panel in the dialog shows the name of the server, the type of the server recognized
by Mulberry, the OGreeting(@xt, and the OCapability@ext.

¥ The name s just the Internet address of the server.

¥ The type indicates which email protocol Mulberry is using to communicate with the
server. This will depend on what versions the server supports, and will be one of
OPOP30, OIMAP2bisO, OIMAP40 and OIMAP4rev10.

¥ The greeting is the first line of text sent back by the server when first contacted by
Mulberry. It sometimes gives details about the manufacturer and version of the server
software.

¥ The capability text is the information returned by the server when Mulberry requests
information about what commands and extensionsthe server supports. This usually
indicates the version of the IMAP protocol the server is using (e.g. OPOP30, OIMAP2bisO,
OIMAP4rev10 etc.) and any extensions that the server supports (e.g. OACLO or OQUOTAO).
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This information is useful when trying to track down problems with the server, or
making sure you are connected to the right server.

The connection indicates whether an SSL secure connection is in place or not. If one is,

the View Certificate button can be used to view the SSLcertificate that the server

provided.

Server

Marme:
Type:

Greeting:

Capability:

Connection:

o

- r
imap.cyrusaft.com U
IMAPdrew]

* 0k darius.cyrusoft.com Cyrus IMAPS v2.1.15 server
ready

IMAP4 IMAP4rev] ACL QUOTA LITERAL+ MAILBOX- 4
REFERRALS NAMESFACE LIDPLUS ID ¥
NO_ATOMIC_RENAME UNSELECT CHILDREN U
MULTIAPPEMD 50RT THREAD=ORDEREDSUBJECT

THREAD=REFERENCES IDLE AUTH=PLAIN AUTH=LOGIN|
AUTH=DIGEST-MD5 AUTH=CRAM-MD5 -

Secure - TLS/S5L encryption |'; View Certificate ;Jl

Figure 75 The server panel in the mailbox details dialog box
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5.4.5.4 Details: Mailbox Access

Access Control List

Mailbox: imap:INBOX fal Key
_ —— s, Lookup
User ID QT SR (4 Read
Currant Usar: SV Y Y R R Y RV Y
7% Seen
Vince Y Y Y Y YYYYY 7 Write
daboo ¥ Y YY WO -
g Add
g Post
q_‘,:u Creata
u Dalete
t.."'i'._', Admin

#_ Add User... # Remove User x 5'[‘:'“31@

Figure 76 The Mailbox Details OAccessganel

The OAccessO panel displays information about the access control list for the mailbox or

mailboxes being examined in this dialog. The access control list for the mailbox chosen in
the OMailboxO popup is displayed in the dialog. To see the access list for other mailboxes
being examined, choosethem via the popup menu.

The accesscontrol list is the list of userswho have Orights@® the mailbox. For mailboxes,
there are atotal of nine Orights@at can be applied to eachuser. Theseare:

OLookup®if set, the user is able to seethe mailbox if they attempt to list it.
OReadd{f set,the user is able to read messagesin the mailbox.

OSeend¥ set, eachuser can mark a messageas seenwithout affecting other users.
OWrite®if set,the user can change any messageflag exceptthe delete flag.

OAddQif set, the user can add messagesto the mailbox by copying them in.

K K K K K K
B &S & Ooen

OPostO - if set, the user is able to send email directly to the mailbox. This capability is
only available if supported on the server.

¥ L7 OcCreateQf set,the user can create sub-hierarchies of mailboxes below the
mailbox.
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¥ oo ObDeletedf set,the user candelete and expunge messagesfrom the mailbox.

¥ & OAdminO - if set, the user is able to change the access control list for the mailbox.

The rights that you have to the mailbox are shown in the OCurrentUser:Gow at the top of
the access control list table. All usersO rights are then shown in the table below this. Each
row consistsof a user id, followed by nine icons or buttons representing the state of the
right for that user:

¥ < Abutton indicating that this right is turned off for the user, but it can be changed
by clicking it.

¥ ¥ Abutton indicating that this right is turned on for the user, but it can be changed
by clicking it.

¥ #  Anindication that this right is turned off for the user, but it cannot be changed
becauseyou do not have the rights to do so.

¥ ¥ Anindication that this right is turned on for the user, but it cannot be changed
becauseyou do not have the rights to do so.

When you have the right to change Orights@r the mailbox, you cando so by clicking one
of the Odiamond®uttons in the list. To changethe Orights@r more than one user at a time,
select all their user ids and click a diamond button with the option key held down.

To delete one or more usersfrom the accesscontrol list, selecttheir userids in the list and
click the ODeleteO button. To create add rights for a new user, click the ONew UserEQ button.
This will display the dialog shown in Figure 77. This allows you to enter any number of

user ids, one on eachline, and choosea set of Orights(y clicking the buttons below the list,

to apply to all the usersthat you enter.

New User ACL
Usar ID=:

Vince
Justin

[ Cancel | {_ OK _}

Figure 77 The dialog used to add new users to an access control list
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You can createa setof Orights@s a style to quickly apply frequently used Orights(To create
anew style:

¥ Select a user id with the set of OrightsO to use.
¥ Click the OStyleO pop-up menu and choose ONew StyleEO.
¥ Enter your chosenname for the new style in the resulting dialog.

The new style will be added to the end of the OStyleO pop-up menu list. To apply a style,
selectone or more user ids in the accesscontrol list and then selectthe required style from
the OStyleO pop-up menu.

When there is more than one mailbox being examined, you can apply the rights for the
current mailbox selected in the OMailboxO popup to all the others by clicking on the OApply
to All Selected MailboxesO. This provides a convenient and quick way to copy rights from
one mailbox to others.

5.4.5.5 Details: Mailbox Quota

Quota
Mama Currant Maximum |96 Usad
v USer vince
STORAGE 53 10240 0%

Figure 78 The Mailbox Details OQuota@anel

The OQuotaO panel displays information about the available quota for the mailbox. This is a _
hierarchical list of Oquota rootsO and quota values. In the example in Figure 78, Ouser.vinceO is
a OquotaootOand OSTORAGE#&quota value. For eachquota value, the current and

maximum values are shown together with the percentageused. The units of the values are
determined by the type of quantity being described. Thus for OSTORAGEO the units will
probably be Mb of disk use,for OMESSAGESKe units will be number of messages.
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5.4.6 Disconnected Mode Operations

Messagesin remote IMAP mailboxes can be cachedlocally for use when the computer
running Mulberry is not connectedto a network. Thesemessagescan be read and
otherwise manipulated in the normal manner, and any changesmade to messageswhile in
disconnected mode will be reflected in their online counterparts the next time a network
connection is made. This is known as disconnected mode operation.

In order to usean IMAP mailbox in disconnected mode, you must first synchronize that
mailbox with alocal cache. There is some preparation necessarybefore IMAP mailboxes
can be synchronized for disconnected use:

¥ The IMAP account that contains the mailnges to be used in disconnected mode must
have the OAllow Disconnected OperationsQopreference option enabled (seepage!38).

¥ The IMAP mailboxes to be synchronized must beidentified. For mailboxes that will be
synchronized on aregular basis,the easiestway to do this is to add the desired
mailboxes to the OAutoSynchronizeCGrabinet (seepage!138). A mailbox can also be
chosen for synchronization using the Options tab of the Mailbox Details dialog (see
page!l44).

5.4.6.1 Disconnecting

To switch Mulberry into disconnected mode, selectthe Disconnect... item from the File
menu. The Disconnect Options dialog, shown in Figure 79, will appear.
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Disconnect Dialog
When Disconnecting:

# Synchronise All Messages
_ Synchronise New Messages
_ No Message Synchronisation

v Synchronise Mailbox Lists
__ Send Queued Messages First
E Synchronise Remote Address Books

Message Synchronisation:

) Entire Message
'!'Ef' Entire Message below: 10| KE
_J First Displayable Part Only

¥ Hide Mailbox Information \_Cancel ) E OK 3

Add Cabinet: [#] ( Add... ) ( Clear )
imap:INBOX
imap:user.support

Total:2 Done:0 Messages:0

Figure 79 The Disconnect Options dialog

The Disconnect Options dialog provides the following options:

Synchronize All Selecting this option causes all messages in each mailbox to be

Messages synchronized. Any messagesalready synchronized will have their flag
state updated and messagesremoved from the IMAP server will be
removed from the disconnected cache.New messageson the IMAP
server not already in the disconnected cache will be downloaded.

Synchronize New  Selectingthis option causesonly new messagesin eachmailbox to be

Messages synchronized. Only messageson the IMAP server that are not already
in the disconnected cache will be downloaded. Other messages in the
disconnected cache will not be touched.

No Message When this option is selected,no messagesynchronization takes place.
Synchronization
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Synchronize This option causes a list of all defined mailboxes to be cached for use in

Mailbox Lists disconnected mode. When a mailbox list is cached for disconnected
use, all display hierarchies will be navigable as they are while in
connected mode.

Send Queued This option causespending messagesin the outgoing queue to be sent
Messages First before going into disconnected mode.

Synchronize This option causesremote IMSP or ACAP address books to be cached
Remote Address for disconnected use. Address books to be synchronized must be
Books specified in the OGeneralO panel of the Address Book Details dialog (see

page!240)and their address account must be marked for disconnected
operations (seepage!46).

Entire Message When this option is selected,the entire contents of eachmessage
(header and all parts) will be downloaded and available in disconnected
mode.

Entire Message When this option is selected,only those parts of a messagewith a total

Below nn byte count below the specified number will downloaded. This means

that some messagesin the disconnected cachemay only be OpartialO.
Such messages can be OfullyO downloaded at a later date to bring all
parts into the disconnected cache as required.

First Displayable \When this option is selected,only the first text part that would be
Part Only shown in the message window is downloaded. As with the previous
option, this results in a partial message in the disconnected cache.

The bottom portion of the dialog displays the mailboxes to be synchronized. By default,
the contents of the OAutoSynchronizeQcabinet are listed (seepage!138). The contents of
other cabinets can be quickly added using the Add Cabinet popup menu. To add one or
more individual mailboxes, click the Add... button. To remove mailboxes, selectthem and
hit the delete key. To clear the entire list of mailboxes, click the Clear button.

When all disconnected options are setasdesired, click the OK button to begin the
synchronization process. The bottom line of the dialog gives status information on the
progress of synchronization, including the total number of mailboxes to be synchronized,
the number completed, and the total number of messagessynchronized.

After synchronization has completed, Mulberry will terminate all active connections to
IMAP, IMSP, and ACAP servers. Once this is complete, the Disconnected Options dialog
will disappear and Mulberry will be in disconnected mode. In this state, it is safe to remove
any network connection.

5.4.6.2 Connecting

To return to connected mode, selectConnect... from the File menu. A dialog, shown in
Figure 80, similar to the Disconnect Options dialog will appear.
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Connect Dialog

When Connecting:

"'Ei" Stay Connected
_ Update then Disconnect

v Synchronise Offline Changes

@ Send Queued Messages
@ Synchronise Remote Address Books

10

( Cancel | { Ok }

Figure 80 The Connect Options dialog

Many of the options in this dialog are similar to those in the Disconnect Options dialog.
However, several new options appear, including:

Stay Connected Selectingthis option causesMulberry to stay in connected mode after
performing any specified synchronization.

Ul?date then When this option is selected, Mulberry will perform any specified

Disconnect synchronization options and then return to disconnected mode.

Synchronize When this option is selected,any changesmade to messagesn

Offline Changes

disconnected mailboxes will be synchronized with the equivalent
messages in online IMAP mailboxes.

Update POP3 When this option is selected, Mulberry will check any POP3 accounts

Accounts listed in the server window for new messageswhile in connected B
mode. This option is only available when the OUpdate then DisconnectC
option is selected.

Send Queued This option causespending messagesin the outgoing queue to be sent.

Messages When using the OUpdate then DisconnectO option, Mulberry will wait
until all messagesin the outgoing queue have beensent before
automatically disconnecting.

154 Mulberry Reference Guide v4



Synchronize When this option is selected, any changes made to addresses in
Remote Address disconnected address books will be synchronized with the equivalent
Books addressin online address books.

When using the OUpdate then Disconnect® mode, the mailbox list used in the Disconnect
dialog will be available to allow you to specify which mailboxes should be synchronized
before the disconnect.

5.4.6.3 Manual Synchronization

When Mulberry is in connected mode, individual mailboxes can be synchronized without
switching into disconnected mode. To do this, either select a mailbox in the server window
or open a mailbox and view its captions in a mailbox window, and then select
Synchronize... from the Mailbox menu. The Synchronize dialog, shown in Figure 81, will
appear.

Synchronise

Mailbox:

_ All Messages
_ New Messages
f*) Selected Messages

Messages:

) Entire Message
(® Entire Message below: 10 KB
_ First Displayable Part Only

[ Cancel | { OK }

Figure 81 The Synchronize dialog

All of the options in this dialog are similar to the options found in the Disconnect Options
dialog, except for the OSelected MessagesO option. This option allows you to synchronize
only aselectedlist of messagesin a particular mailbox. For this option to be available, you
must first double-click on a mailbox to open it, selectone or more messagesand then
selectthe Synchronize... menu option.
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5.4.7 Reference

156

OPERATIONS ON ITEMS IN THE SERVER WINDOW

To open one or more selected
mailboxes

Pressreturn or enter on the
keyboard.

Click/double-click any one of
the selectedmailboxes.

To open a mailbox that does
not appear in the server list

Choose Open MailboxE from
the File menu.

To seeinformation about the
selected mailbox

Choose DetailsE from the Edit
menu or press Command-|
(Mac OS X),Ctrl-I (Windows)

or Metabl (Unix).

To createa new mailbox on
the server

Choose CreateE from the

Mailbox menu or click the
create button in the toolbar.

To rename one or more
selected mailboxes

Choose RenameE from the
Mailbox menu.

To delete one or more selected
mailboxes

Choose DeleteE from the
Mailbox menu.

To subscribe to one or more
selected unsubscribed
mailboxes

Choose Subscribe from the
Mailbox menu or press
Command-= (Mac OSX),

Alt-= (Windows) or Metab=
(Unix).

To unsubscribe from one or
more selectedsubscribed
mailboxes

Choose Unsubscribe from the
Mailbox menu or press
Command-- (Mac OSX),

Alt-- (Windows) or Metabb
(Unix).

To checkfor new messagesin
one or more selected
mailboxes

Choose Check Email from the
Mailbox menu or press
Command-L (Mac OS X),

Ctrl-L  (Windows) or MetabL
(Unix).
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To checkthe set of mailboxes
marked for automatic
checking

Choose Check Favorites from
the Mailbox menu or press
Shift-Command- L (Mac OS
X), Shift-Ctrl-L  (Windows) or
ShiftbMetabL (Unix).
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5.5 Mailbox Pane/Window

g imap:INBOX. work x
From ﬂ
f . i,_lﬂ From / To Thread =
1 IE] B friend@domain.uk Mulberry is Great!
2 E] b Ha Custamar Re: Mulberry is Great!
8 B Vince Everrett How are you?
4 E] B Vince Everrett Here's the new Mulberry!!l
5 IE]E B friend®cyrusoft.com Mulberry is Great!
Total: 5 Uns=en: { Deleted: O Found: O

Figure 82 A mailbox window showing all available messagesin the mailbox

Figure 82 shows a typical mailbox pane. Mailbox panes show a list of messages in the
corresponding mailbox (when displayed in its own window, the window title is the name
of the mailbox). The pane is divided into three main sections:

¥ The Column Headers section indicates which information from a message is displayed
in the corresponding column and which category is used to sort the messages.

¥ The MessagelList section shows all the requested categoriesof information about each
messagesorted according to your preference.

¥ The Mailbox Information section at the bottom of the window lists important
information about the content of the mailbox.

If a mailbox hasread-only permission you will not be able to delete or expunge any
messages,or copy any messagesinto the mailbox. You may be able to set some of the
flags (seepage 166)for messagesin the mailbox, but this depends on your permission to
do so asdetermined by the server. If you do not have enough permission to change aflag,
an error messagefrom the server will be displayed when you try to do so.

A choice of options setin the OMailbox@references(seepage 61) allows mailbox panesto
be opened either at the start or end of the messagelist or with the oldest new messagein
the list selected and displayed.

5.5.1 Mailbox Window Toolbar Buttons

The mailbox window hasatoolbar associatedwith it, whereas the mailbox panein the 3-
pane window usesthe toolbar in the 3-pane window.
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The mailbox window toolbar contains the following items:

7

Draft

Create a new draft window to allow you to compose a new message.

o

Createsareply to messagesselectedin the mailbox pane, or the
message in the preview pane, depending on which is focussed.

Reply
Forwards the messagesselectedin the mailbox pane, or the message

E} in the preview pane depending on which is focussed.

Forward

w Copies or moves the messagesselectedin the mailbox pane, or the

= | message in the preview pane depending on which is focussed.

Mowea to

N Deletesthe messagesselectedin the mailbox pane, or the messagein
il the preview pane depending on which is focussed.

Delete

¥ This button has three states depending on what is selected.

¥ If no messagesare currently selectedin the mailbox window
then the button is not active.

¥ If one or more selectedmessagesare not deleted then the
button is off and clicking on it will delete the undeleted
messagesn the selection.

¥ If all the selectedmessagesare deleted, then the button title
changesto Undelete and it is in the on state. Clicking the
button now will undelete the selectedmessages.

Note If you delete a single message,Mulberry will
automatically selectthe next messageafter the one deleted (if
one exists).

oy

Expunges (permanently removes) deleted messagesin the mailbox
shown in the mailbox pane.

Expunga
@ Turns on or off the mailbox view Match behavior.
Match
Selectsmessageswith the flag criteria (chosenfrom the popup menu)
% in the mailbox pane.
Selact
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Checksthe selectedmailboxes in the server pane for new email, or

i

LI checksfor new email in the mailbox shown in the mailbox pane
Chack depending on which is focussed.
P Searchesfor messagesin the selectedmailboxes in the server pane, or
—y the mailbox shown in the mailbox pane depending on which is
Sparch focussed.

. Displays information about the mailboxes selectedin the server pane,
Ll-../' or the mailbox shown in the mailbox pane depending on which is
Details focussed.

The upper right corner of the toolbar displays an icon that indicates the
connected/disconnected status of the mailbox. Possible icons are:

L__,,.;' An online (IMAP) mailbox

L;.J A POP3 or Local mailbox

l:_q"_'; An online (IMAP) mailbox that has been synchronized and is being used in
» disconnected mode.

5.5.2 Quick Search

The quick searchareaprovides away to quickly searchfor messagesmatching a single
criterion. The criterion can be chosenvia the popup, shown in Figure 83.

* From
To
Recipient
Caorrespondent
subject
Body

Saved Search

Figure 83 The quick search popup.

A searchoccurswhen text is typed in the edit field and the return key or tab key is hit, or
there is a pausein typing for more than about 1 second. When the searchoccurs, the
content of the mailbox is restricted to showing only those messagesthat match the search

160 Mulberry Reference Guide v4



criterion. To edit the quick search mode, click the {&ibutton on the far right off the edit
field, or delete all text in the edit field, or turn off the Match toolbar button.

5.5.3 Column Headers

The column headers indicate what message information is displayed in each column in the
messagelist below it.

MAc OS X To change a category, or to insert a new category, or to delete an existing
category click the mouse button with the control key down (ctrl-click) on the
category title.

WiINDOWS To change a category, or to insert a new category, or to delete an existing
UNix category click the right mouse button on the category title.

A menu will appear giving you the choice of what category to show in the corresponding
column, asshown in Figure 84.You can alsoinsert a new column before or after the one
clicked, or delete the column that was clicked.
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To
From
Reply To
Sender
Cc
Subject
Thread
Date Sent
Date Received
Size
Flags
Number

v Smart Address
Artachments
Parts
Matching
Disconnected

Insert Column after
Insert Column before
Delete Column

Figure 84 A mailbox window with the column title changer menu displayed.

5.5.3.1 Resizing Column Headers

Columns in the mailbox window can be resized by clicking and dragging the cursor whilst

it is over a column boundary (the cursor will changeshapeto <k when it is close to a
column boundary).

5.5.3.2 Smart Address

One special category is the @SmarAddresstategory. When this category is selected,the
column title is OFrom: / To:O (see the third column in Figure 82). When this category is
chosen,Mulberry discriminates between messagesthat were sentby you to someoneelse,
messagessentdirectly to you by someoneelse,and sentindirectly to you (possibly via a
mailing list). This is useful if you have a mixture of messages received and messages sent in
the same mailbox. In this case Mulberry will display in the message list either the OFrom:O
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address, if the messagewas sent by someoneother than you, or the OTo:@ddress, if the
messagewas sent by you.

To indicate which is which, it displays different icons in front of the addresses in that
column:

¥ 4 for messagessentdirectly to you (where you are the primary recipient) by
someoneelse (your address does not appear in the OFrom@ddressfield of the message,
but does appear at least once in the OToO address field)

¥ 4 for messagessentdirectly to you (where you are a secondary recipient) by
someoneelse (your address does not appear in the OFrom@ddressfield of the message,
but does appear at least once in the OCCO address field, but not in the OToO address field)

¥ + for messagessentindirectly to you by someoneelse (your addressdoesnot
appear in the OFrom@ddressfield of the message,and it does not appear in the OToQr
OCCO address field)

¥ » for messagessentby you (your addressappears at leastoncein the OFromO
address field)

Note By default Mulberry always uses the email address that it
has setfor you to discriminate between messagessent or received
by you. But you can specify additional address to count as yours
by adding them to the OOutgoingAddressesto Count asMineQlist
in the Oldentity(references(seepage 4.9).

5.5.3.3 Sorting Messages

You can sort the messagelist in a mailbox window by any messagecategory. If a category
appearsin acolumn title, you canclick that column title to sort by that category. If the
category in a column is the one being used to sort the messageshe title display will change
(for example in Figure 82the messagesare being sorted by ONumber@he O#Column).

If you want to sort the mailbox by a category that is not displayed then choosethe

category from the Sort sub-menu in the Mailbox menu (seepage 301).The order of
sorting (ascending or descending) can be changed by clicking the sort direction button on
the far right of the category titles. The button appears differently for eachsorting method:

¥ |2 for ascending sorts
¥ E for descending sorts

You can also click on the column title for the category being sorted on to toggle the order
of sort between ascending and descending.

When sorting a mailbox, keepin mind that only messagesthat currently have information
cached will be included in the sort (for a detailed description of caching, see page 167), if
Mulberry hasto do the sort itself. If you attempt to sort the messagesin a mailbox by
clicking on a column header, and all of the messagesin that mailbox have not yet been
cachedor the server dos not support server-side sorting, you will be presented with the
following dialog:
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Some information needed to sort all the
messages is unavailable. Do you want to
download the missing message information and
then do a full sort, or just sort the currently
available messages?

( Cancel ) { Current ) ( Full Sort )

Figure 85 The SearchWarning dialog box

To sort only the messagesfor which Mulberry currently hasinformation cached,click the
Current button. To download information on all messagesthat have not beencachedand
then perform the sort, click the Full Sort button. Note that this action may not be desirable
if the mailbox has alarge number of messagesor youOrdimited by available memory or a
slow connection (e.g.a modem). To cancelthe sort action, click the Cancel button.

5.5.3.4 Displaying Message Threads

A special sorting category is OThreadO. When this is selected for a column, Mulberry displays
in the column the subject of the message.When sorting by Thread, Mulberry looks at the
information in eachmessage'sin-Reply-To and Referencesheader, and links together
messagesthat are in the samethread. The messagesubjectsdisplay in the mailbox

window, arethen indented by an amount that reflects the position of the messagewithin

the thread.

5.5.4 Message List

The messagelist shows one messageper row with the data in eachcolumn corresponding
to the category of messageinformation selectedfor that column. Messagesin this list can
be manipulated in anumber of different ways.

5.5.4.1 Selecting Messages

All operations on messagesonly occur for those messagesthat are selectedat the time.
There are a number of different ways to selecta message:

¥ A messagecan be selectedby clicking anywhere in its row.

¥ More than one messagecan be selectedeither by shift-clicking to extend a selection, or
command-clicking (Mac OS X) or control-clicking (Windows & Unix) to make a
noncontiguous selection.
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5.5.4.2 Manipulating Messages

You can manipulate selectedmessagesin a number of different ways:

¥

Pressingreturn or enter on the keyboard will also open any selectedmessageslf the
messageis marked asadraft it will be opened into adraft window (seepage 224),
otherwise it will open into a messagewindow (seepage 183).

Pressingdelete on the keyboard will toggle the delete flag of any selectedmessages.

Messagesmay be copied by dragging them out of the mailbox window into another
mailbox window or onto a mailbox shown in the server window. An option in the
OMessagqipeferencespanel (seepage 69) allows copied messagesto be automatically
marked asdeleted after a successfulcopy. This option can be toggled by holding down
the option  key during the drag.

Mac OS X ¥ Messagesmay also be saved by dragging them to the Desktop or a
ONLY Finder window. They can also be dragged to awindow of any open

application that can receive drag and dropped text (SimpleText for
example). In this casethe first text part of the selectedmessageis sentto
the receiving application.

¥

Somecommands can act on all messagesin a selectiontogether, or on eachindividual
message.For example, Figure 86 shows the dialog that appearswhen saving more than
one selectedmessage.You are given the choice of saving all messagesin the selection to
asingle file (click the Single button), or saving eachmessageto their own separatefile
(click the Multiple button). A similar dialog appears when replying or forwarding with
more than one messagein the selection.

Do you want to save the selected messages in
a single file or as multiple files, one for each
message’

( Cancel | [ Single | { Multiple }

Figure 86 The dialog giving the choice of whether to operate on all messages
in a selection together or individually
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5.5.4.3 Message Flags

The IMAP server assignsvarious flags to eachmessagethat is stored in a mailbox, to help
you keep track of the state of eachmessage.If you have the OFlags€ategory column on
display in the table, Mulberry will display different icons to represent these states. These
icons are:

¥ for messagesthat have arrived since the mailbox was last checked (recent)
for messagesthat have never been opened (unseen)
for messagesthat have been opened at least once (seen)

for messagesthat have beenreplied to (answered)

S &

for messagesthat are drafts (draft)

K K K K K

3 L

we for messagesthat have been marked as deleted (deleted)

For messagesin more than one state (e.g.answered and deleted) the icon order in the list
above will take precedence (i.e. for messages answered and deleted, the deleted icon will
be shown).

5.5.4.4 Attachments in messages

You can seeif any messagesin the mailbox have attachments by viewing either the
OAttachmentsColumn category or the OParts€lumn category. The OAttachmentsColumn
will display an icon if the message contains more than one part. The OPartsO column will
display the total number of parts in the message.The icons used in the OAttachmentsO
column are:

(none)  for messagesthat contain only plain text
9T for messagesthat contain styled text (HTML)

for messagesthat contain only plain text and attachments

2 for messagesthat contain a calendar attachment
;rﬂ for messagesthat contain styled text (HTML) and attachments
j_l- 1

@ for messagesthat contain styled text (HTML) and a calendar attachment
& for messagesthat contain only plain text and are cryptographically signed

7 for messages that contain styled text (HTML) and are cryptographically signed

K K K K K K K K K

d{_
J/® for messagesthat contain only plain text and attachments and are
cryptographically signed

y V= for messagesthat contain only plain text and a calendar attachment and are
cryptographically signed

¥ .rii? for messageshat contain styled text (HTML) and attachments and are
cryptographically signed
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y UF for messagesthat contain styled text (HTML) and a calendar attachment and are
cryptographically signed

¥ ) for messagesthat are cryptographically encrypted

5.5.4.5 Color and Text Style of Displayed Messages

The color and text style of messagesdisplayed in the window is also determined by the
state of the message.The color and text style can be setin the ODisplay@references(see
page 50).

5.5.4.6 Limiting the Number of Displayed Messages (Caching)

You canlimit the maximum number of messageson display in every mailbox window by
changing the OMessage Display CacheO settings in the OMailboxO preference panel (see page
61). This may be required if you have large mailboxes that would either use up too much

of the available memory when all messagesare visible, or take along time to download

over a slow connection (e.g.when using a modem).

The individual caching options are described on page 63. As you become more familiar
with thesesettings, you will be able to customize them to suit your available RAM and
connection speed. The following chart will give you starting point for different situations:

Connection Speed
Slow Fast
Available Memory Low Initial Download: 20, Initial Download: 100,
Limit To 100, Auto Limit To: 100, Auto
Increment Increment
High Initial Download: 20, | Initial Download: 100,
Unlimited Total, Auto Unlimited Total,
Increment Increment by: 100

5.5.5 Searching

Mulberry provides robust messagesearching capabilities. Using the searchwindow, you
canfind email messagesmeeting multiple criteria. You can searchfor messagesn one or
several different mailboxes. You can even save searchesand reuse them later. The Message
Search window, shown below, is the interface to this powerful functionality:
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® 60 Message Search

Saved Search: E]

Find Messages whose
3 From Address | $] | Contains 4] imulberry|
El'ur I:]'Eize I:]'IsﬁreaterThan I:] 1024 KB ==
[*+17and [5) DateSent |5 | Before By 11/ s / 2005
3 . Y r . Y 3 Y
| More Choices | [ Fewer Choices ) | Reset ) (-Search-)
¥ Hide Mailbox Information
: ' W % T
Add Eablnet:@ v Add. .. 3 ¢ Clear ) ( Options... )
POP3INBOX
Total: 1 Found: 0 Messages: 0 S

Figure 87 The MessageSearchwindow

The top section of the window allows you to setone or more email messageattributes to
search.By default, the Searchwindow is configured to searchon one attribute. To add
more attributes, click the More Choices button. To decreasethe number of attributed to
searchon, click the Fewer Choices button. To re-order the attributes in the list, click on
the up or down arrow at the left edge of the attribute to move that one up or down in the
list. The messageattributes that can be searchedare:
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From Address
To Address
CC Address
BCC Address
Recipient
Correspondent
sender

Date Sent
Date Received
subject

Body

Header Field
Entire Message
Size

Recent Flag
seen Flag
Answered Flag
Important Flag
Deleted Flag
Draft Flag

Labell
Label2
Label3
Labeld
Label5
Labelt
Labels
Label8

Grouped
Saved Search

All

Figure 88 The Search Attributes popup menu

From Address

The OFrom@ddress of the message.

To Address

The OToéddress of the message.
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CC Address

The OCcédress of the message.

BCC Address The OBccO address of the message.

Recipient The OToO, OCcO or OBccO addresses of the message.
Correspondent The OFrom@To@Cc@ OBccfdldressesof the message.
Sender The OSenderd the message.

Date Sent The date the messagewas sent.

Date Received

The date the messagewas received.

Subject The subjecttext of the message.
Body The body text of the message.
Header Field The header text of the message.

Entire Message

The entire message,including all headersand the messagebody.

Size

The size of the message.

Recent Flag

The recent flag of the message.

Seen Flag

The seenflag of the message.

Answered Flag

The answered flag of the message.

Important Flag The important flag of the message.

Deleted Flag The deleted flag of the message.

Draft Flag The draft flag of the message.

Labels The named label seton a message.

Grouped This options creates a OgroupO that allows multiple criteria to be
grouped together sothat their result is considered asa whole.

Search Set This option allows you to select a previously saved set of search criteria

in order to combine it with one or more other criteria.

All Messages

This option causes all messages to be returned. This is primarily useful
when used by rules (seeSection!5.7.1.Zor more on Rules).

Onceyou have selecteda messageattribute to search,you must set certain criteria to
searchon. The available criteria vary with the different attributes. When you selecta text
field, such asthe OTo@From@CcOr OBccaaldresses,or the messageSubjector Body, you
can choosefrom the following criteria:
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* Contains
Does not Contain
s Me
Is not Me

Figure 89 Text Search Criteria

Contains

The selected field contains the following text.

Does not Contain

The selected field does not contain the following text.

Is Me

The selected address field contains my email address. This option will
only be available if an address field is selected.

Is not Me

The selected address field does not contain my email address. This
option will only be available if an address field is selected.

When searching a date field, the following criteria are available:

= Before
ion
After
is
is not
is Within
is not Within

Figure 90 Date Search Criteria

Before The selected date field is before the following date.
On The selected date field is equal to the following date.
After The selected date field is after the following date.
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Is Allows a choice of relative dates selected via a second popup:
¥ Is Today - The date is equal to todayOglate

¥ Since Yesterday - The date is equal to either todayOsr yesterdayOs
date.

This Week - The date falls within the current week.

K K

Within 7 Days - The date falls within the past 7 days.
This Month - The date falls within the current month.

+

This Year - The date falls within the current year.

Is Not Allows a choice of relative dates selected via a popup:

Is Today - The date is not todayOglate

Since Yesterday - The date is neither todayOsor yesterdayOslate.
This Week - The date falls outside the current week.

Within 7 Days - The date falls outside the past 7 days.

This Month - The date falls outside the current month.

K K K K K K«

This Year - The date falls within the current year.

Is Within Allows a choice of dates within a specified timeframe (number of days,
weeks, months or years)

Is Not Within Allows achoice of dates outside of a specified timeframe (humber of
days, weeks, months or years)

If at any time you need to clear the criteria youOveset, click the Reset button. When you
have selectedthe messageattributes you wish to searchand the appropriate criteria, click
the Search button to begin the search.Mulberry will searchthe selectedmailboxes for
messagesthat match your searchcriteria. If any messagesare found, the current mailbox
window is brought to the front and you are presented with alist of only messages
matching your searchparameters.
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e Message Search

Saved Search: -

1
1

edu

[ Cancel |
¥ Hide Mailbox Information

Add Cabinet: 2

+7 | PFOP3:INBOX
| imapINBOX
* | imapINBOX. read-mail
g | imapINBOX. sent-mai

Total: 4 Found: 1 Messages: § eeeeeeeeeeeeeeee

Figure 91 The Message Searchwindow with mailbox information displayed

As the searchprogresses,the Searchwindow presentsinformation on the total number of
folders being searched(OTotalOthe number of mailboxes that contain messagesfound
during the search(OFoundOgand the total number of messagesin all mailboxes that match
the current search(OMessagesQYhile the searchis in progress, a progress bar will be
visible to indicate the time remaining.

If you would like to save a setof searchparameters for later use,you can use the Search
Set popup menu in the upper right corner of the Searchwindow. Choosethe Save As...
option to specify a name for the current set of searchparameters. The information will be
saved, and a searchsetwith the appropriate name will be added to the Search Set menu.
To recall the searchparameters youOvesaved, simply choosethe appropriate setname
from the Search Set menu.

By default, Mulberry searchesthe current mailbox for messagesthat match your search
criteria. You can also specify multiple mailboxes to be searched. To get a list of mailboxes to
be searched, click the disclosure button next to the OShow Mailbox InformationO text. A list
of the mailboxes to be searchwill be revealed. You can add mailboxes to the list by clicking
the Add... button and selecting a mailbox. To clear the list of mailboxes to be searched,
click the Clear button. You can also quickly all of the mailboxes within a cabinet to the
searchlist by using the Add Cabinet popup menu. The Options... button provides you
with adialog from which you can setvarious options:
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Search Options

M Simultaneous Searching

Maximum Number: |

| Load Balance Multiple Accounts

@ Open First Matching Mailbox

[ Cancel | {_ OK _}

Figure 92 The SearchOptions dialog

You should checkwith your server administrator if youOreunsure about any of these
settings.

Simultaneous Selecting this option causes Mulberry to search all of the mailboxes

Searching youOve specified simultaneously instead of one at a time. Mulberry will
open an separateIMAP connection for eachmailbox to be searchedif
this option is selected.

Maximum Number This field allows you to specify a maximum number of IMAP
connections that Mulberry can make at once for performing searches.
This option is only available if OSimultaneous SearchingO is turned on.

Load Balance This option tells Mulberry to split the number of IMAP connections
Multiple Accounts used for searching across multiple IMAP servers, when appropriate.

Open First To automatically open the first mailbox with messagesmatching the
Matching Mailbox current search, select this option. The mailbox window will be opened
after the searchis completed.

5.5.6 Matching

MulberryOsmatching feature provides a quick and easyway to selector display only
messagesof interest within a mailbox window. This is controlled via the Match toolbar
button. Clicking this button displays the dialog shown in Figure 93 which allows match
options to be configured. When in match mode, the toolbar button appears OdepressedO.
Clicking the toolbar button in that state, exits the match mode. The behavior for the Match
button is:

To enter Match mode and choosethe match Click the Match toolbar button
criteria from the dialog
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To enter Match mode using the last match Click the Match toolbar button with option
criteria without displaying the dialog (Mac OS X), alt (Windows) or control (Unix)
key down.

To exit Match mode without displaying the Click the Match toolbar button
dialog

To change match criteria using the dialog Click the Match toolbar button with option
whilst in Match mode (Mac OS X), alt (Windows) or control (Unix)
key down.

The Match dialog, shown in Figure 93,is used to setup match criteria and the mode for the
match display. A match pattern is constructed from one or more messagecharacteristics
and a boolean operator. For example, you might wish to display only alist of new
messagesfrom the last 7 days. To do this, you would selectall Criteria met asyour
boolean operator, selectthe New and Sent within 7 Days options, and click the Match
button. The list of messagesin your mailbox window is then filtered to display only those
messagesmeeting the criteria you specified. To resume viewing all of the available
messagesin the mailbox, click the Match toolbar button again.
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WViews:

Match Options

") All Messages without Match Hilights
" All Messages with Match Hilights
"E,“ Matched Messages Only

Match if: Flag Criteria:
f® any Criteria met | New
_J all Criteria met "~ | Unseen
") no Criteria met ! Impaortant
") not all Criteria met " Answered
| Deleted
[ ] Draft
Saved Search sent:
__| From me __ by Me
| Within 1 week ' to Me
[ to List
[ Clear )

Figure 93 The Match Dialog

Match using:

"E,“‘ Selected Criteria
: Last Search Results

Date Criteria:

" | Sent Today

| Sent since Yesterday
| Sent this Week
| Sent within 7 Days

Selected:

" To Addresses
" From Addresses
| Correspondents
| Subjects

| Dates

.___' Cancel '___. f Match }

The following chart describesthe View options in the Match dialog:

All Message
without Match
Highlights

Turns off the Match mode and displays all messages in the mailbox.

All Message with
Match Highlights

176

Turns off the Match mode and displays all messages in the mailbox.
Messageswith the match criteria are highlighted with the background
color setl the Display preferences(seesection!4.3.3).
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Matched Messages Turns on the Match mode so that only the messageswith the match
Only criteria are shown.

The following chart describes the Match using options in the Match dialog:

Selected Criteria  Match using the criteria selected in the dialog.

Last Search This option tells Mulberry to use the results of the last search on this
Results mailbox asits matching criteria. For more information on searching,
seepage!167.

The following chart describesthe Match if options in the Match dialog:

any Criteria met Matches messageswhich meet one or more of the currently selected

criteria.
all Criteria met Only matches messageswhich meetall of the currently selected
criteria.
no Criteria met Matches messageswhich meet none of the currently selectedcriteria.
not all Criteria Only matchesmessageswhich do not meet all of the currently selected
met criteria.

The following chart describes each available matching criteria in depth:

New Matches any messagethat is new.

Unseen Matches any messagethat is unseen.

Important Matches any messagethat is important.

Answered Matches any messagethat has beenanswered.

Deleted Matches any messagethat is marked for deletion.

Draft Matches any messagethat is a draft.

Sent Today Matches any messagethat was sent today.

Sent since Matches any messagethat was sent either today or yesterday.
Yesterday

Sent This Week Matches any messagethat was sent this week.

Sent within 7 Days Matches any messagethat was sentwithin the last 7 days.

Sent by Me Matches any messagethat was sent by you.
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Sent to Me Matches any messagethat was sentto you.

Sent to List Matches any messagethat was sentto a list of people.

Selected To Matches any messagewith the same OTo:@ddress asthe currently
Addresses selectedmessage(s)in the mailbox window.

Selected From

Matches any messagewith the same OFrom:@ddress asthe currently

Addresses selectedmessage(s)in the mailbox window.

Selected Matches any messagewith the same OTo:6r OFrom:&ddresses

Correspondents (excluding your own) asthe currently selectedmessage(s)in the
mailbox window.

Selected Subjects  Matches any messagewith the samesubjectasthe currently selected
message(s)in the mailbox window.

Selected Dates Matches any messagethat was sent on the samedate asthe currently

selectedmessage(s)n the mailbox window.

Search Sets

Selectsa saved searchset (seesection!5.5.5)as a criterion for matching.

The OSelected EQ options above act on all of the currently selected messages within the
mailbox pane. You can selectone or more messagesmanually from the mailbox pane that
have the characteristicsyouOrdooking for. Alternatively, the OSelectOolbar button allows
you to quickly highlight groups of interesting messageswithin the mailbox window:
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Seen
Unseen
Important
Unimportant
Answered
Unanswered
Deleted
Undeleted
Draft

Mot Draft

Matching
Non-matching

Labell
Label2
Label3
Label4
Label5
Label6
Label7
Label8

Figure 94 The OSelectO toolbar button menu

The following table describes each of the available selection options in depth:

Seen Selectsmessagesthat have beenseen.

Unseen Selectsmessagesthat have not beenseen.
Important Selectsmessagesthat are important.
Unimportant Selectsmessagesthat are not important.
Answered Selectsmessagesthat have beenanswered.
Unanswered Selectsmessagesthat have not beenanswered.
Deleted Selectsmessagesthat are marked for deletion.
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Undeleted Selectsmessagesthat are not marked for deletion.

Draft Selectsmessagesthat are drafts.

Not Draft Selectsmessagesthat are not drafts.

Matching Selectsmessagesthat meet the current match criteria.
Non-Matching Selectsmessagesthat do not meet the current match criteria.
Labels Selectsmessagesthat have the corresponding label set.

5.5.7 Reference

OPERATIONS ON MESSAGES IN MAILBOX WINDOWS

To open one or more selected
messages

Pressreturn or enter on the
keyboard.

Double-click one of the selected
messages.

Choose Open Message from
the File menu or press
Command-O (Mac OSX),

Ctrl-O (Windows) or MetabO
(Unix).

To delete one or more selected
messages

Pressdelete or clear on the
keyboard.

Choose Delete from the
Message menu or press
Command -D (Mac OSX),

Ctrl-D (Windows) or MetabD
(Unix).

Click the Delete button in the
mailbox window.

To undelete one or more
selectedmessages(which are
all deleted)
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Pressdelete orclear onthe
keyboard.

Choose Undelete from the
Message menu or press
Command -D (Mac OSX),

Ctrl-D (Windows) or MetabD
(Unix).
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Click the Undelete button in the
mailbox window.

To undelete one or more
selectedmessages(some of
which are not deleted)

Delete the messagesOtwice(The
first time will delete all those not
already deleted. The second time
will undelete all the deleted
messages.

To copy one or more selected
messagesto another mailbox

Selectthe mailbox you want to
copy the messagesto from the

Copy to Mailbox sub-menu in
the Message menu.

Drag and drop the messages
onto another open mailbox
window.

(This feature is only available if Drag
and Drop is supported)

Drag and drop the messages
onto a mailbox in the server
window.

(This feature is only available if Drag
and Drop is supported)

To print one or more selected
messages

SelectPrint from the File menu
or pressCommand -P (Mac OS
X), Ctrl-P  (Windows) or
MetabP (Unix).

(Only the first text part in the

messageis printed, not the whole
message)

To save one or more selected
messagesto disk

SelectSave from the File menu
or pressCommand -S (Mac OS
X), Ctrl-S (Windows) or
MetabS (Unix).

(Only the first text part in the

messageis saved, not the whole
message)

To check for new messages

SelectCheck Email from the
Mailbox menu or press
Command -L (Mac OSX),

Ctrl-L (Windows) or MetabL
(Unix).
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To create a text clipping (a Drag the messagesto the
simple text file in the Finder) Desktop.
of the messagetext in one or

(Only the first text part in the
more selected messages

messageis dropped on the destination,
not the whole message)

(This feature is only available if Drag
and Drop is supported)

To changethe flags for one or  Selectthe flag to toggle from the

more selected messages Flags sub-menu in the
Message menu.

To selectmessageswith a Choosethe flag to selectby

particular flag set or unset from the Select by Flag sub-
menu in the Edit menu.

To reply to or forward the Selectthe required option from

selectedmessages the Message menu or click the

appropriate button in the
mailbox window.

To redirect or send the Selectthe required option from
selectedmessages the Message menu.

To createa messagedigest of  Choose Create Digest from
the selectedmessages the Message menu.

To expunge (permanently Choose Expunge from the
remove) deleted messages Mailbox menu or press
from the mailbox
Command -E (Mac OSX),
Ctrl-E (Windows), MetabE
(Unix).

Click the Expunge button in the
mailbox window.
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5.6 Outgoing Message Queue Window

Mulberry hasthe ability to collect outgoing messagesn alocal queue. The outgoing
messagequeue is a special type of local mailbox that is managed by Mulberry. There are
several advantagesto this approach, including the ability to send outgoing messagesn the
background, aswell ascompose messageswhile in disconnected mode and send them the
next time a network is available.

To enable the outgoing messagequeue for a particular SMTP account, you must first select
that accountin the Accounts preference panel and turn on the appropriate items in the
Options tab (seepage !43).

Once one or more SMTP accountsare enabled for local queuing, the Outgoing Message
Queueswindow will be accessiblevia the Show Outgoing Queues item in the File menu.
The window is shown in Figure 95.

SO0 Outgoing Message Queues: SMTP - Disabled

@ @ L_j r?él Accounts | SMTP s = ;rg

Haold Pricrity  Delete Expungea Enakble

PN ™ [ From / To Thread =

1|z  Pfriend@domainuk  Mulberry is Great!
z M P v Ererrett herare ;.---l.-'!'

Total: 2

Figure 95 The Outgoing Message Queues window

The Outgoing Message Queues window is very similar to a Mailbox window, although
different buttons are used in the header areaand the icons in the OFlagEblumn are
different. Messages can be opened, deleted, and expunged exactly as in a regular Mailbox
window.
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The outgoing queue window toolbar contains the following items:

Allows selectedmessagesto be put on OholdOHeld messagesare not
sent, even when Mulberry is in connected mode and the outgoing
queue is enabled.

Assigns a higher priority to selectedmessages. Priority messagesare
sent before other messages.

&)
Haold
Pricrity

Deletesthe selectedmessagesDeleted messageswill not be sent.

-
Delete
lfT Expunges (permanently removes) deleted messages.
]|
Expungea
Account Allows switching between the queuesfor different SMTP servers.
N Enablesthe outgoing queue causing it to send any queued messages.
L ] When the queue is enabled, this button will changeto a Disable
Enable button. The outgoing queue is automatically disabled when

Mulberry is in disconnected mode. When switching from
disconnected back to connected mode, the outgoing queue is

normally re-enabled, and any messages queued while in disconnected
mode are sent.

The possible flag icons for messagesin the outgoing queue are:

RELOE
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A messagewaiting to be sent.

A messagebeing held in the queue.

A messagein the processof being sent.

A message that was not sent successfully.

A messagesthat has been marked asdeleted.
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5.7 Rules and Filtering

Mulberry hasthe ability to automatically perform user-defined actions or rules on
messagesm chosenmailboxes, when a certain Oevent@ccurs for that mailbox. For example,
it is possible to setup arule to look for new messagescontaining a particular From address,
and to changethe flag to important, when a mailbox is first opened.

The current Rules behavior in Mulberry is implemented in two ways:

¥ OLocal® b with local rules, Mulberry can apply actions to incoming messages that it OseesO
in mailboxes. This implements a Oclient-sideO filtering capability, allowing Mulberry (the
client) to determine how to automatically processincoming messagesin mailboxes.

¥ OSIEVEO b SIEVE is a Oserver-sideQ filtering technology that allows messages to be filtered
when they are delivered to mailboxes on the server, before the client application ever
OseesO them. Server-side filtering is more efficient than client-side filtering as the server
doesall the work in the background, asopposed to having to wait for the client to do
filtering. In order to use SIEVEfiltering, your email system must support it Bcheck with
your email system manager.

Local and SIEVE rules are described in more detail in the following sections, together with
a description of the Rules Manager window which is used to create, edit, delete and
manage rules In Mulberry.

5.7.1 Local Rules

5.7.1.1 Introduction

Local rules are used to apply a setof actions to a setof incoming messageswhen a specific
event occurs on a mailbox. This can be thought of in the following way:

When event occurs on mailbox ITrigger 1
If a messagematchessearchcriteria Rule 1
then do actions
elseif a messagematchessearchcriteria Rule 2
then do actions
When event occurs on mailbox ITTiggef 2
If a messagematches searchcriteria Rule 1
then do actions
elseif a messagematchessearchcriteria Rule 3
then do actions
etc. etc

The items underlined above indicate properties that you cansetin Mulberry.
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This behavior is configured in Mulberry by setting up a series of Otriggers® and OrulesO, each
with a user supplied unique name. A trigger specifies a set of mailboxes and an event to

look for on those mailboxes. A rule specifies a set of searchcriteria and some actions to

apply to messages that match those search criteria. Multiple rules can be associated with a
single trigger, and a single rule can be used by multiple triggers, as illustrated above
(Trigger!1 contains Rules!1 and 2, Rule!l is used in both Triggers!1 and 2).

The next sections describe rules and triggers in more detail.
5.7.1.2 Rules

Rules consist of two components: a set of searchcriteria used to determine which messages
should be processed, and a set of actions that will be applied to those message which match
the searchcriteria. Eachrule can be associatedwith one or more Triggers (see
Section!5.7.1.2.3or full details of Triggers) and this can be done by selecting the triggers
when the rule is created or by dragging it onto the trigger after it has beencreated (see
Section!5.7.1.3.4 for more details). If a rule is not associated with any triggers, it will never
be run, and its name appears in the Rules Manager window in italic text. Each rule has a
user supplied unique name.

5.7.1.2.1 Search Criteria

Rules can contain one or more searchcriteria. When arule is executed against a set of
messagesa searchis done to determine which messagesn the set match the ruleOssearch
criteria. Only those messages which match the search criteria will be processed, others will
be ignored by the rule.

Rules searchcriteria are the sameasthose available for searching of messages,using the
Search window, and are fully described in Section!5.5.5.

5.7.1.2.2 Actions

Rules can contain one or more actions. When arule is executed against a set of messages,
the actions are applied to (only) those messagesthat match the ruleOssearchcriteria. The
actions are:
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Set Flag Setsthe specified flag or label on the matching messages.

Unset Flag Removesthe specified flag or label from the matching messages.

Copy Message to  Copies the matching messagesto the specified mailbox.

Note This action does not setthe deleted flag after the
copy operation, even if the ODeleteMlessageafter CopyO
option is on in the Message>Options preference panel (see
Section!4.6.2).

Move Message to  Copies the matching messagesto the specified mailbox and then sets
the deleted flag on all of those messages.

Note The deleted flag is always set, even if the ODelete
Messageafter CopyQoption is off in the Message>Options
preference panel (seeSection!4.6.2).

Reply to Message Generatesreplies to the matching messagesone for eachmatched
message.A number of options for generating the reply are available,
and fully described in Section!5.7.3.3.1.

Forward Message Generatesforwarded messagesfor the matching messages,one for
eachmatched message.A number of options for generating the
forward are available, and fully described in Section!5.7.3.3.2.

Redirect Message Generatesbouncesto the matching messagesone for each matched
message.A number of options for generating the redirect are available,
and fully described in Section5.7.3.3.3.

Expunge Message Expunges (permanently removes) the matching messagesfrom their
mailbox.

Note Only those messagesin the matching setthat have
their deleted flag turned on will be expunged. Thus an
Expunge action will likely be preceding by a OSet Flag
DeletedCaction or a OMoveMessagetoCaction.

Play Sound Plays the specified sound when matching messages are found.
Display Alert Display an alert box on screen with the specified text appearing in the
with alert when matching messagesare found.

MAc OS X & MAc OS X & WINDOWS ONLY

‘évlg,NeDaci(WS — Speaksthe specified text when matching messagesare found.
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5.7.1.2.3 Stopping Rules from further processing Messages

When atrigger contains multiple rules, eachrule is executed one after the other when the
trigger runs. Sometimesit is necessaryto prevent later rules from processing messages
that were already processedby an earlier rule.

For example, you might have arule to match messagesfrom your bosswith an action to
mark it asimportant, and another rule to match messagesfrom co-workers in your email
domain and move those to another mailbox. If you donOtwant messagesfrom your boss
to be moved out along with the others from co-workers, you canturn on the OStopf
MatchedQoption for the Obossle, when creating or editing the rule (seeSection!5.7.3.3).
That will prevent messagesthat match that rule from being processedby others that
follow it.

5.7.1.3 Triggers

Triggers are different types of eventsthat occur in Mulberry and that can be usedto run a
setof rules. Eachtrigger specifieswhat type of event it is governed by, aswell asthe setof
mailboxes to which it applies. Rules are then added to the trigger and those rules will be
executed when the trigger runs.

By default the Triggers list in the Rules Manager window is hidden, but it can be made
visible via the Show Triggers button. Mulberry provides a set of default triggers that are
the common ones most userswill need. Additional triggers can be created and configured
via the Triggers list in the Rules Manager window.

Each trigger has a user supplied unique name. Triggers can be explicitly enabled or
disabled. Disabled triggers appear in the Rules Manager window with their names
displayed in italic text.

5.7.1.3.1 Trigger Events

There are a number of different eventsin Mulberry that can causea trigger to be run:

Never The trigger never runs. This can be used to disable a trigger without
deleting it.

New Messages The trigger runs when new messagesare detected when opening a
Arrive mailbox, or when an open mailbox is checked. This trigger will only be
applied to messagesthat are unseen, not deleted and not drafts, in
addition to any other search criteria specified by its rules.

Opening a This trigger runs whenever a mailbox is opened.

Mailbox

Closing a This trigger runs whenever a mailbox is closed.

Mailbox

All The trigger runs when any of the three previous events occur.
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5.7.1.3.2 Trigger Mailbox Sets

Each trigger will only run when its event occurs on a mailbox that is specified in the trigger.
There are a number of different ways of specifying the list of mailboxes to which the
trigger applies. Using the Rule Triggers dialog (see Section!5.7.3.4), it is possible to create
multiple setsof eachtype. The different types are:

None There are no mailboxes causing this trigger to run.

Mailbox The name of a single mailbox can be specified. The trigger will run when
the triggerOsevent occurs on that mailbox only.

Cabinet The name of a single mailbox cabinet (seeSection!5.4.4.6an be
specified. The trigger will run when the triggerOsevent occurs on any of
the mailboxes listed in the chosen cabinet at that time. This provides a
quick way to apply atrigger to an arbitrary group of mailboxes, by
simply creating a cabinet for those mailboxes, adding them to the
cabinet, and choosing that cabinet for the trigger. Adding or removing
mailboxes for use with the trigger is then a simple matter of adding or
removing them from the cabinet, as opposed to adding or removing
individual mailbox selections to the trigger.

Account The name of a mailbox account can be specified. The trigger will run
when the triggerOsevent occurs on any of the mailboxes belonging to
the chosenaccount.

All The trigger will always run when the triggerOsevent occurs on any
mailbox.

5.7.1.3.3 Default Triggers

When a new setof preferencesis used (for example when first running Mulberry), a
default setof triggers is created. Thesecover the typical setthat is used:

All Incoming This trigger is run when new messagesarrive in any of the mailboxes in

Email the OCheclravoritesCcabinet. Theseare by default the set of mailboxes
chosento be checkedfor new email. The rules are only applied to new
messages.

When Opening a | This trigger is run when opening any of the mailboxes in the OCheck
Mailbox FavoritesCrabinet. Theseare by default the setof mailboxes chosento
be checkedfor new email. The rules are applied to all the messages.
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5.7.1.3.4 Adding or removing rules

There are two ways to add rules to atrigger:

¥ When creating or editing the rule, click on the Triggered by popup button in the Rules
Edit dialog (seeSection!5.7.3.3and selectthe trigger you want to add the rule to or
remove the rule from. When the rule is added to atrigger, a checkmark will appear
against the trigger in the Triggered by popup menu.

¥ When the Triggers table is visible in the Rules Manager window, eachtrigger hasits set
of rules displayed beneath it in a hierarchical list that can be collapsed or expanded. To
seethe rules associatedwith atrigger expand the list. To add arule to atrigger, drag
and drop the rule from the Ruleslist onto the trigger in the Triggers list. To remove a
rule from atrigger, selectthe rule in the Triggers list and hit the Delete key.

5.7.1.4 Applying Rules by Hand

Normally rules are run by triggers in responseto a particular event on a particular

mailbox. It is also possible to manually apply a rule to specific messages in any mailbox, or
to messagesin all open mailboxes, without the need for atrigger. This can be done either
by using the Apply Rules sub-menu in the Mailbox menu, or by using the Apply button in
the Rules Manager window.

To use either method, the rule must first be setto appear in the Apply Rules sub-menu of
the Mailbox menu. This can be done by turning on the OApply Rules MenuQoption in the
Triggered by popup when editing a rule (see Section!5.7.3.3). Rules which have that option
set will appear in the Apply Rules sub-menu.

5.7.1.4.1 Using the Apply Rules sub-menu

To manually apply arule to a setof selectedmessagein an open mailbox, first select
messagesin the mailbox and then choosethe rule from the Apply Rules sub-menu in the
Mailbox menu. Only those messageswhich match the searchcriteria in the rule, will be
processedbothers will beignored eventhough they are selected.If you want to have a
rule that is always applied to the entire selection, create one with a single search criterion
set to OAIIO (see Section!5.7.3.3 for more details).

5.7.1.4.2 Using the Rules Manager Apply button

To manually apply all the rules in the Apply Rules sub-menu to all the messages in all
open mailboxes, go to the Rules Manager window and click the Apply button. Only those
messages which match the search criteria in each rule, will be processed D others will be
ignored.

5.7.1.5 Create a Rule using an Existing Message as a Template

It is possible to use an existing messagein a mailbox to createa rule that matchescriteria
for that message,so that similar messagescan be filtered when they next appear. To do
that, first selectone or more messagesin a mailbox window, and then choosethe Make
Rule command in the Mailbox menu. This will createanew rule in the Rules manager
window, and display a Rules Edit dialog (see Section!5.7.3.3) with the From address and
Subject text for each message automatically added as search criteria in the dialog. You can
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then remove the criteria you donOtwant or add additional criteria, or refine the criteria
already present asrequired.

5.7.2 SIEVE Rules

5.7.2.1 Introduction

SIEVE rules are similar to local rules, except that they are put together into a OscriptO which
is then passedto a SIEVE server. The server then interprets the command in the script
whenever a messageis delivered for the current user, and takes appropriate actions based
on the script contents.

In Mulberry, a SIEVEscript is created from a setof rules. Theserules are very similar to
those used for local filtering, but have slightly different search criteria and actions based on
what SIEVE can do. Rules can then be associated with one or more OscriptsO, in a similar
manner that local rules are associatedwith triggers. A script canthen be generated by
writing the script item to disk. From their, the script file can be uploaded to a SIEVE server
using the mechanism provided by that server.

The next sections describe SIEVE rules and scripts in more detail.

5.7.2.2 Rules

SIEVE rules are similar to local rules, and are created, edited and deleted in the same
manner as local rules. SIEVE rules have slightly different search criteria and actions
compared to local rules, and these will be described in the next sections.

5.7.2.2.1 Search Criteria

SIEVE search criteria contain the following items:

From Address Matches the From addressin the messageheader

To Address Matches the To addressin the messageheader

CC Address Matches the CC addressin the messageheader

Bcc Address Matches the Bcc address in the message header

Recipient Matches either the To, CC or Bccaddressesin the messageheader

Correspondent Matches any addressin From, To, CC or Bccmessageheadersthat is
not one of your addressesor an alias.

Sender Matches the Senderaddressin the messageheader

Subject Matches the Subjecttext in the messageheader

Header Field Matches text in a chosenmessageheader

Size Matches the size of the message

All Messages Always matches
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5.7.2.2.2 SIEVE Actions

SIEVE actions can be any combination of the following:

Keep

The message will always be delivered to the OdefaultO mailbox
(usually INBOX), in spite of any actions that come before or after this
one.

Discard

The messagewill be removed and not be delivered to any mailbox.
There will be no error messageto indicate the messagewas
removed.

Reject

The messagewill be sentbackto its sender and will not be delivered
to any mailbox. You can specify text to be used in the rejection notice
sent back to the sender of the original message.

Redirect

The message will be bounced to an address that you specify and will
not be delivered to any mailbox.

File into

The messagewill be delivered into the mailbox that you specify.
Mailboxes other than INBOX can only be used when SIEVE is
available with an IMAP server. The mailbox that you specify must be
avalid mailbox for the SIEVE server. If the mailbox does not exist,
the message will instead be delivered to the OdefaultO mailbox.

5.7.2.3 Scripts

A SIEVE script can contain multiple SIEVE rules, and has a unique user-defined name.
When a script is selected in the Rules Manager window, and the Write button clicked, a text
file will be generated with the textual form of the script asits content, and named after the
script name. This file canthen be uploaded to the SIEVE server for use by that server.

5.7.3 Rules Manager Window

5.7.3.1 Basic Layout

The Rules manager Window is shown in Figure 96.
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Figure 96 The Rules Manager Window.

The Rules Manager window is divided into three main sections:

¥ The Tab buttons section allows either Local or SIEVE rules to be displayed in the list
areabelow. When one is selected,the toolbar and lists, will be changed to reflect the
type of rules selected for display.

¥ Thetoolbar section contains buttons that can be used to create, edit, delete and manage
rules. Thesebuttons change depending on whether local or SIEVE rules are being
displayed.

¥ The lists section contains either one or two lists displaying rules, depending on whether
local or SIEVE rules are being displayed:

¥ Local: when local rules are selected, it is possible to have one or two lists displayed.
When a single list is displayed, it contains the list of local rules. When two lists are
displayed, the left-hand list is the set of local rules, and the right-hand list is the set of
triggers. It is possible to toggle the display between one or two lists using the Show
Triggers button in the toolbar.

¥ SIEVE: when SIEVE rules are selected, two lists are always displayed. The left-hand
list shows the set of SIEVE rules, and the right-hand list shows the list of SIEVE
scripts.

Mulberry Reference Guide v4 193



When both lists are displayed, you can adjust the relative sizesof eachby using the
split-pane control located between them. Items from the rules list on the left-hand side
canbe drag and dropped onto items in the right-hand list, to add rules to a trigger or

script.

5.7.3.2 Toolbar

5.7.3.2.1

Local Rules

The following buttons are available in the Local rules toolbar:

Rule Createsanew rule. The rule edit dialog appearsto allow anew item
to be configured and added to the rules list.

Trigger Createsa new trigger. The trigger edit dialog appearsto allow a new
trigger to be configured and added to the triggers list.

Edit Edits the currently selectedrule or trigger.

Delete Deletesthe currently selectedsetof rules or triggers.

Apply Applies the currently selected rules to all messages in all open

mailboxes.

Show Triggers

Togglesthe display of the triggers list.

5.7.3.2.2 SIEVE Rules

The following buttons are available in the SIEVE rules toolbar:

Rule Createsanew rule. The rule edit dialog appearsto allow anew item
to be configured and added to the rules list.

Script Createsa new script. The adialog appearsto allow a name for the
new script to be configured and added to the script list.

Edit Edits the currently selected rule or script.

Delete Deletesthe currently selectedsetof rules or scripts.

Write Writes the currently selectedscript to a server or to disk.

5.7.3.3 Editing a Rule

To edit a rule, either double-click on it in the rules list, or select it and click the Edit button
in the toolbar. The rules edit dialog shown in Figure 97 will then appear.
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Edit Rule

Mame: |MSDMN Triggered by@

If Messages Match:

k3 N . N .

+] From Address | & ] Contains = ] newsletters.microsoft
EI or  [$] From Address |$] | Contains %] msdn@microsoft.com
T or s ] From Address |§ ] Contains I ¥ ] madnnote@microsoft.
[ More Choices | | Fewer Choices | | Reset |

Then do Actions:

il Move Message to |4 ] imap:INBOX.Pragramming.Infa.MSDN @
*

E Expunge Message | & ]

[+ Speak with 1'#] MSDN filter triggered

I More Actions I I Fewer Actions I (] Stop if Matched |__' Reset '__|

I Cancel I\f oK

Figure 97 The Rules Edit dialog used for creating or editing rules.

The rules edit dialog contains three main sections:

¥

¥

Name and trigger/script application: this section allows the name of the rule to be set.
The Triggered by popup allows the rule to be associated with a trigger or script
depending on whether it is a local rule or a SIEVE rule.

Searchcriteria section: this section allows the criteria used to match messagesto be
specified. It is possible to createas many criteria asrequired, using the More Choices
button. The last criteria can be removed using the Fewer Choices button. Criteria can
be moved up or down the list by clicking on the up or down arrow buttons to the left
of eachitem.

Action criteria section: this section allows the actions to be performed on matching
messagesto be defined. It is possible to createasmany actions asrequired, using the
More Actions button. The last action can be removed using the Fewer Actions
button. Actions can be moved up or down the list by clicking on the up or down arrow
buttons to the left of eachitem.
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Reply, forward and redirect actions require extra configuration using the Options button
that appearswith those action items. Clicking on that button, allows the configuration for

eachof those types of action, and will be described next.

Reply Options

The reply options edit dialog is shown in Figure 98.
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Reply Action Options

Reply using:
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Figure 98 The Reply Options action edit dialog.
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The dialog allows editing of the following reply options:

Reply using

Allows you to choosewhich addressfrom the original message
should be used asthe addressto reply to. Choicesare:

¥ Reply-to Bthe addressin the Reply-To header of the original
message

¥ Senderbthe addressin the Senderheader of the original
message

¥ From bthe addressin the From header of the original
message

¥ All Bbthe addressesin the From and Cc headersof the
original message

Quote original Message

If turned on, the original messagetext will be automatically
quoted in the reply.

Reply Text

Click to setthe text that is used in the reply.

Use Standard Identity

Turn this on to select the identity that is normally associated
with the mailbox or account that the original message is in. This
identity will be used for the reply message,and determines
what signature is used, and where any copies of the reply will
be saved etc

Use Identity

Turn this on and choosean identity via the popup nextto it to
associate the chosen identity with the reply message. This will
override the normal identity that would be used when replying
to the messageby hand.

Create Draft instead of
Sending

Turn this on to generatea draft window containing the reply,
without automatically sending it. You can then inspect the
reply, modify it if needed, and then send it manually. Turn this
off to have the reply automatically sentwithout giving you the
option to inspect or modify it.
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5.7.3.3.2 Forward Options

The forward options edit dialog is shown in Figure 99.

Forward Action Options

To: ||
Ci:

Beoe:

E Quote original Message
2 Attach original Message

Ifr Forward Text... 1'l

,:, Use Standard ldentity
f®) Use Identity: | Default B

E Create Draft instead of Sending

.'-i- -\IH'.
( Cancel ) €0k )

Figure 99 The Forward Options action edit dialog.
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The dialog allows editing of the following forward options:

To Allows you to setthe addressesto whom the forwarded
messagewill be sent.

Cc Allows you to setthe addressesof recipients that should have
the forwarded messageccOdo them.

Bcc Allows you to setthe addressesof recipients that should have

the forwarded messagebccOdo them.

Quote original Message

If turned on, the original messagetext will be automatically
quoted in the reply.

Attach Original
Message

If turned on, the original message will be added as an
attachment to the forward message.

Forward Text

Click to setthe text that is used in the forward.

Use Standard Identity

Turn this on to select the identity that is normally associated
with the mailbox or account that the original message is in. This
identity will be used for the forwarded message,and
determines what signature is used, and where any copies will
be saved etc

Use Identity

Turn this on and choosean identity via the popup next to it to
associatethe chosenidentity with the forwarded message.This
will override the normal identity that would be used when
forwarding the messageby hand.

Create Draft instead of
Sending

Turn this on to generatea draft window containing the
forwarded message, without automatically sending it. You can
then inspect the message modify it if needed, and then send it
manually. Turn this off to have the forwarded message
automatically sentwithout giving you the option to inspect or
modify it.

Mulberry Reference Guide v4

199




5.7.3.3.3 Redirect Options

The forward options edit dialog is shown in .

Redirect Action Options

To: ||
Ci:

Beoe:

,:, Use Standard ldentity
f®) Use Identity: | Default B

E Create Draft instead of Sending

.'li- -\I\l\'.
( Cancel ) 0Kk

Figure 100 The Redirect Options action edit dialog.
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The dialog allows editing of the following forward options:

To Allows you to setthe addressesto whom the bounced message
will be sent.

Cc Allows you to setthe addressesof recipients that should have
the bounced messageccOdo them.

Bcc Allows you to setthe addressesof recipients that should have

the bounced messagebccOdo them.

Use Standard ldentity

Turn this on to select the identity that is normally associated

with the mailbox or account that the original message is in. This
identity will be used for the bounced message,and determines
what signature is used, and where any copies will be saved etc

Use Ildentity

Turn this on and choosean identity via the popup nextto it to
associatethe chosenidentity with the bounced message.This
will override the normal identity that would be used when
bouncing the messageby hand.

Create Draft instead of
Sending

Turn this on to generatea draft window containing the
bounced message, without automatically sending it. You can
then inspect the message modify it if needed, and then send it
manually. Turn this off to have the bounced message
automatically sentwithout giving you the option to inspect or
modify it.
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5.7.3.4 Editing a Trigger

To edit a rule, either double-click on it in the rules list, or select it and click the Edit button
in the toolbar. The rules edit dialog shown in Figure 101 will appear.

Edit Rule Trigger

Mame: |Incoming Mail E Enabled

Trigger when: Mew Messages Arrive _:]

Apply to

+1 Cabinet {51 Check Favourites ﬂ

*1 Mailbox 1) POP3:NBOX (+)
( More Choices ) ( Fewer Choices ) ( Reset )

( cancel ) { Ok }

Figure 101 The Triggers edit dialog.

The triggers edit dialog contains the following items:

Name Allows you to setthe name of the trigger that will be displayed in the
Rules Manager list. You must enter a unique name for this trigger.

Enabled Turn this on to enablethe trigger. Turn this off to disable the trigger.
This gives you the option of temporarily turning off atrigger without
having to delete it.

Trigger when Selectthe event that should be occur to initiate this trigger. The events
that can be selected are described in Section!5.7.1.3.1.

Apply to Use this section to specify which set of mailboxes this trigger should
be applied to. You can createasmany mailbox setsasyou like. To add
anew set, click the More Choices button. To delete the last setclick
the Fewer Choices button. To re-order sets,use the up and down
buttons to the left of eachsetitem.

The options available for each set are described in Section!5.7.1.3.2.
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5.7.4 Reference

OPERATIONS ON RULES IN THE RULES MANAGER
WINDOW

To display Local rules

Click the Local tab button

To display SIEVE rules

Click the SIEVEtab button

To show or hide the triggers
list for Local rules

Click the Show Triggers
button.

To createa new Local or
SIEVE rule

Click the New button

To createa new trigger

Click the Trigger button

To edit one or more selected
Local or SIEVE rules, or
triggers or SIEVE scripts

Click the Edit button

Pressreturn on the keyboard

Double-click on the rule, trigger
or script

To delete one or more selected
rules, triggers or scripts

Click the Delete button

Pressdelete on the keyboard

To add a Local rule to atrigger

Drag and drop the rule onto the
trigger in the triggersQlist

Edit the rule and select the
trigger in the Triggered by
popup in the edit dialog

To remove a Local rule from a
trigger

Select the rule in the triggersO list
and click the Delete button

Select the rule in the triggersO list
and pressdelete on the
keyboard

Edit the rule and deselect the
trigger in the Triggered by
popup in the edit dialog

To add a SIEVE rule to a script

Drag and drop the rule onto the
script in the scriptsO list

Edit the rule and select the script
in the Triggered by popup in the
edit dialog

To remove a SIEVE rule from
a script
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Select the rule in the scriptsO list
and pressdelete on the
keyboard

Edit the rule and deselect the
script in the Triggered by popup
in the edit dialog

To apply selected Local rules  Click the Apply button
to all the messages in all open
mailboxes

To write selected SIEVE scripts Click the Write button
to a server or to disk
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5.8 Message Pane/Window

From: Vince Everett <vince®@cyrusoft.com> To: Happy Customer <happy@domain.uks>,

Subject: Re: Mulberry is Great! Date: /8798 8:01 PM

T

= Parts: 1 | Formatted I—#—] A“lA. " All Quotes

= --0n Mon, Feb 28, 1995 3:17 pm "Happy Customer”™ <happy@domain.uks
> wWrote:

» I think Mulberry is great - don't you?

Yes - but I wrote 1t so what do you expect?

Figure 102 A typical messagepane with its parts list collapsed
S O6 Mulberry is Great!
= R REY T (= =
A b O e d D D
Draft Reply Reply Al Forward Move to Delete Print Frav Mext Del-Mxt
Frome |1ufinn:e Everett <vince@cyrusoft.ooms
Ta: | friend@domain.uk
Ce: | somebody@domain.uk
Subject: Mulberry is Great!
Date sent: August &, 1998 2:01:43 PM Message 1 of 5
—— | |—| "Formatted |4 | | As I Jﬂhl | " All Quotes e
|Ju51: to let vou know that I think Mulberry 1s great!
P

Figure 103 A typical messagewindow with an expanded header area
and its parts list collapsed
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Figure 103shows atypical messagepreview pane that canappear in the 3-pane window or
in a mailbox window. Figure 103 shows a typical message window that displays a message
in its own window, the window title is the text of the subjector the address of the sender if
the subjectline is empty. You can setthe default size and location for messagewindows by
sizing and positioning a messagewindow to your tastesand then choosing Save Default

Window from the Window menu (seepage 311).
Message windows are divided into three main sections:
¥ The Header section can appear expanded or collapsed:

¥ Expanded: shows the addresses,subjectand date for the message,together with
navigation buttons and other buttons to operate on the message(asillustrated in
Figure 103).

¥ Collapsed: Shows only the navigation buttons and other buttons used to operate on
the message. Address, subjectand date information is displayed in summary form
in the message text display area (as illustrated in Figure 104).

¥ The Parts section can be expanded or collapsed. In its collapsed state (as shown in
Figure 103)it shows the total number of MIME parts to the corresponding message,
together with a button for displaying the messageheader, pop-up menus to changethe
display format and choosea mailbox to copy the messageto, and a button to perform a
copy to the selected mailbox. In its expanded state, it also shows a list of each MIME
part allowing you to manipulate the individual parts.

¥ The Text Display section is used to display any text parts in the message.
Thesesectionsare now described in more detail.

5.8.1 Toolbar Buttons

The messagewindow has atoolbar associatedwith it, whereas the messagepreview pane
usesthe toolbar in the window that contains it.

The messagewindow toolbar contains the following items:

Create a new draft window to allow you to compose a new message.

=
=
fu
=

Createsareply to the message.

i

Reply

Create areply to all correspondents in the message.

&

Rephy All

Forwards the message.

i

Forevard
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E, | Bouncesthe message.
i

Redirect

- Copies or moves the message.

I

Mowe to

-

Deletesthe message.

EL

Delete

Prints the message.

|

nnt

= Delete the messageand display the next messagein the mailbox in
the window.

%

Del-MNxt

Display the previous message in the mailbox in the window.

Pray
[} Display the next message in the mailbox in the window.
Mext

5.8.2 Address Captions

5.8.2.1 Preview Pane

The address captions at the top of the preview pane, shown in Figure 102, display
summary details about the addressees the subjectand date the messagewas sent. The
address caption display canbe added or removed by turning on or off the Show Address
Bar option in the Window Options dialog (see section!5.1.2).

As an alternative to the address captions, the summary header information canbe
displayed at the top of the text areain the messagepreview. The display of summary
headerscan be turned on or off using the Show Summary Headers option in the
Window Options dialog (see section!5.1.2).
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5.8.2.2 Window

e 06 Mulberry is Great!
o 2T v -ir D F—
M CIRRE RS WSS I | | /
Diraft Reply Reply All Forward Move to Delete Print MNext Del-Mxt
Message 1 of 5
= Parts: 1 = Formatted ﬂ A“lA- All Quaotes ﬂ

From: Vince Everett <vince@cyrusoft.coms
To: friend@domain.uk

cc: somebody@domain. uk

Subject: Mulberry i1s Great!

Date-5Sent: August &, 1998 B:81:43 PM

Just to let yvou know that I think Mulberry 1s great!

Figure 104 The messagewindow showing the header areain collapsed
state, with the summary headers displayed in the messagebody.

In its expanded state (seeFigure 103),the messagewindow header shows three address

fields for the OFrom:O, OTo:0 and OCc:O address lists in the message. These fields display either
the first address in the corresponding list if it is collapsed, or a scrolling list of all the

addresses in the corresponding address list if expanded. Each address field can be expanded

or collapsed by clicking the disclosure button next to it.

Note When Mulberry opens or displays a new messagein an
existing message window with an expanded header, it will
automatically expand or collapse the address fields depending on
whether there is one or more than one addressin the list to be
displayed. If there is only one address and its text fits in the single
address field, the disclosure button will be disabled.

The expanded header in the messagewindow also shows the subject of the messageand
the date on which it was sent. You cannot edit the text in these fields or any address field.
However, you can selectthe text and either copy it or drag and drop it to a different
location (for example dragging addressesto an address book, which would add those
addressesto the address book list).

When the header is collapsed, summary message
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5.8.3 Security Information
5.8.4 Parts Header

5.8.4.1 Message Parts Header: Controls

The messageparts header area contains a number of controls as shown in Figure 105,and
described in more detail below:

¥ OPartsO disclosure button Expands or collapses the display of the parts table.
¥ OPartsAumber The total number of parts in this message.

¥ Attachment indicator If present, indicates that the messagecontains some
attachments. Different icons indicate different types
of attachment:

%r Indicates a message which contains styled text and
plain text alternatives.

E Indicates a messageswhich contain other types of

attachment.

¥ OHeaderButton Toggles the display of the messageOseader (seenext
section.

¥ OFormatting@op-up menu Changesthe formatting of the text on display (see
page!213).

¥ OText SizeO buttons Increasesor decreasesthe size of the text used for

displaying the messagecontent. The current size factor is
displayed next to the buttons.

¥ OQuote LevelO pop-up mendrurns on or off the display of quoted text at different levels
of quotation in the messagecontent.

= Farts: 1 = Formatted ﬂ At A~ All Quotes _:]

Figure 105 The messageparts header area controls

5.8.4.2 Showing Message Headers

Email headerscontain the addressing information and details about the structure of the
messageand are used by SMTP serverswhen a messageis sent. The headersare also used
by the IMAP server to determine the addressing information aswell asthe MIME parts
and structure of the message.Sometimesit is useful to seeall the headersin a messageand
the header button (shown in Figure 105)is used to toggle the display of the messageOs
email header. When it is on, the email header text is displayed at the top of the text display
area.When off, the email header is not displayed.

The style for the header fields displayed in the header can be changed in the OStylesO tab of
the Display preferences panel.
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Note You can choosewhether to have the email header displayed
or not displayed when first opening a messagewindow. This
option is controlled by the OShow Message Header in WindowO
option in the OMessaggtdeferencespanel (seepage 69).

5.8.4.3 Message Parts Header: Parts Table

The MIME standard allows messages composed of multiple parts to be sent via email.
Theseparts can be ordinary plain text or more complex Oblnary@ata such asimages or
even application files. The MIME structure of a message is hierarchical and allows message
parts to be grouped in a Omultipart(art.

MIME messageshave these features:
¥ [Every messagecontains one or more parts.

¥ Eachpart is described by atype and arelated subtype. For example there are three
standard subtypes corresponding to the Otext§pe. Theseare:

¥ OplainO - indicates the part contains plain, unformatted text.

¥ OenrichedO - indicates the part contains text in the special OenrichedO format which
allows formatted text to be sent.

¥ OhtmlO - indicates that the part contains HTML (Hyper Text Mark-up Language) text
that is used asthe basisfor World Wide Web pages.

Other types are used to represent binary data (e.g. Oimage@audio@videoO,
OapplicationO) and the OmultipartO type is used to indicate a group of other parts. A special
OmessageO type also exists and this is used to indicate an encapsulated email message
inside another or other information about a specific email message.

¥ Mulberry allows you to view any text part, and includes support for viewing enriched
and HTML formatted text as well as plain text (see page!213).

¥ Other parts can be downloaded to any disk on your local computer and then opened
using their appropriate application.

The message MIME parts display can be either collapsed (as shown in Figure 103) or
expanded (as shown in Figure 106). In the collapsed state it just indicates the total number
of different MIME parts in the message. When expanded it displays a either a hierarchical
list of all the MIME parts in the message or a flat (simplified) list, showing the MIME type
and sub-type, the size, and the name of eachpart. To switch between hierarchic and flat
mode use the flat/hierarchic toggle button. In the flat (simplified) mode Mulberry shows
only those parts which you canactually view or saveto disk.
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The expanded view also shows which parts can and cannot be viewed in the text display
area,and whether they have already beenseen.This is indicated by the diamond buttons
in the first column of the list:

¥ 4 Indicates the part currently on view in the text areabelow.

¥ 4 Indicates that the corresponding part is of a type that Mulberry can display in the
text areabelow. Clicking this button will causethe part to appear in the text areabelow.

¥ 4 Indicates that a part which Mulberry can display has already been seen. Clicking this
button will causethe part to appear in the text areabelow.

¥ Indicates a part which Mulberry is unable to display in the message window.

¥ O Indicates a part that is a MIME sub-message included in the main message. Clicking
this button will open a new messagewindow showing the sub-message.

¥ B Indicates a MIME sub-messagepart that has already beenseen.

¥ Parts: E = Formatted | ] A~ A~ All Quotes s ]
';..#L!l Content-Type (Hierarchic) Size Mame
L =| text/plain 37 Unnamed part #1

v I1’?&]n1|_|I1:i|;:|ar:fmiwcr:-uc:l

> l:l multipart/appledouble Mulberry Mailbox Con...
L =| text/plain 0 Unnamed part #2_2
O v @ messagerfcB22 356 Here's the new Mulbe...
L =| text/plain 47 Unnamed part #3_1

Figure 106 The message parts list showing a complex message structure

You can seemore detailed information about eachpart by selecting it and choosing

DetailsE from the Edit menu. This will display the dialog shown in Figure 107 with the
details for the selected MIME patrt filled in.
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MIME Part

Name: Unnamed part #1
Type: text/plain
Encoding: 7hit
ID:
Disposition: inline

Description:

Parameters: CHARSET=us-ascii
FORMAT=flowed

Open with: TextEdit

ok )

Figure 107 A typical OMIME PartOdialog that shows detailed
information about a particular MIME part

5.8.4.4 Viewing Attachments

One or more parts can be viewed in another application by selecting them and either

double-clicking them, or selecting View Parts from the Message menu (seepage!305).
When an attachment is viewed, Mulberry savesit to atemporary directory on disk, and
then launchesthe appropriate application to view it, and passesthe temporary file to that
application for display. When you quit Mulberry, the temporary files are removed from
the disk provided they are not still in use in the viewer application.

5.8.4.5 Saving MIME Attachments to Disk

One or more parts can be savedto disk by selecting them and either double-clicking them,
dragging them to the Finder, or selecting Extract Parts from the Message menu (see
page 305).When a part hasbeensavedto disk a +' mark appears next to it in the second

column of the list. If you drag a multipart item to disk then all the enclosed parts are
downloaded one after another.

MAc OS X If you receive a multipart/appledouble part then you should download the
ONLY multipart item rather than the individual sub-parts because the whole
multipart actually corresponds to a single Mac OS X file.
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You can choosehow Mulberry behaveswhen it downloads a part to disk by choosing the
appropriate option in the OSavéo DiskOsection of the OAttachment@referencespanel. You
can chooseto have Mulberry give you the choice of where to download a part to (when

double-clicking or using Extract Parts from the Message menu) or automatically
download the part to a pre-chosendestination folder.

You can also choosehow Mulberry behavesafter a part is downloaded to disk. This is
controlled by the choicesin the OOperafter Save@ection in the OAttachment@reference
panel. Mulberry can be setto either automatically open the downloaded part in its
appropriate application, to ask you whether to open the part, or to never open the part. In
addition, it is possible to override this for parts that can be displayed in Mulberry (i.e. text
parts). This allows you to choosenot to open parts that you have already seenif all you
want to do is savethem for later perusal.

Note You can resize the parts list by clicking and dragging on the
split-pane divider lines between the parts list and the text display
area.When the cursor is over the split-pane divider it changes

shapeto ==

5.8.5 Text Display

This displays the text of the currently selected MIME part in the message. Mulberry will
show the first item in the MIME parts list that it is capable of displaying when opening a
new messagewindow. If there are no parts that can be displayed in the text areathen this
is left blank. The messageOsmail header may appear at the top of the text areadepending
on whether the header button (seepage!209)is on or off.

Note You can use the spacebarto navigate through messages.
When you pressthe spacebarMulberry will scroll down the
current text display areaone page at atime. When it reachesthe
end of the scrollable areait will move on to the next messagein
the mailbox list. If you hold down the Option (Mac OS X) or Alt
(Windows) key while using the spacebar,the messagebeing read
will be marked asdeleted before the next messageis displayed.

5.8.5.1 Working with Styled Text

Mulberry is able to display a number of different formats of styled text. Styled text is text
which hasdifferent type-face characteristics,for example a different font or size, or use of
bold or italic text. Styled text normally requires the use of special OtagsO embedded within
the text itself that are used to mark the start and end of OstyleunsOThesetags are
interpreted by the application viewing the text and used to created the styled text display.
Mulberry is able to interpret OenrichedO and OHTMLO styled text. When you receive a MIME
messagewith text in one of these formats, Mulberry determines what type it is and

displays it accordingly. You can choose to change how Mulberry displays the text by using
the formatting pop-up menu, shown in Figure 108,in the messageparts header area (see
page!209).
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* Formatted
Plain Text
Source

as HTML
as Enriched
Fixed Font

Raw Message

Figure 108 The formatting pop-up menu

¥ OFormatted®the text is displayed using the styles determined from the tags and
appropriate for the type of styled text being viewed.

OPlain TextO - the text is displayed without styles, but with the styled text tags removed.
OSourceO - the text is displayed without styles, with styled tags showing.

Oas HTMLO b the text is displayed as HTML.

Oas EnrichedO b the text is displayed as Enriched text.

OFixed FontO b the text is displayed using a fixed-width font.

K K K K K K

ORaw MessageO b the entire message body is displayed in its raw MIME encoded format
without any formatting or styling.

For all text types, whenNOFormatgedO text is being displayed, URLs are highlighted using the

style setin the OStylestab of the ODisplay@reference panel (seepage 60). When the cursor

is over a URL it changes to a hand icon and you can click on the URL to launch it. Mulberry

only highlights URLSs that have a schemethat matchesan entry in the ORecogniz&RL

SchemesO area in the OStersO tab of the ODlspIayO preferences panel (see page 60). URLs are
not highlighted when viewing OPlainO or ORaw TextO.

MACIOSEX Note URLs can only be launched if a suitable OHelperO
application is set-up in Internet control panel/settings.

WiNDows Note URLS can only be launched if a suitable OHelper®
application is available in the Windows Registry.

UNIX

Note URLs can only be launched if a suitable OHelperO
application is available in the url.helpers file as described in
the online FAQ:
<http://www.mulberrymail.com/mulberry/unix/fagq>.

When the messageheader is displayed, Mulberry will changethe text style of the message
header fields to that specified using the style set in the OStylesO tab of the ODisplayO
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preferencespanel (seepage 60). When OFormattedé@xt is being displayed, any URLs in the
messageheaderswill also be styled according to the URL style asdescribed above.

When viewing OSource®lulberry will changethe text style of any formatting tagsto that
specified using the style set in the OStylesO tab of the ODisplayO preferences panel (see page
60).

5.8.5.2 Text alternatives

Sometimesyou may receive messageswith Oalternative@@xt parts. Theseusually consist of
aplain text part followed by a styled text part, and are sentto ensure that all email
programs are able to seethe text of the messagecorrectly. Since some email programs are
not able to display styled text, they will display the first plain text part to the user. Other
email programs, including Mulberry, that are able to display styled text will choose to

show the second, styled text, part to the user. You can control this behavior in Mulberry by
using the OShowstyledQoption in the OMessaggiveferences(seepage!69).When turned on,
Mulberry will pick the best styled part in a text alternative message to display. When

turned off, Mulberry will always display the plain text part in an alternative.

5.8.6 Working with Messages

5.8.6.1 Deleting a Message

A messagecan be deleted by clicking the Delete toolbar button. What you cando with a
deleted messageis controlled by two preferences:

Preference On Off
(Message/Options panel)

Allow Deleted Messages | A deleted messagecan be A deleted messagecannot be
to be Opened opened, or otherwise opened, or otherwise
operated upon in amailbox | operated on in a mailbox
pane. Actions on a message | pane. When a messageis

when it is deleted will deleted, it is removed from
depend on the OClose _ any messagepreview pane
Message when DeletedO in which it is displayed, or
option. any messagewindow which
it is displayed in is closed.
Close Message When When a messageis deleted, | Actions on a messagewhen
Deleted it is removed from any it is deleted will depend on
messagepreview panein the OAllow Deleted Messages

which it is displayed, or any | to be Openedoption.
message window which it is
displayed in is closed.

Note If the messagecomesfrom a mailbox with read-only
permission you will not be able to delete it and the Delete toolbar
button will not be active.

Mulberry Reference Guide v4 215



Note If the messageis a MIME sub-messagepart within another
messageyou will not be able to delete it and the Delete toolbar
button will not be active.

5.8.6.2 Replying to Messages

There are two ways to use the Reply toolbar button which depend on whether the Option
(Mac OSX), Alt (Windows) or Control (Unix) key is held down when clicking the button.
The choice of action is determined by the OMessagegfdeference panel setting (seepage 69).

¥ In one casea new draft messagewindow (seepage 224)is automatically createdin
reply to the current message. The draft message has its OTo:0 address field filled in with
the OReply-To:&ddress of the messagebeing replied to. Any other addressesin the
original messageare ignored.

¥ Inthe second case Mulberry will display a dialog (shown in Figure 109) which allows
you to choosewhich addressesfrom the original messageare to be used in the reply
and where they should appear in the reply. The dialog lists all the addresses in the
original message (it does not display duplicate addresses) and indicates in what field the
addresseswere originally in. You canthen choosewhere to put eachaddressin the
reply messageby clicking on or off one of the diamond buttons next to the address.
Oncethe required choice is made click the Create Reply button or pressreturn to
create a new draft message with the requested addresses automatically filled in. The
Oquick selectO buttons immediately below the address list allow typical choices for
different types of replies to be automatically selectedby Mulberry, or in the caseof the
ONoneButton removes any choice. Use of the Create Reply button will create a draft
in responseto the original, and the subjectof that reply will have an ORe@efix, and the
original messagewill be quoted using the Quote options specified in the dialog..
Instead, if you use the Create New button, a new draft addressedto the chosen
recipients will be created, with an empty subjectand no quoting of the original.
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Reply To

Select Addresses to be used in the Reply:

To Cc Beo Address Originalky
p sp <p Vince Everett <wince®@cyrusoft.come Reply-to
o o vince®Eimap.cyrusoft.com Sender
& ¢ ¢ friend@domain.uk To

& % < somebody@domain.uk Cc

Select: © peply Y (" Reply Al Y From 3 [ Sender Y [ None

Cuate:
@ Selection ) Entire Message ) Nothing

( Cancel ) ( Create New ) f Create Reply }

Figure 109 A typical OReplyToQdialog used for filling in addressesfor a
messagein reply to another

Note The default OReplyToCaction can be toggled at your option.
The default is to have the dialog appear only when the Option
(Mac OS X), Alt (Windows) or Control (Unix) key is down. To
change this click the appropriate radio button in the OAllow
Choice of who to Reply to whenOgroup in the OMessageO
preferencespanel (seepage 69).

5.8.6.3 Quoting Message Text in a Reply

When replying to the message,if you want to have any part of the messagetext
automatically displayed as a quotation in the reply, select the required text before clicking

the Reply button or using one of the reply commands from the Message menu.
Alternatively, if the OQuote Whole Message if no SelectionO option is turned on in the
OMessaggtveferencespanel (seepage 69),the whole of the text on display in the text area
will be quoted in the reply if no selection already exists. If this option is off, no text will be
guoted unless there is an existing selection.
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5.8.6.4 Bouncing, Forwarding and Sending Again

Mulberry gives you three additional ways to Oreply@ messages:

¥ ORedirect&allows you to passthe messageon to someoneelseand have it appear as
though it originated from the original sender of the message.This allows the recipient
to reply direct to the original sender.

¥ OForward@allows you to passthe messageon to someoneelse (who may not bein the
original list of recipients or may not be the original sender). There are various options
related to forwarding that can be configured via the preferencesdialog or through a
dialog that appearswhen forwarding the message.

¥ OSendgainO- allows you to resend any messageswhich were originally sentby you.
This option is only available when Mulberry recognizesthe messageashaving been
sent by you.

5.8.6.5 Forwarding Options

There are two ways to use the Forward button which depend on whether the Option (Mac
OS X), Alt (Windows) or Control (Unix) key is held down when clicking the button. The
choice of action is determined by the OMessaggtdeference panel setting (seepage 69).

¥ In one casea new draft messagewindow (seepage 224)is automatically createdto
forward the current message.The draft messagehas the original messagequoted or
attached determined by the setting of the OMessaggideference panel setting (seepage
69).

¥ In the second case Mulberry will display a dialog (shown in Figure 110) which allows
you to selectthe forwarding options.

Quote Original When this is selectedthe text from the original
messageis quoted in the forwarded message.

Include Headers in Quote When this is selected,the headersof the
original message are also included in the
forwarded message.

Forward as attachment When this is selected, Mulberry will always
attach the original messageto the forwarded
message, even if it only contains text which is
also quoted.

Use Embedded Message When this is selected, Mulberry will attach the
original messageasa message/rfc822 part in
the forwarded message.When this is not
selected,the parts of the original messageare
attached to the forwarded messageOin-lineO.

Save Options and Skip When this is selected, the options used in the
Dialog in Future dialog will be saved as the default for future
forward operations. The Preferenceswill be
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changed accordingly, and to ensure the dialog
does not appear next time. To have the dialog
appear again, turn on the Allow Choice of
Forward Options item in the General tab panel
of the Messagepreferences(seeSection!4.6.1).

Forward Message

Forward Options:

E Quote Original
_llnclude Headers in Quote

@ Forward as Attachment
™ Use Embedded Message

Cuote:
) Selection ) Entire Message ) Nothing

| Save Options and Skip Dialog in Future

( Cancel ) { Forward }

Figure 110 The Forward dialog used to setoptions when forwarding a
message.

Note The default OForward@ction can be toggled at your option.
The default is to have the dialog appear only when the Option
(Mac OS X), Alt (Windows) or Control (Unix) key is down. To
change this click the appropriate radio button in the OAllow
Choice of who to Forward OptionsOgroup in the OMessageO
preferencespanel (seepage 69).

5.8.6.6 Moving or Copying the Message to Another Mailbox

The messageon display can be moved or copied to another mailbox. There are two
different ways to specify the mailbox to copy to. You can choosea mailbox directly from

the Move to/Copy to Mailbox item in the Message menu. Selectinga mailbox from
this menu will immediately carry out the move/copy operation.
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Alternatively you can selecta mailbox from the Move to/Copy to toolbar button by
clicking on the left-side to bring up a popup menu. Upon selecting a mailbox from there,
the move/copy operation is carried out. If you click on the right-side of the Move
to/Copy to toolbar button, the messageis moved/copied to the last mailbox chosenvia
the popup..

5.8.7 Reference
OPERATIONS ON MESSAGE WINDOWS

To savethe current message  Choose Save from the File

display text menu or press Command-S
(Mac OS X), Ctrl-S (Windows),

or MetabS (Unix).

To print the current message  Choose Print from the File

display text menu or press Command-P
(Mac OS X), Ctrl-P (Windows),

or MetabP (Unix).
To show the previous Click the Read Previous button

messagein the mailbox in the
current window

Choose Read Previous from

the Message menu or press

Command- [ (Mac OSX), Alt-[

(Windows), or Metab[ (Unix).
To show the next messagein Click the Read Next button

the mailbox in the current
window

Choose Read Next from the

Message menu or press

Command-] (Mac OS X) Alt-]

(Windows), or Metab] (Unix).
To delete the current message Click the Delete and Read
and then show the next Next button

messagein the mailbox in the
current window

Choose Delete & Read Next
from the Message menu or
press Command-/ (Mac OS X),

Alt-/ (Windows), or Metab/
(Unix).
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To delete the current message Click the Delete button in the
messagewindow

Choose Delete from the
Message menu or press
Command-D (Mac OSX) or
Ctrl-D (Windows), or MetabD
(Unix).

Delete the messagein its
mailbox window.

To undelete the current Click the Undelete button.
message

Choose Undelete from the
Message menu or press
Command-D (Mac OSX) or
Ctrl-D (Windows), or MetabD

(Unix).
To show the messageOsmail  Click the header button in the
header messagewindow.

Choose Show Header from
the Message menu or press

Option-Command-H (Mac OS
X), Alt-Ctrl-H (Windows),

CtribMetabH (Unix).

To hide the messageOsmail Click the header button in the
header messagewindow.

Choose Hide Header from the
Message menu or press

Option-Command-H (Mac OS
X), Alt-Ctrl-H (Windows) or

CtribMetabH (Unix).

To reply to the messageOs Click the Reply button in the
OReply-To:O address messagewindow.

Choose Reply from the
Message menu or press
Command-R (Mac OSX),

Ctrl-R (Windows), MetabR
(Unix).
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Toreply to the messageOs Choose Reply to Sender from
OSender:O address the Message menu.

To reply to the messageOs Choose Reply to From from
OFrom:address the Message menu.
Toreply to the all the Choose Reply to All from the

addressesin the messages Message menu.

To forward the messageto Choose Forward from the

someoneelse Message menu or press
Command-J (Mac OS X), Ctrl-J
(Windows), or MetabJ (Unix).

Click the Forward button in
the messagewindow.

To redirect the messageto Choose Redirect from the
someone else Message menu
To send the messageagain Choose Send Again from the

Message menu.

(This feature is only available if the
messagewas originally sent by you)

To move/copy the messageto Selectthe mailbox you want to
a different mailbox copy the messagesto from the

Move to/Copy to Mailbox

sub-menu in the Message
menu.

To change any of the flags for ~ Selectthe flag to toggle from the
the message Flags sub-menu in the
Message menu.

To saveone or more selected Double-click the selected parts.
parts in the parts list

Drag the selectedparts to the
Finder.

(This feature is only available if Drag
and Drop is supported)

Choose Extract Parts from the
Message menu or press
Command-; (Mac OS X), Alt-;
(Windows), or Metab; (Unix).
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To seemore detailed
information about a selected
part

Choose DetailsE from the Edit

menu or press Command-|
(Mac OS X), Ctrl-l (Windows), or

Metabl (Unix).

To decode BinHex embedded
in the messagetext

Choose BinHex from the
Decode Embedded sub-menu
in the Message menu.

To decode UU embedded in
the messagetext

Choose UU from the Decode
Embedded sub-menu in the
Message menu.
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5.9 Draft Window

&S O6 Re: Mulberry is Great!
. = 73] i J @ fal i
Draft Save Attach Spelling Add Cc Add Bee Sign Encrypt Send
> To friend®@domain.uk

Subject:  Re: Mulberry is Great!

= Attached: [ Copy to: | imap:INEOX. sent-mail =

Hi Vince,
--0n August &, 1998 3:81:43 PM -8488 <vinceBcyrusoft.com= wrote:

Just to let vou know that I think Mulberry is great!

yvirus Daboo

Figure 111 A typical draft messagewindow with the header areain
expanded state

Figure 111shows atypical draft messagewindow. Draft messagewindows display the
contents of messageswhich you are in the processof writing prior to sending (the window
title is the name of the file if the draft messagewas originally opened from disk).

You can set the default size and location for new draft windows by sizing and positioning a
draft messagewindow to your tastesand then choosing Save Default Window from the
Window menu (seepage 311).

Draft message windows are divided into four main sections:
¥ The toolbar.
¥ The draft header section can appear expanded or collapsed:

¥ Expanded: shows the addressesand subjectfor the new message.lt also contains
buttons and a menu listing all available mailboxes for saving a copy of the message
when sent (as illustrated in Figure 111).

¥ Collapsed: shows a summary of the list of recipients (as illustrated in Figure 112).

¥ The draft parts section contains a hierarchical list of MIME parts that represents the
structure of the messagebeing sent.

¥ The messagetext display sectionis where you cantype text for any text parts you wish
to send in the message.
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Thesesectionsare now described in more detail.

5.9.1 Toolbar Buttons
The draft window toolbar contains the following items:

Create a new draft window to allow you to compose a new message.

Savethe draft to a mailbox or to afile.

Savea

? Attach files to be sentwith the draft.
Attach

i Spell check the text shown in the text display section.
Lpelling

O Adds a Cc: address field for including additional recipients.
<
Add Cc

2=
=5
(=1
m
a
]

Adds a Bcc: address field for blind-copying additional recipients.

Digitally sign the message when it is sent. This button is only
available if PGP or SIMIME security plugins are installed.

Sign
= Digitally encrypt the message when it is sent. This button is only
u available if PGP or S/IMIME security plugins are installed.
Encrypt
UNIX ONLY UNIX ONLY
€ Edit the current messagetext in an external text editor.
Edlit

e

Send

Sendthe message.
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5.9.2 Header

eSO 6 Re: Mulberry is Great!
; — =D [ ] @ fal ]
7 & ¥ & CE 8 T
Draft Save Attach Spelling Add Cc Add Bec Sign Encrypt Send

Racipients: friend@domain.uk

= Attached: [ Copy to: | imap:INBOX. sent-mail [ ]

Hi ¥ince,
--0n August &, 1998 8:81:43 PM -8488 <vincefcyrusoft.com= wrote:

Just to let you know that I think Mulberry is great!

Cvrus Daboo

Figure 112 The draft window showing the header areain collapsed
state.

In its expanded state, the window header has three address fields which can be used to
enter the email addressesto which you want to send this message(To), or to which you
want a copy to be sent(Cc), or to which you want a copy to be sent without revealing
their email address (Bcc). Use of these fields is described in more detail in the next section.
By default the Cc and Bcc fields are hidden. The Add Cc and Add Bcc toolbar buttons

and equivalent Draft menu commands will turn on the display of the corresponding
addressfield. If you want either the Cc or Bec addressfields to appear by default in a
draft window, you can changethe options in the Outgoing Preferencespanel (see
Section!4.7.1for more details).

The subject of the messageshould be entered in the Subject field. If this messagewas
generated asareply to an existing message Mulberry will insert OReCollowed by the
subject from the original message into the subject field (ORe: O is not prepended if it is
already there). Similarly, if the messageis being forwarded, Mulberry modifies the original
messageOsubjectand inserts that into the Subject field. The new subjectis determined by
the OForwardSubjectGetting in the Outgoing Preferencespanel (seeSection!4.7.1for more
details);

5.9.2.1 Address fields

Each of these fields can be collapsed to display a single line of text, or expanded to display a
scrolling list of text.

Single addresses can just be typed straight into a collapsed field.
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For multiple addresses,separatethe addressesby a comma or put eachone on a new line.
You cantype legitimate email addressesin a number of different ways:

Example Address Description
mulberry@dial.pipex.com Standard email address format
<mulberry@dial.pipex.com> Standard email address format

“Mulberry Owner” <mulberry@dial.pipex.com> Email address with name

mulberry@dial.pipex.com (Mulberry Owner) Email address with comment

<mulberry@dial.pipex.com> (Mulberry Owner) Email address with comment

As you type in addresses,Mulberry attempts to determine whether what you typed was a
complete address or a OpartialO address. In the case of a partial address a number of things
might happen when you type Return or move the cursor outside of the addressfield:

5.9.2.1.1 Nickname Resolution

Address or group entries in address books can contain nick-names (seepage 236for more
about Address Books). Justtype the name of the nick-name or group name in place of an
email address. Mulberry will attempt to resolve the nick-name by searching eachaddress
book marked for nick-name resolution (seesection!5.10.2for more details). The first
matching nick-name (if one exists) will then be substituted for the partial address in the
address field.

5.9.2.1.2 Address Expansion

When doing address expansion, Mulberry searches the text in various address fields in an

address book (as specified in the OExpansion TabO of the OAddressesO preferences panel b see
page!92)for a match to the partial address. The searchis done on eachaddress book

marked for searching (seesection!5.10.2for more details). If there is a single match it will

be substituted in place of the partial address in the address field. If there is more than one
matching address, then Mulberry will display all matches in a dialog box list allowing you

to chooseone or more addressesto substitute for the partial address.

5.9.2.1.3 Default Domain

If Mulberry cannot resolve a partial addressasa nick-name, or via expansion, it assumes
that the text typed is an OunqualifiedO address. It will then append the ODefault Domain for
Outgoing EmailOvalue, setin the OOutgoing@referencespanel (seepage!76),to the typed
text and take that to be the email address. If the ODefaultDomain for Outgoing EmailOvalue
is empty, an error will occur when you attempt to send the messagebecausethe typed text
cannot be recognized as a valid email address.
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5.9.2.2 Saving Copies of Sent Messages

If you want to have the draft messagecopied to a mailbox in the server list after it is
successfully sent, selectthe required mailbox from the OCopyToCpop-up menu.
Alternatively selectONone@t the top of the OCopyTo(Qpop-up menu.

You can also copy the draft messageto any mailbox before sending it by selecting a
mailbox from the OCopyToGpop-up menu and choosing Append Now from the Draft
menu. Alternatively, choosea mailbox from the Append to Mailbox sub-menu.

Note When creating a new draft message Mulberry will
automatically select the default OCopy ToO mailbox specified in the
ODraft@references(seepage 76). Also, if ORemembe€Chosen
Copy MailboxOis on in the ODraft@referencesthen any changeto
the OCopyToQOmailbox in adraft messagewindow is remembered
and the modified value used the next time a draft message
window is created.

If the draft messageis in reply to another (or is being forwarded or bounced) then you can
also chooseto have Mulberry copy the original messageto the OCopyToOmailbox before it

copiesthe reply by turning on the Also Copy Original Message item in the Draft
menu. This allows you to file messagesyrelating to the same subject, together in a mailbox
in the correct order (i.e. original before reply).

5.9.2.3 Spell Checking Text

The Spelling button can be used to spell checkthe text in the draft body area.

5.9.2.4 Sending a Message

The Send button can be used to send the draft message.

After sending a message,an icon appearsin the bottom right of the header areato indicate
successful completion (see Figure 113). This will not appear if the message could not be
sent. Sincea network related error can occur either while sending the messageor while
copying it to a mailbox (if that option is chosen),the icon can be used to confirm that the
messagewas sent correctly and that the problem arose after sending it (i.e. while copying
to amailbox). Mulberry automatically closesa draft messagewindow only after
successfully sending the message and copying it to a mailbox (if that option is chosen). This
could mean that the window may disappear before the successfulsend icon can be seen,
but the message has been sent successfully in this case.

e

a8
e

Figure 113 The symbol used to indicate that sending the draft message
was successful
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5.9.2.5 Attaching Files

The Attach button works together with the parts list and is described in the next section.

5.9.2.6 Using Identities

The From popup can be used to choosethe identity used when sending a draft message.
An identity provides away to setinformation such asthe return addressor signature used
with adraft. For more information on the contents of an identity and how to createand
edit them see page!85. When you switch identities using the From popup, or edit the
existing identity set in the popup, Mulberry automatically changes information in the draft
window to reflect the new identity chosen,or the changesmade to the currently selected
identity. This includes change any signature, changing the Copy To popup menu setting,
and various other items.

5.9.2.6.1 Tied ldentities

When creating a draft message Mulberry determines which identity to use basedon a set
of rules that use Otied identitiesO to determine what to do. An identity can be OtiedO to a
mailbox (seepage!l44)or a email account (seepage!39)such that use of that mailbox or
account will trigger the use of the OtiedO identity when creating drafts with that mailbox or
account OactiveO. To determine the correct tied identity Mulberry uses the following rules:

OChoosédentity from Mulberry determines the identity by looking at the original
Original MessageO option | messagesbeing replied to or forwarded.

is on in the ldentity
Preferencespanel (see
section!4.9 for details).

If any To addressin the original messagesmatchesthe From
addressin any identity (searchedin the order they appear in
the preferences),then that identity is used in the draft.

If no To addressesmatch an identity, Mulberry will then try to
match any Cc addresses against identities and will use the first
matching identity found in the preferences.

If no identity match is found, or the preferenceis off, Mulberry
will use one of the subsequentlisted rules to determine the
identity to use.

Serverwindow active, Usethe tied identity for the account of the selectedserver, if it
server row selected exists
or

Use the default identity

Serverwindow active, Use the tied identity for the mailbox, if it exists
mailbox selected

or
Use the tied identity for the mailboxOs account, if it exists

or

Use the default identity
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Mailbox window active

Use the tied identity for the mailbox, if it exists
or

Use the tied identity for the mailboxOs account, if it exists
or

Use the default identity

Message window active

Use the tied identity for the mailbox containing the message,if
it exists

or

Usethe tied identity for the account of the mailbox containing
the message, if it exists

or
Use the default identity

Any other case

Use the default identity

Mulberry will then usethe tied identity or the default identity basedon another setof rules
outlined in the next sections.

5.9.2.6.2 Tied Identities and new drafts

When creating a new draft using the New Message menu command or by clicking a
Draft button in a server or mailbox window, the following rules apply:

‘Use Tied Identities with
New Drafts’

Option (Mac OS | Identity set when draft is created
X) or Alt

(Windows) Key

Off Not used Default identity

Off Down Tied identity for the active window
(asdetermined by rules in
section!5.9.2.6.1).

On Not used Tied identity for the active window
(asdetermined by rules in
section!5.9.2.6.1).

On Down Default identity
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5.9.2.6.3 Tied Identities when replying, forwarding, bouncing, sending again or creating
a digest

When replying, forwarding, bouncing, sending again or creating a digest of messages,
Mulberry will always use the tied identity appropriate for the selected messages as
determined by the rules of section!5.9.2.6.1.

5.9.3 Sending Attachments: Parts Display

Mulberry allows you to create sophisticated MIME-structured messages for sending. As
well assending any number of text parts, which it allows you to type in, you can also send
any type of file stored on the local file system, complete messagesfrom any mailbox on the
IMAP server, or individual parts of messageson the IMAP server.

By default, the draft message window is created with a single text part. Additional parts can
be added in a number of ways and the hierarchical structure of the MIME message
changed accordingly. Mulberry also allows you to setdetails for eachpart being sent such
asthe encoding method, the MIME type details, the name of the part and the description of
the part, which could be useful to the recipients.

¥ Attached: 3 E Copy to: | imap:INBOX. sent-mail ﬂ
Mame Size Content-Type
' Getting Started v 907 K application/msword
v @Ilaw are you? 342 message/rfcBld
=|Unnamed part #3_1 42 text/plain
Figure 114 The expanded hierarchical parts list in a draft message
window

The message parts display section contains a hierarchical list (see Figure 114), similar to the
onein the incoming messagewindow, that displays the full hierarchy of the messagebeing
composed.

¥ Thediamond buttons in the first column have the samemeaning asin the message
window parts list (see page 207).

¥ The second column indicates whether the details of the part can be changed. This
includes being able to change the MIME type and encoding used for the part. In
general, all messageparts (be they a complete messageor a part from within an
existing message)that belong to messageson the IMAP server are read-only.

¥ The third column lists the MIME type that will be used when the part is sent.

¥ The fourth column shows the size of the part. Note that the size of the current text part
is only updated when switching the text display to another part.

¥ Thefifth column shows the name of the part. If the part hasno assigned name,
Mulberry will generate a default name for display in the hierarchy list. However, this
name is not used when the messageis sent.
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¥ The final column indicates the type of encoding that will be used to send the part. OTextO
and OAutomaticO encodings correspond to the standard MIME encodings. Mulberry will
choosethe best MIME encoding to usein this case.Other encodings may be used if the
file requires special processing, for example to ensure that the resource fork of the file is
preserved when sent between Mac OS X users.

5.9.3.1 Editing MIME Information

The type, name and encoding of parts can be modified (if the part can be changed) or
viewed (if the part is read-only) by choosing DetailsE from the Edit menu.

For read-only attachments, the dialog shown in Figure 107is displayed with the relevant
information filled in. For parts that can be modified, the dialog shown in Figure 115 is
displayed. This allows you to changethe name of the part, the MIME type and subtype, the
encoding and add a description to the part. The name and description are sent with the part
and can be viewed by the recipient if they have a suitable application to view the message
with (Mulberry for instance!). The type and subtype should not generally need to be
changed, as Mulberry will generate defaults for these that should suffice.

To changethem, either type a new value into the appropriate field or chooseone from the
pop-up menu next to eachfield. Note that the items in the subtype pop-up menu depend
on the value in the type field.
MIME Part
Mame: Getting Started v4
Type: application

Subtype: octet-stream

=@

Encoding: Automatic ﬂ
Description:
Disposition: Attachment ﬂ
Charset: Automatic ﬂ

[ Cancel | ( OFK }

Figure 115The dialog used to edit the details of a MIME part before sending it
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5.9.3.2 Creating MIME Multiparts

You canadd new levels of parts hierarchy by choosing a suitable OMultipartGtem from the

New Multipart sub-menu in the Draft menu. This will createa new hierarchy level into
which you can place single parts or more multipart hierarchies.

When inserting new parts into the parts list, the new parts will always be added as sub-
parts of any selectedhierarchy. Thus to createa hierarchy within a hierarchy, selectthe top
level hierarchy part in the list and then choosethe appropriate menu item. If no
hierarchical part is selected in the list, new parts are added at the top level of the hierarchy.

You can move parts around inside the parts list by dragging them to the desired hierarchy
position.

The next sectionsdescribe how you can createand use different types of parts in Mulberry.
5.9.3.3 Manipulating Text Parts

You can create new text parts by choosing an item from the New Text Part sub-menu in

the Draft menu. This will add a new text part of the chosensubtype to the parts hierarchy
list and automatically switch the text display area over to viewing this part.

You can switch the text display area between different text parts by clicking the diamond
buttons in the first column of the parts hierarchy list. Thesebuttons have the same
meaning asthose used in incoming messagewindows (seepage!207).The size of the text
part displayed in the parts table is only updated when switching to another part.

5.9.3.4 Attaching Files to a Message

To attach files to draft messagesso that they get sentalong with any other parts, click the
Attach button, and choosethe files you want to send from the resulting file open dialog.
This allows you to chooseany number of files to be attached to the draft message.You can
alsodrag files directly from the desktop into the parts list to have those files sent.

5.9.3.5 Whole Message Parts

You can attach a complete messagelocated on the IMAP server to a draft message.To do
this drag the messageout of its mailbox window into the draft messageOgarts list. This
will produce a Omessage/rfc8220 part which contains the parts hierarchy for the original
message.You can delete parts from the sub-messageOisierarchy but you cannot reorder
them or add other parts.

5.9.3.6 Parts from other Messages

You can attach parts from messagedocated on the IMAP server to a draft message.This
allows you to send particular parts of messagesthat have beensentto you on to someone
else.To do this, drag the parts from the parts list of the original messagewindow into the
draftOs parts list.

5.9.4 Text Display

This displays the text of the currently selecteddraft messagepart. You cantype the text for
the messagehere. Mulberry allows you to createand edit plain, enriched or HTML text.
When adraft is first opened, Mulberry choosesthe text style basedon the settings in the
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OO0utgoingO preferences panel (see page!76). When editing enriched or HTML styled text,
Mulberry placesatoolbar at the top of the text areato allow you to easily changethe
formatting of selectedtext, aswell asshow the current format of the selectedtext.
Formatting can also be changed by choosing a command from the Draft menu (see
page!308).

5.9.4.1 Text Macros

Mulberry allows you to define a setof Oshortcuts@r usein the text display area. When you
type ashortcut and then immediately type the macro expansion key combination,
Mulberry will expand the OshortcutO into the text you have defined for it. These Otext

macrosCan be setvia the Text Macros command in the Edit menu. The keystroke used
to expand the macros can also be setthere.

5.9.4.2 Spell as you Type

Mulberry can be set to spell check text as you type it into the text display area. Misspelled
words are always given ared wavy underline style and the background color changed to

that specified in the Spelling Options setvia the Edit menu.
To correct a misspelled word:
Mac OS X To correct a misspelled word, click the mouse button with the control key

down (Ctrl-click) on the highlighted word and chooseaword to replace it
with from the resulting popup menu, or chooseAdd to Dictionary to save

the word.
WINDOWS To correct amisspelled word, click the right mouse button on the
UNIX highlighted word and chooseaword to replace it with from the resulting

popup menu, or chooseAdd to Dictionary to savethe word.

5.9.5 Reference
OPERATIONS ON DRAFT MESSAGE WINDOWS

To saveadraft message Choose Save from the File

menu or press Command-S
(Mac OS X), Ctrl-S (Windows),

or Metab$S (Unix).

To saveadraft messageusing Choose Save AsE from the
a different name to the one File menu

previously used

To create additional text parts  choose New Text Part from
the Draft menu.

To create multiparts Choosethe appropriate item
from the New Multipart sub-
menu in the Draft menu.
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To attach files to a draft
message

Click the Attach button and add
the files you want to attach.

Drag afile from the Finder into
the expanded parts list.

Drag a file from a parts list in
another draft messagewindow
into the parts list of this draft
messagewindow.

To attach a messagefrom a
server mailbox to a draft
message

Drag the messagefrom its
mailbox window into the parts
list.

To attach one or more parts
from a messagein a server
mailbox to a draft message

Drag the parts from the original
messagewindow into the parts
list.

To remove attachments from
a draft message

Selectthe attachmentsin the
parts list and press delete.

To include the text of the
messagebeing replied to,
forwarded or bounced

Choose Quote Original

Message from the Draft
menu.

To include text as a quotation
in the draft message

Copy the text to the clipboard
and choose Paste as
Quotation from the Edit menu
or press Command-’ (Mac OS
X), Alt=’ (Windows) or Meta-O
(Unix).

To send the message

Click the Send button.

Choose Send from the Draft
menu or press Command-M
(Mac OS X), Ctrl-M (Windows),

or MetabM (Unix).

Mulberry Reference Guide v4

235



5.10 Address Book Manager Pane/Window

The address book manager pane/window displays is used to organize local and remote
address books.

5.10.1 Address Book Manager Pane

The address book manager pane, an example of which is shown in Figure 116, is divided
into two main sections:

| Email | Contacts | Calendar | T

7 2 ) Mame

v (@) Mac Address Book
o E ) Mac OS5 X

v (@) Address Books
o £_) Import

¥ \.Jimsp
G WY E_) vince
o W ) daboo
o W £ _J daboo.public
o t_J daboo.upper

Figure 116 The Address Book Manager pane.

¥ Theitems in the Column Header section indicate what type of address book
information is displayed in the corresponding column in the Address Book List section.

¥ The Address Book List section displays lists of address books.
5.10.1.1 Address Book Window Toolbar Buttons

The address book manager window has atoolbar associatedwith it, whereas the address
book manager pane in the 3-panewindow usesthe toolbar in the 3-pane window.
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The address book manager window toolbar contains the following items:

Createsa new address book.

e

Waw

Opens the address book selectedin the address book manager pane.

Deletesthe address books selectedin the address book manager
pane.

L=
1]
. = il

=
']
1]
=
i

Allows searching for addressesin address books.

Search

Shows details about the address books selectedin the address book
manager pane, or the address book shown in the address book pane.

E..

Details

Table 7 The Address Book Manager Window Toolbar

5.10.1.2 Column Headers

The column headers indicate what address book information is displayed in each column in
the list below it. The column indicates with text or an icon what the information is:

¥ ONameO The name of the address book or remote server account.

¥ [l Showsa Odiamond®utton that can be clicked on or off to have address books
opened on startup.

¥ 2 Showsa Odiamond®utton that can be clicked on or off to have address books used
for nick-name resolution.

¥ £ ShowsaOdiamond®utton that can be clicked on or off to have address books used
for searching (seepage!244)or address expansion (seepage!227).

Mac OS X Hold down the control key and click the mouse button (ctrl-click) on a
column header to changethe column type, insert a new column, or delete
the column.

WINDOWS To change a category, or to insert a new category, or to delete an existing

UNIX category click the right mouse button on the category title.

When you do this the menu shown in Figure 117will appear giving you the choice of what
category to show in the corresponding column. You can also insert a new column before
or after the one clicked, or delete the column that was clicked.
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Open at Start
Resolve Nick-Name
v Allow Searching

Insert Column after
Insert Column before
Delete Column

Figure 117 The pop-up menu used to change column information in the
address book manager window

Note The OName@olumn which shows the name of the address
book or address server is always present and cannot be changed
or deleted. You can insert columns before or after it though.

5.10.1.3 Address Book List

The address book manager list shows address books within a hierarchy that representsthe
local or remote Oaccounttbat handles the address books. The first accountis always
OAddressBooksGand representsthe local storage of address books on the computer on

which Mulberry is currently running. Subsequentaccountsare remote address book

accounts setup in the OAccountsO preference panel (see page!9l). Different icons are used to
represent the different types of items displayed in eachrow:

v/ A remote address book server account.

e A remote address book server account that is available for usein disconnected
mode. This icon is only shown when in disconnected mode.

A Local address book account.
A remote or local address book that can be opened.

A remote address book that has been synchronized for usein disconnected mode.
This icon is only shown when in disconnected mode.

B & O &

A remote address book whose contents are only available while in connected
mode. This icon is only shown when in disconnected mode.

5.10.2 Getting Information on Address Books

Information about address books can be displayed by selecting the address book and then
choosing DetailsE from the Edit, or clicking the Details toolbar button. This will display
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the dialog shown in Figure 118 which will have two different panels displaying different
information about the address book:

¥ OGeneral®
¥ OAccessO
_J General General
MName:
o Access Sarver:
Addresses:
Taotal:
Single:
Group:

Address Book: vince

" E
vince r\-_«‘l

iImsp.cyrusoft.com

o
-

&
4
4

| Open on Startup
@ Uze for Nick-names
@ Use for Searching and Expansion

] Synchronise on Disconnect

Figure 118 The Address Book Details dialog showing the OGeneralfanel
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5.10.2.1 Address Book Details: General

General

Mame: wince l'*--.--)

Lerver: imsp.cyrusoft.com

Addresses:
Tatal: &

Single: 4
Group: 4

Open on Startup

h_.!"i Use for Mick-names

| S

@ Use far Searching and Expansion

synchronise on Disconnect

Figure 119 The Address Book Details OGeneral@anel

The items in this panel are:

¥

¥
¥

240

ONameO The name of the local address book or full pathname of the remote address
book.

OServerOThe internet address of the server on which this address book is located.

OAddressesO These items will only be available if the address book is open. This will
always be the casefor local address books, but not necessarily for remote address
books which may be listed in the address book manager but may not be open in
Mulberry.

b OTotald Thetotal number of addressesand groups in the address book.
b OSingle® The number of single addressesin the address book.
b OGroups The number of groups in the address book.

OOpen on StartupO  If turned on, the address book will be opened whenever the
current preference set is opened, including when Mulberry next starts up.

OUse for Nick-namesO If turned on, the address book will be used for nick-name
resolution when typing addresses into an address field in a draft window. If the address
book is local, it must also be open in Mulberry for nick-name resolution to take place. If
it is a remote address book, Mulberry must be logged in to the server, but the address
book need not be open in Mulberry as nick-name resolution can be done remotely.

OUse for Searching and ExpansionO If turned on, the address book will be used for
searching when searching address books (seepage!244),or for address expansion (see
pagel227).
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¥ OSynchronize on DisconnectOIf turned on, the address book will be synchronized
when disconnecting from the network, provided that address book synchronization
has beenrequestedin the disconnect dialog (seesection!5.4.6).

¥ Address book stateicon:

An address book on aremote server.

An address book on aremote server that is available
for use in disconnected mode. This icon is only

&)

L;] An addressbook on the local machine.
S

* shown when in disconnected mode.

5.10.2.2 Address Book Details: Access

Access Control List

Key
User ID 1S == § Lookup
Currant Usear: Y Y BT T AV

() Raad
vince LU / Write
daboo ooy e G e G

l:,'_‘,:i Create

tay Delete

l_b-d_-r Admin

“ Add User... ) [ Remove User | STlflEf@

Figure 120 The Address Book Details OAccesséanel

The OAccessO panel displays information about the access control list for the address book.
This is the list of userswho have Orights@ the address book. For address books, there are
atotal of six rights or privileges that can be applied to eachuser. Theseare:

¥ i, OLookup®if set,the useris able to seethe address book if they attempt to list it.

¥ 4 ORead{f set,the useris able to seeaddressesor groups in the address book.
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¥ ¢ OWwrite®if set,the user can changeany addressor group in the address book, but
not delete them.

¥ 02 Ocreatedf set,the user can create sub-hierarchies of address books below the
current address book.

i~ ObDeletedf set,the user can delete addressesor groups from the address book.

& OAdminO - if set, the user is able to change the access control list for the address
book.

The rights that you have to the address book are shown in the OCurrentUser:Gow at the
top of the accesscontrol list table. All usersQights are then shown in the table below this.
Eachrow consistsof a user id, followed by six icons or buttons representing the state of the
right for that user. This table behavesin exactly the sameway asthe one used to setthe
accesscontrol for mailboxes (seepage!146).

5.10.3 Reference
OPERATIONS ON ADDRESS BOOKS
To view the Address Book Choose Contacts from the 3-
Manager panein the 3-pane pane window tabs.
window

To bring the Address Book Choose Address Book
Manager window to the front Manager from the Address

menu.

To createa new addressbook choose New Address BookE

from the Address menu after
selecting an address server, or
click the New button.

To open one or more selected Pressreturn or enter on the
remote address books keyboard, or click the Open
button.

Double-click any one of the
selectedaddress books.

To open an address book Choose Open Address BookE

from the Address menu, or
click the Open button

To rename one or more Choose Rename Address
selectedaddress books BookE from the Address
menu.

Toimport addressesfrom a  Choose Import  AddressesE
different type of address book from the Address menu

into the selectedaddress book

242 Mulberry Reference Guide v4



To export addressesin the
selectedaddress book to a
different type of address book

Choose Export AddressesE
from the Address menu.

To delete one or more selected
address books

Choose Delete Address

BookE from the Address
menu, or click the Delete
button.

To login to the selected
remote address book server

Choose LoginE from Address
menu.

Double-click the remote address
book server.

To logout from the selected
address book server

Choose Logout from the
Address menu.

To seeinformation about the
selectedaddress book

Choose Details from the Edit
men, press Command-l (Mac
OSX), Ctrl-l (Windows), or
Metabl (Unix). or click the
Details button.

To searchfor addressesin
address books marked for
searching

Choose SearchE from the

Address menu or click the
Search button.
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5.11 Address Search Window

&S O6 Address Search
Find Items using LDAP F$ server whose
Email Address - :] Contains - :] isamet
8 || & &
Searchk  Clear Draft
|FuII Name |Err|z|il Address |
¥ &2 Emall Address = vince
E, Vince Everrett vince®@oyrusoft.com
¥ 2 Emall Address = isamet
E, Cyrus Daboo daboo®@isamet.com
E, John Degory jdegory@isamet.com
E, Mariss Mednis mmednis@isamet.com
E, Qi He gihe@izamet.com
4
Figure 121 The Address Searchwindow used to searchfor addressesin

local and remote address books, or using directory services

Figure 121shows the Address Searchwindow. This is used to perform searchesfor
addresseseither in local or remote Mulberry address books, or using a directory lookup
protocol.

The Address Search window is divided into four main sections:
¥ The Criteria section is used to specify the criteria for the searchoperation.
¥ The Button section allows has various buttons for common actions.

¥ The Column Headers section indicates which information about an address is displayed
in the corresponding column in the list below.

¥ The Results section displays a list of search results.
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5.11.1 Ciriteria

The address criteria section allows the search criteria to be specified. It consists of three
pop-up menus and one text field:

¥ The OmethodPop-up menu (shown in Figure 122)allows you to choosebetween the
various types of address accounts available for searching:

I OinAddress BooksQuill searchthose Mulberry address books that have the OUsdor
Searching@ption turned on (seepage!240).

I Ousing LDAPO will use any LDAP directory accounts selected in the OServer choiceO

popup menu.
in Address Books
= ysing LDAP
Figure 122 The method pop-up menu used to select the method to use for

the address search

¥ The Oserver choiceO pop-up menu (shown in Figure 121) only appears when LDAP has
been chosen as the search method. The pop-up allows each individual LDAP server to
be searched in turn if desired.

¥ The OfieldO pop-up menu (shown in Figure 123) allows you to choose which address field
to search.Theseare the fields available in a Mulberry addressbook (seepage!250).

Full Mame
Mick-Mame

*  Email Address
Company
Address
Phone Work
Phone Home
Fax
LELs
Notes

Figure 123 The field pop-up menu used to selectwhich field to searchon

when doing an address search

¥ The Omatch@op-up menu (shown in ) allows you to choosewhich part of the address
field you want to look for text in:

I OlsO will attempt to find addresses with fields exactly matching the search text.
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Ostarts withO will attempt to find addresses with fields which have the search text at
the start.

OEnds withO will attempt to find addresses with fields which have the search text at
the end.

OcContainsO will attempt to find addresses with fields which have the search text
contained anywhere within it.

=

starts with
Ends with
= (Contains
Figure 124 The match pop-up menu is used to selectwhich part of the

address text to compare with the searchtext

¥ Thetext field allows you to enter the text to searchfor. Pressingreturn or enter on

the keyboard will initiate the search. You can use a O*0 as a wildcard character to match
one or more occurrencesof any character. e.g. Ocyru*@/lll match Ocyrusénd OcyrusoftO
When you use the OStarts with®, OEnds withO or OContainsO options for the OContainsO
popup menu, Mulberry automatlcally includes a O*O in the appropriate place for the

search. E.g. assuming the text field is set to OsearchO

Ostarts with®: actual text searched Osearch*O.
OEnds withO : actual text searched O*searchO.
OContainsO : actual text searched O*search*O.

5.11.2 Buttons

The button section contains the following buttons:

¥ Search!Dlinitiates a search using the criteria provided.

¥ Clear!'Plremovesall searchresults from the results list.

¥ Message!D!creates a new draft message with its address fields automatically filled in
with any selectedentries in the results list. There are two ways to use the Message
button which depend on whether the Option (Mac !0S), Alt (Windows) or Ctrl (Unix)
key is held down when clicking the button or not. The choice of action is determined by
the OAddressespreference panel (seepage 84).
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¥

In one case a new draft message window is automatically created with its OTo:0
address field filled in with the selected entries in the active list.

In the second case Mulberry will display a dialog (similar to the one shown in Figure
109) which allows you to choose which addresses from the selection in the active list
are to be used in the draft message and in which address fields they should appear.
You can choosewhere to put eachaddressin the draft messageby clicking on or off
one of the diamond buttons next to the address. Once the required choiceis made,
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click the New Message button or pressreturn to createa new draft messagewith
the requested addresses automatically filled in.

5.11.3 Column Headers

The column headers indicate what address information is displayed in each column in the
list below it.

MAc OS X To change a category, or to insert a new category, or to delete an existing
category click the mouse button with the command (3) key down (3 -click)
on the category title.

WINDOWS To change a category, or to insert a new category, or to delete an existing
UNIX category click the right mouse button on the category title.

When you do this the menu shown in Figure 125will appear giving you the choice of what
category to show in the corresponding column. You can also insert a new column before
or after the one clicked, or delete the column that was clicked.

¥ Full Name (Smart Sort)
Full Name (Simple Sort)
Mick-Name
Email Address
Company
Address
Phone Work
Phone Home
Fax
URLs
Motes

Insert Column after
Insert Column before
Delete Column

Figure 125 The pop-up menu used to change column information in the
address searchwindow

The OSmarsortoption for OFulNameQwill causeMulberry to sort the addressesusing the _

full name, but it will attempt to format the name into OFirstastGand sort first by the OLastO

text, then the OFirstO text. The OSimply SortO option for OFull NameO will cause Mulberry to
sort addressesusing the full name text without any special formatting changes.
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5.11.4 Results

The results lists shows results of searches. Each search is shown in its own hierarchy, with
the hierarchy row shown in gray, and with a description of the searchcriteria used to
generatethat particular setof results. You can collapse or expand a hierarchy by clicking on
the disclosure button next to the description.

The search results will not be deleted when the window is closed, but they will be lost
when quitting from Mulberry. You canremove all the results using the Clear button. You
candelete an entire hierarchy by selecting the hierarchy description row and pressing
delete . You can delete individual search results by selecting them and pressingdelete

Each address can be edited by double-clicking on the address entry. This will display the
dialog shown in Figure 128, which can be used to edit the address.

Addressesin the results table can be copied to an address book or to a draft window

addressfield either through the clipboard Copy and Paste functions, or by using drag and
drop to drag the addressesof interest to their destination.

5.11.5 Reference
SEARCHING ADDRESS BOOKS

To bring the Address Search  choose SearchE from the
window to the front

Address menu.

Click the Search button in the
Address Book Manager
window.

To start a new search Click the Search button.

Pressreturn or enter on the
keyboard after entering text in
the text field.

To delete all search results Click the Clear button.

Pressclear on the keyboard.

To delete selected search resull Pressdelete on the keyboard.

sets

To delete selected individual Pressdelete on the keyboard.
address search results

To change one or more Double-click the selected
selected individual address address, or pressreturn  or
search results enter on the keyboard.

To createa draft message Choose New Message from

using one or more selected

the File menu or press
addressesor groups

Command-N (Mac OS X),

Ctrl-N (Windows), or MetabN
(Unix).
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Click the Message button in the
address book window.

To copy one or more selected
addressesto a draft message

Choose Copy from the Edit

menu or press Command-C
(Mac OS X), Ctrl-C (Windows)

or MetabC (Unix), go to the
addressin the draft messageand

choose Paste from the Edit

menu or press Command-V
(Mac OS X), Ctrl-V (Windows)

or MetabV (Unix).

Drag the selecteditems to the
address field in the draft
messagewindow.

(This feature is only available if Drag
and Drop is supported)

To add one or more selected
addressesto an address book

Choose Copy from the Edit

menu or press Command-C
(Mac OS X) or Ctrl-C (Windows)

or MetabC (Unix), go to the
address book window choose

Paste from the Edit menu or
press Command-V (Mac OS X)

Ctrl-V (Windows) or MetabV
(Unix).

Drag the selecteditems to the
single address table in the
address book window.

(This feature is only available if Drag
and Drop is supported)

Drag the selecteditems to the
addressbook listed in the
Address Book Manager
window.

(This feature is only available if Drag
and Drop is supported)
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5.12 Address Book Pane/Window

£} imsp:vince By
¥ Hide Addresses L_"-;IU Add M New Message to
Full Mame Email Address
&4 A Friend friend®example.com
& First Customer customer@exmaple.com
& Happy Customer happy@example.com
& Somebody Else somebody®example.com
¥ Hide Groups & Add | L Mew Message to
» & group
& ISAMET, Inc.
® 8 Mailing Lists
» 8 sites
Addrasses: 4 Groups: 4

Figure 126 A typical addressbook window

Figure 126shows a typical addressbook pane. Address books allow you to store
commonly used email addressesand groups of addresses.Address books can either be
stored locally on the computer running Mulberry, or remotely on a server. Address books
are managed using the Address Book Manager pane/window.

You can assign Onick-namesO to addresses and groups, which you can then enter in address
fields in draft message windows. Mulberry will automatically substitute the correct email
addresswhen it sendsthe message.

Note Nick-name resolution only works if the address book
containing the nick-name has been marked for nick-name
resolution in the Address Book Manager pane/window.

You can specify any number of address books to be opened when a preference setis
opened by turning on the OOperat StartupQoption for the address book in the Address
Book Manager window.
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An address book pane is divided into three main sections:
¥ The single address list section shows the list of single addresses in the address book.

¥ The group list section shows a hierarchical list of groups with their corresponding
addresses.

¥ The addressor group preview area.

In the address book pane, either the addresslist section or the group list section is active at
any time. The active list has a highlight border around it. Sometoolbar buttons and menu
commands operate on the active list only.

5.12.1 Toolbar Buttons

The address book window has atoolbar associatedwith it, whereas the address book pane
in the 3-panewindow usesthe toolbar in the 3-pane window.

The address book window toolbar contains the following items:

3 Create a new draft window to allow you to compose a new message.
M Seesection!5.12.1.1below for afull description of what this button
Draft will do.

O Createsa new address.

-

Single

: . Createsa new group.

Group

.ﬁ Edits the selected addresses or groups.
Edit

Q Deletesthe selectedaddressesor groups.
=
Delete

Table 8 The Address Book Window Toolbar

5.12.1.1 Creating Messages with the Address Book

The Draft toolbar button is used to createa new draft messagewith its addressfields
automatically filled in with any selected entries in the active list. There are two ways to use
the Draft button which depend on whether the Option (Mac OS X), Alt (Windows) or
Control (Unix) key is held down when clicking the button or not. The choice of action is
determined by the OAddressespreference panel (seepage 84).

¥ In one case a new draft message window is automatically created with its OTo:0 address
field filled in with the selected entries in the active list.
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¥

In the second case Mulberry will display a dialog (similar to the one shown in Figure

109) which allows you to choose which addresses from the selection in the active list are
to be used in the draft message and in which address fields they should appear. You can
choosewhere to put eachaddressin the draft messageby clicking on or off one of the
diamond buttons next to the address. Once the required choiceis made, click the OK
button or pressreturn to createanew draft messagewith the requested addresses
automatically filled in. If there are any drafts currently open, those will appear in the

Add to Draft popup menu. If you selectan existing draft from that popup, the
addresseswill be added to the corresponding fields in that draft, rather than a new one
being created.

5.12.2 Single Address List

The single address list shows single addresses in the address book. The single address list
has a setof column headersthat can be used to determine what type of information is
displayed as well as the sort order for the list data.

5.12.2.1 Column Headers

The two pop-up menus are used to determine what information is shown in the single
address field and what method of sorting is used to display the addresses. The menu
choices are shown in

Column headerscan be re-arranged, added, or deleted.

MAc OS X Hold down the control key and click the mouse button (ctrl-click) on a
column header to changethe column type, insert a new column, or delete
the column.

WINDOWS Click the right mouse button on a column header to change the column

UNix type, insert a new column, or delete the column.

When you do this, the menu shown in Figure 127will appear.
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v Full Name (Smart Sort)
Full Name (Simple Sort)
Mick-Name
Email Address
Company
Address
Phone Work
Phone Home
Fax
URLs
Notes

Insert Column after
Insert Column before
Delete Column

Figure 127 The pop-up menu for changing column headers in the address
book pane

Creating a New Address

To create a new entry in the single address list, first make sure it is active by clicking inside
it and then click the New button in the address book header. This will display the dialog
shown in Figure 128. Enter the values you desire and then click OK. The ONick-nameO field
canbe used asan alias for the email address. This can be entered in any draft message
window and Mulberry will resolve the nick-name to its proper email address provided the
address book containing it is open.
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Address Edit

Full Mame: First Customer Phone Work: +1 412 &05 0000
Mick-Mame: cust] Fhone Home: +1 412 605 0000
Email: customer@exmaple.com Fax: 41 412 605 0000

Company: Email Ltad

Address:| 2ZB21 SMTP Drive,
Protocol Parkway,

Hame Town,
RFC 2822

URLs:| http:/fwww.mulberrymail.com/mulberry

Motes:| First ever Mulberry customer.
Hopefully very satisified.

( Cancel ) f OK }

Figure 128 The new address dialog, which is also used for editing
address information

5.12.2.2 Editing an Address

If the preview area is visible, click once on an address to select it and have it previewed,
and then edit it in the preview area.

Alternatively, double-click the address to be edited. The dialog shown in Figure 128 will
again appear allowing you to changethe values previously entered.

5.12.2.3 Copying Addresses

You candrag and drop addressesbetween address books or to a draft messagewindow to
copy an addressto another location.

5.12.3 Group List

The group list shows groups of addressesin the address book. You can group any number
of single addressesor other groups together in a group, which canthen be referred to by a
nick-name. When a group nick-name is resolved all the addresses in the group will be
inserted into the addressfield. Mulberry canresolve up to 10levels of nested groups as
well.
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5.12.3.1 Creating a Group

To create a new entry in the group list, first make sure it is active by clicking inside it and
then click the New button in the address book header. This will display the dialog shown in
Figure 129. Enter the values you desire and then clickOK. The ONick-NameO field can be
used asan alias for the group. Single addressesor groups should be typed into the
OAddressesO field. Entries in the OAddressesO field can also be alphabetically sorted by
clicking the Sort button.

Group Edit

Group Mame: ISAMET, Inc.|
Mick-Mame: isamet

Addresses: | daboo®isamet.com
jdegory@isamet.com
mmednis@isamet.com
gihe@isamet.com

Sart

[ Cancel | f DK }

Figure 129 The new group dialog, which is also used for editing a group

5.12.3.2 Editing a Group

If the preview area is visible, click once on a group to select it and have it previewed, and
then edit it in the preview area.

Alternatively, double-click the address to be edited. The dialog shown in Figure 129 will
again appear allowing you to changethe values previously entered.

5.12.3.3 Copying Groups

You can also drag and drop or copy and paste addresses from a single address field into a
group. You candrag and drop groups between address books or to a draft message
window to copy the group to another location.
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5.12.4 Address/Group Preview

The address preview areashows the content of the selectedaddress or group from the
active addressor group table of the address book it is attached to. Addresses or groups can
be changed by editing the content of the preview panel items.

5.12.4.1 Address Preview Panels

The Address preview, shown in Figure 130,contains three panels to show all the content of
an address:

¥ Personal b This shows the name, nick-name, email address and company.
¥ Contact b This shows the phone and fax numbers, mailing address and URLSs.
¥ Notes b This shows the notes.

& Happy Customer 5|

| Personal | Contact Notes

Full Name: llappg.r Customer
Mick-Mame:
Email: happy@example.com

Company:

Figure 130 The address preview pane

5.12.4.2 Group Preview Panel

The Group preview panel, shown in Figure 131,shows the name, nick-name and address
list for the group.
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g ISAMET, Inc.

",

Group Mame: 1SAMET, Inc.
Mick-Name: isamet

Addresses:

' Group ?|

daboo@isamet.com

jdegory@isamet.com
mmednis®@isamet.com

gihe@isamet.com

' =

Lort

Figure 131

5.12.5 Reference

The group preview pane

OPERATIONS ON ADDRESS BOOKS

To createan address book

Choose New Address Book

from the Address menu with
either the OLocal@r a remote
server item selectedin the
Address Book Manager
window.

To open an address book
from disk

Choose Open Address BookE

from the Address menu with
either the OLocal@r aremote
server item selectedin the
Address Book Manager
window..

To import addressesinto an
address book from a different
format address book

Choose Import  AddressesE

from the Address menu. You
canimport OCommunicatorO,
OPineO, OEudoraO, B
OOutlook/Outlook ExpressO or
ONetscapeO address entries.
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To export an address book in
another format

Choose Export AddressesE

from the Address menu. You_
can export as OCommunicatorO,
OPineO, OEudoraO, .
OOutlook/Outlook ExpressO or
ONetscapeO.

To save an address book

Choose Save from the File

menu or press Command-S
(Mac OS X), Ctrl-S (Windows),

MetabS (Unix).

To save an address book using
a different name

Choose Save AsE from the
File menu.

To createa new address

Select the single address list and
click the New button in the
address book window.

To change one or more
selected single addresses

Double-click the selected
address.

To delete one or more selected
addresses

Click the Delete button in the
address book window.

To createa new group

Select the group list and click the
New button in the address book
window.

To add addressesor other
groups to a group

Drag the selectedaddressesor
groups to the another group.

Double-click the destination
group and type the addressesor
groups you want added.

To change one or more
selectedgroups

Double-click the selected group.

To delete one or more selected
groups

Click the Delete button in the
address book window.

To createa draft message
using one or more selected
addressesor groups

Choose New Message from
the File menu or press
Command-N (Mac OS X),

Ctrl-N (Windows), MetabN
(Unix).

Click the Message button in the
address book window.
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To copy one or more selected Choose Copy from the Edit
addressesor groups to a draft menu or press Command-C

message (Mac OS X) Ctrl-C (Windows) or

MetabC (Unix), go to the
addressin the draft messageand

choose Paste from the Edit

menu or press Command-V
(Mac OS X), Ctrl-V (Windows)

or MetabV (Unix).
Drag the selecteditems to the

address field in the draft
messagewindow.

To add addressesfrom a Drag the messagefrom its
messageto an address book mailbox window into the
address book window.

5.13 Calendar Store Pane/Window

The calendar store pane/window displays is used to organize local and remote calendars.

The calendar store pane, an example of which is shown in Figure 132, is divided into two
main sections:
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o Email | Contacts | Calendarzli i

+ | Mame Colour
v Lm:al Calendars

¥ 2445 AllExamples ]
> E Backups
> E Container

G IETF-62-TZ
> E Specials
A\ J @\hh Calendars

T 20053 2Tourd2de3i2France.ics
¥ () Cyrusoft CalDAV
> E public
v E LUsers
v E daboo@isamet.com
. home [ ]
T test
. work ]
> Ejd&gnw@isamet-cnm
> E kdaboo@omu.edu
> E mmednis@isamet.com

Figure 132 The Calendar Store pane.

¥ Theitems in the Column Header section indicate what type of calendar information is
displayed in the corresponding column in the Calendar List section.

¥ The Calendar List section displays lists of calendars.
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5.13.1 Toolbar Buttons

The calendar store window has a toolbar associatedwith it, whereas the calendar store
pane in the 3-panewindow usesthe toolbar in the 3-pane window.

The calendar store window toolbar contains the following items:

5 Createsa new draft window. When an event or task is selected,the
m selected item is added to the draft as an attachment.

Changescalendar accounts between online and offline states.

Legin
— Creates a new calendar or calendar container in a calendar account.
Create
- When a calendar or calendar account is selected, this will display a
) 1) dialog providing details about the selected item.
Cetails
5.13.2 Column Headers

The column headers indicate what address book information is displayed in each column in
the list below it. The column indicates with text or an icon what the information is:

¥ -/ ShowsaOdiamond®utton that can be clicked on or off to add calendarsto the
main calendar display.

¥ OName® The name of the calendar or account.

¥ OcColourO - The colour of the calendarOs displayed events and. You can double-click the
colour to changeit. The colour button is only present when the calendar is subscribed.

MAc OS X Hold down the control key and click the mouse button (ctrl-click) on a
column header to changethe column type, insert a new column, or delete
the column.

WiINDOWS To change a category, or to insert a new category, or to delete an existing

UNix category click the right mouse button on the category title.

When you do this the menu shown in Figure 133will appear giving you the choice of what
category to show in the corresponding column. You can also insert a new column before
or after the one clicked, or delete the column that was clicked.
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v Subscribe
Colour

Insert Column after
Insert Column before
Delete Column

Figure 133 The pop-up menu used to change column information in the
calendar store window

Note The OName€olumn which shows the name of the calendar
or accountis always present and cannot be changed or deleted.
You caninsert columns before or after it though.

5.13.3 Calendar List

The calendar store list shows calendars within a hierarchy that represents the local or B
remote OaccountO that handles the calendars. The first account is always OLocal CalendarsO
and representsthe local storage of address books on the computer on which Mulberry is
currently running. Subsequentaccounts are remote address book accountssetup in the
OAccountspreference panel (seepage!91).Different icons are used to represent the

different types of items displayed in each row:

w/ A remote calendar account.

e A remote calendar account that is available for use in disconnected mode. This
icon is only shown when the account is in disconnected mode.

NG A web-calendar account.

L;J A Local calendar account.

I_j A hierarchy within a calendar account.

2 A remote or local calendar that can be opened.

Y A remote calendar that cannot be accessedn disconnected mode.

5.13.4 Getting Information on Calendars

Mulberry allows you to view detailed information on the various calendar accountsthat
you have configured in your Accounts preferences, as well as details about individual
calendars. This information will be of most interest to experienced usersand system
administrators.
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To getinformation on an account, click oncein a server pane on the account name or a
calendar in the account you want to examine, and click the Details toolbar button, or select
Details... from the Edit menu.

To get information on a calendar, click once on the calendar and click the Details button in
the server pane tool bar or selectDetails... from the Edit menu. You will be presented
with the Calendar Details dialog box, which is shown in Figure 134.

The Details dialog can have up to five different panels displaying different information
about the server or mailbox. The five possible panels are:

¥ Options
¥ Details
¥ Server
¥ Webcal*
¥ Access *
Calendar: users/daboo@isamet.com/work
Options
f2f Options l'\.._.-"l
[14] Details E show in Subscribed Views
&9 Server
ldentity
E Tie to ldentity
o Access

Identity: Default

48
e

Figure 134 The Calendar Details dialog showing the OOptions'panel

* Note: The OAccessO panel is only available when you are
communicating with a WebDAV or CalDAV calendar server
that supports the WebDAV access-controlextensions.

Mulberry Reference Guide v4 263



5.13.4.1 Calendar Details: Options

Options

E Show in Subscribed Views

Identity
E Tie to ldentity

Identity: Default

E N 3
e

Figure 135 The Calendar Details OOptions@anel

This panel allows you to set several different options for a given calendar. The available
options are:

¥ OShow in Subscribed ViewsO:If turned on, the calendar will be displayed in the
subscribed calendars pane.

¥ OTie to IdentityOlf turned on, the identity chosen in the popup menu will be Otiedd to the
selectedmailbox. When creating new drafts, or replying to messagesn the selected
mailbox, Mulberry may automatically select the OtiedO identity in the new draft window.
For more information on tied identities seepage!229.

264 Mulberry Reference Guide v4



5.13.4.2 Calendar Details: Details

Details

Mame: work l\.__J

Server: www.cyrusoft.com:B080

Hierarchy: wusers/daboo@isamet.com

Hierarchy
Separator:

Size: f Calculate

Status: Open, Subscribed

synchronised: Calendar has not been synchronised

Figure 136 The Calendar Details ODetails@anel

The items in this panel are:

¥ ONameO The name of the calendar.

¥ OServerOThe Internet address of the server on which this calendar is located.
¥ OHierarchy®  The hierarchy that the calendar belongs to, if any.
¥

OHierarchySeparatorO The character that signifies a new level of hierarchy in the
calendar name.

¥ OsSizeO Shows the size of the calendar in bytes.
¥ Ocalculated Clicking this button causes the calendar size to be re-calculated.
¥ OstatusO Shows various status information about the mailbox:

b OOpenO Indicates that the calendar is open.

b OSubscribedd Indicates that the calendar is subscribed to.
¥  OSynchronizedhows the date and time that the calendar was last synchronized.
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5.13.4.3 Calendar Details: Server

Server
Mame: www.cyrusoft.com:8080 l\.,_,.)

Type: DAV Level 2

Greeting:  Apache-Coyote/1.1

Capability: Allow: PROPPATCH, COPY, DELETE, POST, GET, i
REFORT, PROPFIMD, PUT, UNBIND, MOWE, UNLOCK, b}
TRACE, OPTIONS, HEAD, ACL, LOCE, BIMD, COMMECT,
REBIND, SEARCH
Cache-Contral: no-cache
DASL: <DAV:basicsearchz
DaN: 1, 2, slide, access-contral, binding

MALI. . fm el mmmbee]l i e klma - . B L E e S L

Connection: Not secure - plain text data

Figure 137 The Calendar Details OServer@anel

¥ ONamed Shows the Internet address of the server.

¥ OTypeO Shows which calendar protocol Mulberry is using to communicate
with the server.

¥ OGreetingd Shows the server identification string.

¥ OcCapabiltyd  Shows the information returned by the server to indicate what options
it supports.

¥ OcConnection® Shows whether an SSL secure connection is in place or not. If one is,
the View Certificate button can be used to view the SSLcertificate that the server
provided.
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5.13.4.4 Calendar Details: Webcal

Webcalendar Details q:)
w

URL: http://Yexample.com/Z2005 Tour de France.ics

E Allow Local Changes
"~ Automatically Publish to Server when Changes Ocour

Refresh Calendar from Server

@ Mever

" Every: 30 mins.

Figure 138 The Calendar Details OWebcal@anel

¥ OURLO Showsthe URL for the web-calendar, which can be changed.
OAllow Local ChangesONhen turned on, the calendar can be edited locally.

#

¥ OAutomatically PublishOWhen turned on, changesto a calendar locally are
automatically savedto the server when the web-calendar is stored..

¥ ORefresh@llows control of automatic refreshing of the calendar from the server at a
specified time interval.
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5.13.4.5 Calendar Details: Access

Access Control List

Calendar: Cyrusoft CalDAV:users/daboo®@isamet.co... | Key

_ 14 Lookup
User ID 5%31;_;3_5&: (4 Read
Currant Usear: AR RN B R AR 7 Write
fslide/users/daboo®isamet.com - + + W Create
<< Ay Anonymous Users:» A S S Ty
/slide/roles/guest X HE KX A ®E K s Delete
/slide/roles/root R R R R i Admin

#_ Add User... # Remowve User x 5'[3-'|Ef

Figure 139 The Calendar Details OAccessgaanel

The OAccessO panel displays information about the access control list for the calendar. This is
the list of userswho have Orights@ the calendar. For calendar s, there are a total of six
rights or privileges that can be applied to eachuser. Theseare:

¥ & OLookup®if set,the useris able to seethe calendar if they attempt to list it.
¥ ' ORead{f set,the useris able to seeevents or tasksin the calendar.

¥ ¢ OWriteOif set,the user can changeany eventsor tasksin the calendar, but not
delete them.

¥ 07 OcCreatedf set,the user can create sub-hierarchies of calendars below the current
calendar.

¥y 5 ObDeletedf set,the user can delete events or tasks from the calendar.

¥ & OAdminO - if set, the user is able to change the access control list for the calendar.

The rights that you have to the calendar are shown in the OcCurrentUser:Qow at the top of
the access control list table. All usersO rights are then shown in the table below this. Each
row consistsof a user id, followed by six icons or buttons representing the state of the right
for that user. This table behavesin exactly the sameway asthe one used to setthe access
control for mailboxes (seepage!146).
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5.13.5 Managing calendars

5.13.5.1 Creating Calendars

To createa new calendar, click once on an accountrow and then click the Create toolbar
button. Enter a name for the new calendar and click OK. The new calendar will appear in
the Calendar Store Manager inside the chosenaccountrow. Onceit is present, click on the
OdiamondO button to ensure the calendar is displayed.

5.13.5.2 Moving or Copying Calendars

Drag and drop can be used to move or copy calendars between the same or different
calendar accounts.

5.13.5.3 Import/Export of Calendar Data

5.13.5.3.1 Import

Importing calendarsfrom local iCalendar files can be done in one of three ways:

o Import canbe done to anew calendar object. In this casethe imported data is copied
directly into the calendar. To do this, make sure no calendar is selected in the
calendar store list, then use the File menu OlmportCalendarGcommand. You will be
prompted for afile to import, and then to createa new calendar into which the data
will go.

o Import canbe done to an existing (selected)calendar object, and there are two
options for that:

0 The existing contents of the calendar being imported into can be completely
overwritten.

0 The existing content and the new imported content can be merged using
smart synchronization that ensuresnew and changed items are handled
appropriately.

5.13.5.3.2 Export

Entire calendars can be exported to local iCalendar files. Simply click once to select a
calendar and use the File menu OExport CalendarO command.

5.13.5.4 Web Calendars

Web calendars are associated with either http or webcal URLs which indicate the location
where the calendar data is stored remotely.

5.13.5.4.1 Creating a Web Calendar

A web calendar can be created and Osubscribed® in one of two ways:

o Usethe OAddWeb CalendarGcommand in the Calendar menu and enter and http or
webcal URL for the calendarOs location.

o Click on a Owebcal® URL in a web browser with Mulberry set as your default webcal
URL handler.
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Either of those methods will add a new calendar to the Web Calendars sectionin the
calendar store list, from where it can be viewed.

5.13.5.4.2 Refreshing a Web Calendar

When first subscribed to, Mulberry will download the web calendar data from the internet
and store it locally. If the remote calendar changesyou will needto use the ORefresiWeb
CalendarCcommand in the Calendar menu to download the updated calendar data so that
what you seein Mulberry is the sameasthe data on the internet.

5.14 Calendar View Pane/Window

5.14.1 Toolbar Buttons

The calendar view window has a toolbar associated with it, whereas the calendar view
pane in the 3-panewindow usesthe toolbar in the 3-pane window.

The calendar view window toolbar contains the following items:

; Createsa new draft window. When an event or task is selected,the
M selected item is added to the draft as an attachment.

Draft

Createsa new event.

&l

Event

Createsa new to do item (task).

=y
)
4

—
[=]
2
=]

Changes the calendar view to display a single day.

Changesthe calendar view to show the work days.

(2] |¢ [E

ﬁ-

Changesthe calendar view to show an entire week.

__
=
] I
1]
-~

Changesthe calendar view to show an entire month.

Month
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Changesthe calendar view to show an entire year.

Changes the calendar view to display a listing of events within a
specified time range.

L0 | L

SuImimary

Shows or hides the tasks view.

E

Tasks

Changesthe current event view so that the current day is displayed.

'

-
=]
(=S
1]
)

Switches the current event view so that a chosen date is displayed.

I8

oy
o
o

When a calendar or calendar account is selected, this will display a
dialog providing details about the selected item.

E..

Details

5.14.2 Event View

5.14.2.1 Types of Layout

The event view hasfour main types of layout, one of which hasthree variants. These
layouts show different ranges of datesin different ways. Mulberry always remembers the
last layout and settings used between sessionsand for eachnamed calendar that is opened
into its own window.

At the top of eachlayout are a seriesof buttons and popups that control various features of
eachlayout.
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5.14.2.2 Year Layout

272

@ 2005 m

| 2005 |D idmwstcnlumns Iﬂ

February

000000606 6000006060 60V0V66
1 1 2 3 4 5 1 2 3 4 5

2 3 456 7 8
9101112131415
161718192021 22
2324252627 2829
3031

April

__ April |
00000066
1 2

3456 7 89
10111213141516
171819202122 23
24 252627 282930

July

00000066
1 2

345 6 7Y 8 89
101112131415 16
1718192021 2223
24252627 282930
il

October

00000066
1

2 3 456 7 8
9101112131415
161718192021 22
2324252627 28289
3031

B 7 & 9101112
1314151617 1818
2021222324 2526
27 28

May

| May |
000000606

1 2 3 45 & 7
8 91011121314
151617 18192021
222324252027 28
293031

August

000000606

1 2 3 456
7 8 910111213
14151617 181920
21222324 252627
28293031

Movember
000000606
1 2 3 4 5
6B 7 B 9101112
1114151617 1819
20212223 242526
27282930

6 7 8 9101112
1314151617 1818
202122232425 26
2728293031

June
00000066
1 2 3 4
5 6 7 8 91011
121314151617 18
1920212223 24 25

2627282930
00000066

1 2 3
4 5 6 7 & 910
111213141516 17
1819202122 23 24
252627 282930

December
(SIMITIWITIFTS)
1 2 3
4 5 6 7 & 910
11121314151617
151920212223 24
252027 28293031

Figure 140

The Year Event view
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The year layout (shown in Figure 140)displays a calendar grid of twelve months for a
single year.

At the top of the layout are buttons that allow the year to be changed forward or

backwards. Also, a popup controls the pattern of rows and columns used for the grid of
months.

Double-clicking a month title will switch the view to the month layout for the selected
month.

Double-clicking a day within a month grid will switch to the day view for the selected date.

A single-click on a day will select that day. When switching to one of the other views, the
other view will be adjusted so that the selected day is within the range of visible days.

If the current year is being shown, the current dateOs cell will be shown in blue.
The year layout does not display any information about events.
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5.14.2.3 Month Layout

[ May 2005 o
May 2005 "Us/Eastern )

S5un | Mon | Tue | Wed | Thu | Fri Sat
1 May 5 6 B

2
9

3
.
10
EEEE

4
[RECURRT....|
11

[vTccap... |

= =
(Ta ] Pt

15 16 17 18 20 21
22 23 24 25 26 27 28
29 30 2 3 4

Figure 141

The Mont

h Event view

The month layout (shown in Figure 141)displays a calendar grid of days for an entire
month, with sevencolumns for eachday and four to six rows. The day of the week
(Sunday, Monday etc) used for the first column is setvia the preferences.Sometimesdays

from the previous and next months are also shown, and they appear with a grey
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background. Eachday hasits own rectangular region with the day of the month number in
the top-left corner. Events for eachday are shown within that dayOsectangle only, unless
the event spans multiple days.

Buttons at the top of the layout allow the month and year to be separately advanced
forwards or backwards, one month or year at atime. The timezone popup is also present
to adjust the display of eventsto the chosentimezone.

Events are shown using two possible shapes:

o A Orounded-edgeO rectangle is used to indicate OAIl DayO events, and these always
appear above OTimed®ventsin any day.

o A Osquare-edgedO rectangle is used to indicate OTimedO events.

A jagged edge may appear at the left or right side of an event. This indicates that the event
spansa period prior to or after the current item.

If there are more eventsin a particular day than can be displayed in the available space,the
text OMoreECappearsin the top-right corner of that dayOsectangle. To seeall the events,
switch to the day view by double-clicking on the empty spacein that dayOsectangle.

If the current date falls within the chosenmonth (or is one of the days shown just before or
just after the month) then the rectangle for that date is shown in blue.

Double-clicking empty space in a day rectangle will switch to the day view for the selected
data.

Double-clicking an event will display a window for editing the event details.

Hovering the cursor over an event will show atooltip with details about the event.

You can use the tab key on the keyboard to cycle the selection between events shown in
the layout. Shift-tab will reversethe order of selection.

5.14.2.4 Day Layouts

The day layouts display a vertical grid of hours within a day, and show between one and
seven columns for eachday in the grid.

o Ifthe ODayO layout is chosen, then only a single day will be shown (Figure 142).
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(i Monday, May 09, 2005 o

[«]QID[»] | us/Eastern '+ Fitto Height |31  Full 24 Hours |3

2005 Monday, May 09
all Day

12:00 am
1:00 am
2:00 am
3:00 am
4:00 am
5:00 am
&:00 am
700 am
&:00 am
300 am

10:00 am

11:00 am

12:00 pm

" 1.00 pm
200 pm
4:00 pm
5:00 pm
600 pm
700 pm
&:00 pm
S:00 pm

10:00 pm

11:00 pm

Figure 142 The Day Event view

o If the OWork@ayout is shown (Figure 143),then only work days will be shown in the
grid. The days of the week that are work days can be controlled via the Preferences.
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(3] Monday, May 09, 2005 - Friday, May 13, 2005

|

[ US/Eastern

'+ | Fit to Height

'+ Full 24 Hours 3]

2005

Mon, May 09

Tue, May 10

Wed, May 11

Thu, May 12

Fri, May 13 |

all Day

12:00 am

1:00 am

2:00 am

3:00 am

4:00 am

5:00 am

&:00 am

700 am

&:00 am

S:00 am
10:00 am

h

11:00 am

12:00 pm

100 pm

2:00 pm

3:00 pm

4:00 pm

5:00 pm

6:00 pm

7:00 pm

2:00 pm

S:00 pm

10:00 pm

11:00 pm

Figure 143

The Work Week Event view

o If the OWeekO layout is shown (Figure 144), then a full seven days will be shown in
the grid, with the first column corresponding to the first day of the week, assetin

the

Preferences.
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(3] Sunday, May 08, 2005 - Saturday, May 14, 2005 o

" US/Eastern ‘4] | Fitto Height %] Full 24 Hours |3
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103 others.. AIDRRD (Weddin
12:00 am
1:00 am
2:00 am
3:00 am
4:00 am
5:00 am
&:00 am
7:00 am
&:00 am

S:00 am
10:00 am

11:00 am
12:00 pm
prm

2:00 pm

3:00 pm -.|

4:00 pm

5:00 pm

6:00 pm -

7:00 pm

2:00 pm

S:00 pm

10:00 pm
11:00 pm

Figure 144 The Week Event view

The range of hours displayed vertically in the grid canvary anywhere between midnight at
the start of a day to midnight at the end of a day. The ORangedpup controls what the
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current range of hours is, and eachrange in the popup (other than OFul24 HoursO)is
controlled via the Preferences.

The height of the rows in the layout can be controlled via the OScalgfdpup. The rows can
be scaled between full size and 1/4 size, and can also be auto-scaled so that the current full
range of hours is completely displayed in the layout, without the needto scroll the pane
vertically.

Also at the top of the layout are buttons that allow the day or week to be changed forward
or backwards. The timezone popup is also present to adjust the display of eventsto the
chosentimezone.

All day events are shown in their own row at the top of the list. The height of that row
automatically adjuststo ensure all such events are visible. A jagged edge may appear on
the left or right side to indicate that the event spansa period prior to or after the current
visible date range.

Timed events are shown in locations that correspond to the time range of that event within
the areaof the list. A jagged edge may appear at the top of bottom to indicate that the
event spansa period prior to or after the current range of time on display, or spans
additional days.

A red horizontal line appearsacrossthe grid at the position corresponding to the current
time. When that intersectsthe column that corresponds to the current day a solid line is
shown, otherwise a dashed line appears. This line will move down the screen keeping track
with the current time.
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5.14.2.5 Summary Layout

(1] Sunday, May 08, 2005 - Saturday, May 14, 2005 i
" US/Eastern '3 | This Week B
Date | Tirme | Summary | Status | Calendar

In the Past

Earlier this Week

Yesterda

Todda

Tomorrow

Later this Week

.y — i

Figure 145 The Summary Event view

The summary layout displays a tabular layout of all events within a specified range of time
around the current date. The time range is set via a popup. Mulberry displays special rows
in the list to group eventstogether within useful periods of time:

o Olrnthe Past@®events prior to the current week.

OEarliethis Weekevents that occurred earlier in the current week.
OYesterdayBevents that occurred yesterday.

OToday©events that occur today.

OTomorrow@®events due to occur tomorrow.

OLatethis Week@events due to occur later this week.
ONextWeek(Pevents due to occur next week.

O O O o 0o o o

Olnthe Future®bevents due to occur after next week.

The left-hand column of information shows vertical Obracketsthat group together events
on the sameday.
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5.14.3 Task View

Show: | All Due

&

Overdue

i1

Due Later

Figure 146 The Task view

The task view shows to-do items for the calendars being shown in the current view. The
set of items displayed is controlled via a popup at the top of the view:

o OAlIDueCPshows any task that is due now or in the future, or is currently overdue.
o OAIIO b shows all tasks, including ones that have been completed or cancelled.
o ODueTodayOPshows only tasks that are due today or overdue.
o ODuehis Week@®shows only tasks due this week or overdue.
o OOverdue®shows only tasksthat are overdue.
Note that tasks completed within the last 24 hours are always shown asareminder.
Mulberry displays special rows in the list to group taskstogether basedon their due date:
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OOverdueO b tasks whose due date is in the past.
ODue NowO b tasks whose due date is today.
ODud aterCbtasks whose due date is after today.

© O O O

ODone®Btasks that have been completed.

o OcCancelledBtasks that were cancelled before being completed.
Each task includes a checkbox that can be turned on to indicate completion.
5.14.4 Preview

The preview pane shows a summary of a selectedevent or task in the event or task view
associated with the preview.

5.14.5 Managing Events
5.14.5.1 Types

5.14.5.1.1 Timed Events

A timed event is one that occurs at a specific time of day and has an arbitrary duration. E.g.
ameeting at 11 am with duration of 1 hour.

5.14.5.1.2 All Day Events

An all day event is one that spans a fixed number of days, with no specific time that it
occurs on those days. E.g. an anniversary or holiday.

5.14.5.1.3 Repeating Events

Timed and all day events can be set to repeat at specific intervals, or on particular days
governed by a set of rules. Whilst Mulberry hasfull support for the range of rules in the
iICalendar standard, it only lets you createa subsetof common rule types in order to keep
the user interface simple.

5.14.5.2 Creating Events

Events can be created by using the New Event command in the Calendar menu, or by
clicking the Event toolbar button. When that is done a new event edit dialog is shown
allowing the new event to be specified.
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5.14.5.3 Editing Events

e o0 Edit Event

Summary: Test Event| test |

4k

Status: Mone |

s
v

{ Timing | Details Alarms  Attendees

__|All Day Event
Starts on: 9/ 5/2005 . |[E| 12:00:00PM . _ US/Eastern s
_JEnds on: 9/ 5/2005 . 1:00:00PM . US/Eastel .
f Duration: 0 E Days bedland 1 0 0 HHMMSS
Eﬂepeats
[ simple | Advanced |

Every 1 [ | Year(s) e

: For ever

" For 1 -~ time(s)

@ untl: 11/ 5/2005 . [@] 1:14:44pPM . [ US/Eastern y

-._; Cancel ;_.- 6 OK 3

Figure 147 The Event editing dialog

The event edit dialog is used for creating, editing and duplicating events.
The dialog contains a common areaat the top and a seriesof tabbed panels underneath.

5.14.5.3.1 Common Area

o OSummary®text that briefly describesthe event. This text appearswhen the event
Is displayed in the calendar views.

0 Calendar popup P lists all currently open calendars. If this is a new event, the
calendar popup will be set to the last calendar used to create a new event. If this is an
existing event, the calendar popup will be set to the calendar that the event is
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currently stored in. You can selecta different calendar to store the event in. Some
calendars may not be modifiable by you. Thosecalendarswill appear with the text
O(Read Only)O after their names in the calendar popup. Whilst those can be selected in
the popup, when they are, the OK button in the dialog will be disabled, since
changesare not allowed.

o OsStatusBallows the state of the event to be set:
o ONoneO b no special status for the event. This is the default.

o OcConfirmed® b the event will definitely take place. When this is selected, a
check mark appears next to the event summary when the event is displayed
in a calendar view.

o OTentativeOthe event has not definitely beenconfirmed. When this is
selected,a question mark will appear next to the event summary when the
event is displayed in a calendar view.

o OcancelledO b the event has been cancelled and will not take place. When this is
selected, the event will be crossed out when displayed in a calendar view.

5.14.5.3.2 Timing Panel

[ Timing | Details Alarms = Attendees

~ | All Day Event
Starts on: | 9/ 5/2005 . |[@| 12:00:00PM . | US/Eastern B
_JEndson: 9/ 5/2005 . 1:00:00 PM -
) Duration: 0 ; Days feland 1 0 0 HHMM:SS
E Repeats
[W Advanced

Every 1 | [,] [ Year(s) T]

" For ever

) For 1 “ timels)

@until: 11/ 5/2005 . [E@| 1:14:44PM . | US/Eastern B

284

Figure 148 The Event editing dialog OTiming(anel
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The timing panel allows you to settiming parameters for an event, including start and end
dates and times and/or duration periods. Also, repeating events can be setup.

o OAIl DayO b turning this on will make the event an all-day event. When it is on, the
time and timezone items below will be hidden asthey are not needed for all-day
events. When it is off, the time and timezone items will be visible and can be used to
settimes for the event.

o OstartonCPallows the start date and, if not an all-day event, the time and timezone
to be set.

o OEndon(Pallows the end date and, if not an all-day event, the time and timezone to
be set.

o ObDuration®an alternative way of specifying the end of an event. The length of the
event in days or weeks and, if not an all-day event, the number of hours, minutes or
secondscan be set.

ORepeatddrontrols whether the event is setto repeat at someinterval. If turned on, the
event will repeat basedon the settings in the tab panels below. If turned of, the event will
occur only once on the date and time specified.

5.14.5.3.3 Recurrence Panels

The iCalendar standard allows for a variety of different ways to specify repeating events or
tasks. Mulberry will only allow you to edit a subsetof the possible variations that exist for
simplicity. However, it will correctly handle repeating complex instances that are generated
by others.

When a repeatlng event is too complex for MulberryOsedltlng capabilities, the OComplexO

tab will appear in the tab-panel and that will contain the OrawO recurrence information

about the event. That complex representation cannot be changed. However, if you switch

to either the OSimpleO or OAdvancedO panels and make any changes there, those changes will
replace the complex rule.

5.14.5.3.3.1 Simple

OEvery®setsthe repeating period of time.
OFoever(Pif selectedthe event will repeat at the choseninterval for ever.

OFoE time(s)(Dif selectedthe event will repeat for the specified number of times
only.

o OuntilO b if selected the event will repeat up to and including the specified time, but
not after it.

5.14.5.3.3.2 Advanced
Displays a brief description of the repeating rule. To edit the rule, click the OEditEO button.
5.14.5.3.3.3 Complex

Shows the complex repeating rule from the original event. This cannot be edited directly.
Leave this tab selectedif you do not want to changethe complex rule, asMulberry will
simply preserve it when the event is edited. Alternatively, you canchangethe rule by
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switching to either the OSimpleO or OAdvancedO tab and specify a new rule there D that rule
will replace the original complex one when the event is changed.

5.14.5.3.4 Details Panel

Timing | Details | Alarms  Attendees

Location: Office

Description: An event of some kind.

Figure 149 The Event editing dialog ODetails@anel

o OLocatiorbtext that describesthe physical location where the event is to take place.

o ObDescription® b detailed text that describes the event (e.g. an agenda, list of
documents needed for the meeting etc).
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5.14.5.3.5 Alerts Panel

Timing  Details | Alarms | Attendees

E Use Alert

Status: Active T]

“JAlerton: 11/ 572005 . 1:14:44 PM ;
) Interval: 0 21| Days Fs 1 and g : HH:MM:55

Before the Start T]

I Behaviour | Repeats

Action: Speak Text T]

Speak Text Test Event

Figure 150 The Event editing dialog OAlerts@anel

OUsd\lertOPTurns on or off an alarm on the event.
OstatusO D Sets the status of the alarm:
o OActiveO b the alarm is pending and will execute when the trigger times occur..

o OCompleted®the alarm has completed asthere are no trigger times left to
execute.

o ODisabledd B the alarm is disabled and will not execute when the trigger times
occur.

o OAlert onO = allows a specific date and time to be set for the alarmOs initial trigger
time.

o Olnterval®setsa duration relative to the start or end of an event that is used to
determine the initial trigger time. The interval popup can be setto:

o OBefor¢he Start(the initial trigger is setat the duration before the start time
of the event.

o OBeforeghe EndCbthe initial trigger is setat the duration before the end time
of the event.
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o OAfterthe Start(Dthe initial trigger is setat the duration after the start time of
the event.

o OAfterthe EndCbthe initial trigger is setat the duration after the end time of
the event.

5.14.5.3.5.1 Behaviour

Allows the type of alarm action to be set:
o OPlay Sound® B when the alarm triggers the standard computer alert sound is played.

o OSpeaRextCbwhen the alarm triggers the specified text is spoken using the
computer text-to-speech capability if present.

o ObDisplay AlertO B when the alarm triggers the specified text is displayed in an alert
box.

o OEmail® b when the alarm triggers an email message with the specified subject and
text is sent to the specified email addresses.

5.14.5.3.5.2 Repeats

Behaviour | Repeats !

Repeat 1 . timel(s)

Interval 1 > Days beland 00 : 00 : 00 HHMM:SS

Figure 151 The Event editing dialog ORepeatsfanel

Thesesettings control whether the alarm occurs more than once and what interval.
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5.14.5.3.6 Attendees Panel

Timing  Details  Alarms | AIIEndEESF

Organiser: Default ﬂ
Mame Participation Role Particpation Status
Vince Everrett Chair Accepted
Cyrus Daboo Required Meeds Action
( New... | | Change... ) | Delete )

Figure 152 The Event editing dialog OAttendees@anel

The attendeespanel displays the list of attendeessetfor the event, aswell asthe organizer
of the event. When anew event is createdit initially hasno attendeesor organizer, and the
Attendees Panel contains a single OAdd AttendeesO button.

When the button is clicked the panel layout changes to show an Organizer popup listing
identities that can be used to indicate who the organizer is, and a list showing the current
attendees.By default the current organizer is added as an attendee whose role is to chair
the event.

Attendees can be added, their status changed, or they can be removed through use of the
buttons below the list.

The attendee list shows the name, role and status of eachattendee. The name may be a
suitable Odisplay nameO or an email address or other calendar address.

The role can be one of:
o OcChair®this is the person in charge of the event

o ORequired® b this attendee is required to participate B the event cannot take place
without them

o OOptional®this attendee may or may not participate asthey deem fit Btheir
presenceis not required for the event to take place
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o ONotParticipatingObthis attendee has beeninformed that the event is taking place
but they are not participating in the event itself

The status can be one of:

o ONeeds ActionO b a reply either accepting or declining the invitation to the event is
still pending

OAcceptedO b the attendee will definitely be participating in the event
ODeclinedO b the attendee will definitely not be participating in the event

OTentative®the attendee s likely to be participating in the event, but has not
definitely confirmed that

o ObDelegatedBthe attendee has delegated their participation to another person
Add Attendee

Attendees:

Cyrus Daboo <daboo®@isamet.com:

Role: Particpation Required T‘

Status: Needs Action T‘

™ RsvP Required

[ Cancel | {_ OK _!I-

Figure 153 The Add Attendees dialog

When creating or editing the information for an attendee, the edit dialog includes popups
allowing the role and status to be set. In addition, the edit field used to specify attendee

names supports address nick-name and expansion behaviour, in a similar manner to the
OToO, OCCO and OBccO fields in a draft window, making it easy to quickly add attendees with
an entry in an address book.

When setting the status of an Attendee, if you choose ONeedsctionOyou can also setan
option that will causean invitation to be sentto them if needed. To do that turn on the
ORSVP RequiredO option.
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5.14.5.4 Copying or Moving Events

To copy an event use the Duplicate Item command in the Calendar menu whilst the event
to be copied is selected.That will createa new event with the same properties asthe one
being copied and open an edit dialog for that event. The copy can be placed in another
calendar by simply choosing the destination calendar via the calendar popup in the edit
dialog. Properties of the duplicated event can be changed without affecting the original.

To move an existing event, simply edit it and change the calendar popup to the calendar
where the event is to be moved.

5.14.6 Managing Tasks

5.14.6.1 Creating Tasks

Taskscan be created by using the New To Do command in the Calendar menu, or by
clicking the To Do toolbar button. When that is done a new task edit dialog is shown
allowing the new task to be specified.
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5.14.6.2 Editing Tasks

860 Edit To Do
Ssummary:  Task| test =
W Completed 11/ 5/2005 . |[E| 1:27:28PM . US/Eastern P2 [ Now

{ Timing | Details  Alarms  Attendees
@ Date Only - no Time

@ Mo Due Date
") Due by: 11/ 5/2005
") Starts on: 11/ 5/2005

Duration: 0O . Jay's =

- L , L 4

E Repeats

{ Simple | Advanced  Complex .

Every 1 . | Yearls) »
E}Fﬂr aver
) For 1 * time(s)
OUntil: 11/ s5/2005 . 1:27:24PM . US/Eastel .

-.__' Cancel '__.- ( OK ]

Figure 154 The Task editing dialog

The to do edit dialog is used for creating, editing and duplicating tasks.
The dialog contains a common areaat the top and a seriesof tabbed panels underneath.

5.14.6.2.1 Common Area

o OSummary®text that briefly describesthe task. This text appearswhen the task is
displayed in the calendar views.

o Calendar popup D lists all currently open calendars. If this is a new task, the calendar
popup will be set to the last calendar used to create a new task. If this is an existing
task, the calendar popup will be setto the calendar that the task is currently stored
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in. You can selecta different calendar to store the task in. Somecalendars may not

be modifiable by you. Those calendars will appear with the text O(Read Only)O after
their names in the calendar popup. Whilst those can be selected in the popup, when
they are, the OK button in the dialog will be disabled, since changes are not allowed.

o OCompleted®changesthe completed state of the task, and allows the completion
date and time to be edited.

o ONow®changesthe completion date and time to the current date and time.
5.14.6.2.2 Timing Panel

The timing panel allows you to settiming parametersfor an event, including start and end
dates and times and/or duration periods. Also, repeating events can be setup.

o ODate Only  no TimeO D turning this on will remove the need to specify a specific
time at which the task is due on the chosendate.

ONo Due DateO P used to indicate a task with no specific due date.

ODuebyOPallows the due date and optionally the time and timezone to be set. If a
task is not completed by that date and time, the task will be considered asoverdue.

OstartonCPallows a start date and optionally the time to be set, along with a duration for
the length of the task. If the task is not completed after the specified duration has passed
since the start date and time, the task will be considered asoverdue.

5.14.6.2.2.1 Recurrence Panels
Sameasfor events.

5.14.6.2.3 Details Panel
Sameasfor events.

5.14.6.2.4 Alerts Panel
Sameasfor events.

5.14.6.2.5 Attendees Panel

Sameas for events.

5.14.7 Sending/Receiving via Email

Both events and tasks can be sentvia email to other people in a standard format that
should allow them to automatically add those items directly to their own calendars,
provided the software they use allows that - if they use Mulberry it will!

5.14.7.1 Sending

To send events or tasks, selectthem in a calendar view and click the Draft toolbar button.
This will create a new draft window with the selected items included as a text/calendar
attachment. Additionally, a summary of the selected items will be displayed as text in the
body of the message.The identity used in the draft is chosenin the following manner:

o If the calendar of the selected items has a OTied IdentityQ, then that identity is used.
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o If the account of the calendar of the selected items has a OTied IdentityO, then that
identity is used.

o If none of the above conditions apply, then the default (first) identity in the
preferences is used.

5.14.7.2 Receiving

By default Mulberry handles received text/calendar attachments itself when you double-
click them, however that is controlled via an option in the preferences.

When a text/calendar attachment is received in incoming email, you can double-click on
the attachment and have Mulberry automatically add the included calendar items to a
calendar of your choice. If the new items are updates to onesalready received, then the
existing items will be updated in the calendar. If the new items are older versions of any
existing items, then no action will be taken.

Someitems sentvia email are invitations that require a responsebthose are handled in a
special manner when you double-click on them as described in the next section.

5.14.8 Scheduling using Email

5.14.8.1 Attendee Status

When an event has one or more attendees,an icon is displayed for that event in the month
or day/week views. The icon is used to indicate the following:

o =7 |Indicates that there are attendeesin the event whose status is not confirmed.

o0 =& Indicates that there is at least one attendee that has declined to participate
whose presenceis required.

0 ¢ Indicates that all attendees whose presence is required have accepted the
invitation

o & Indicates that an event organized by someoneelsethat you have agreed to
participate in.

5.14.8.2 Sending an Invitation

Invitations are sentto all Attendees in an event that have a status of ONeed#\ctionOand
have the ORSVIRequiredQoption turned on. When such attendeesare listed in an event,
you can right-click on the event to display a context menu that will contain an Olnvite
AttendeesQoption. If that option is disabled then there are no suitable attendeesto request
an invitation of.

When the Olnvite AttendeesO command is used, an email message will be created addressed
to eachattendee being invited. The messagewill contain the event asan attachment. If the
OAutomatically Send Email Invitations and RSVPsO option is on in the Calendar preferences,
then the email messageis sent out immediately. If the option is off, a draft window will be
created allowing you to inspect and send the messagewhen needed.
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5.14.8.3 Responding to an Invitation

When an invitation is received via email it can be processed by Mulberry if you double-
click on the calendar attachment included with the message. When that happens Mulberry
will first check the list of attendees to determine which one is you. If a match is found it will
then check whether the event in the invitation will conflict with any events on subscribed
calendars. You can then chooseto:

0 Accept the invitation. If aresponsewas requested by the organizer Mulberry will
createaresponseemail messagecontaining the appropriate RSVP.The accepted
event will then be placed on a subscribed calendar of your choice.

o Decline the invitation. You can only decline an invitation if the organizer asked for a
responsein the invitation. If no responsewas required, you caninstead ignore the
event (described next). The event being declined is not placed on any calendars.

Ignore the invitation. The event is completely ignored Bno responseis senteven if the
organizer requested one, and the event is not placed on any calendars.

5.14.8.4 Handling an Invitation Response

When attendeesrespond to an invitation and send back their responses,they will arrive as
email messages with calendar attachments. Double-clicking on the calendar attachment will
result in the event being updated to reflect the response (acceptedor declined) of the
corresponding attendee.
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6. MENU REFERENCE

6.1 File Menu

New Message 3EN
Open Mailbox... {30
Open Message 3E0
Open Draft. ..

Import Calendar...
Export Calendar...

Close FEW
S5ave £ S
Save As. ..

Revert

Disconnect...

Show Outgoing Queues

Page Setup...
Print... 36 P

New Message
Command-N

Createsa new draft messagewindow in which you can create
messagesto send.

Open MailboxE
Shift-Command-O

Opens a new mailbox or a selectedmailbox depending on the
current selection in the active server pane.

Open Message
Command-O

Opens the selectedmessagesn the active mailbox pane.

Open DraftE

Opens a previously saved draft messagefrom disk.

ImportE

296

Inserts text from any text file at the current selection position in
adraft messagewindow. Or imports calendar data into a
calendar. Or imports rules from a file.
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ExportE

Export calendar data from a calendar. Or exports rules to a file.

Close
Command-W

Closesthe active window or atab in the active mailbox pane.

Save Savesthe current message,draft messageor address book to
Command-s sk
Save AsSE Savesthe current draft messageor address book to disk
allowing you to choosethe file location and name.
Revert Discards changesto the current draft messageor address book.
PreferencesE Opens the OPreferencesfinlog box to allow the settings for the

application to be changed.

Disconnected ModeE

Switches Mulberry between connected and disconnected mode.

Show Outgoing
Queues

Opens the OOutgoing Message QueuesO window or brings it to
the front.

Page Set-upE

Setspaper size, orientation and other printing options for
printing messages.

PrintE Allows selectedmessagesin a mailbox window or messages
Command-P displayed in their own window to be printed.
Quit Quits from Mulberry. This will close all open windows

Command-Q

(allowing any unsaved changes to be saved or discarded) and
logs out of the email server if its still logged in to.
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6.2

Edit Menu

Undo Typing
Redo Typing

Cut

Copy
Paste

Paste as Quotation
Clear
Select All

Find...

Find Next

Replace

Replace & Find Next
Replace All

Text Macros...
Details...

Change Password...
Speak Message

Check 5pelling

46 L
{3z

46X
e C
JEV

dEA

g6 F
G
5B
JET

i

NHET

AL

Undo Undoes the previous editing action.
Command-Z

or

Redo Redoesthe previous editing action that was undone.
Command-Z

Cut Cuts the current text selectionin the active window to the
Command-x  Clipboard.
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Copy Copies the current text selectionin the active window to the
Command-c  Clipboard.
Paste Pastesthe text contents of the clipboard at the selection position

Command-V

in the active window.

Paste as Quotation
Command- '

Pastesthe text contents of the clipboard into at the selection
position in the active draft message. The text is indented using
the quotation characterfrom the OOutgoing@referencespanel

Clear Remove the current selectionin the active window.
Select All Selects all available items in the active window or pane. This
Command-A could betext in a messageor draft messagewindow, messages
in a mailbox window, mailboxes in a server window, or
addressesand groups in an address book window.
FindE Display the Find and Replace dialog that can be used to find and
Command-F  eplacetextin amessageor draft window.
Find Next Finds the next occurrence of text in a messagepane or draft

Command-G
Shift-Command-G

window. If the shift key is down, the previous occurrenceis
searchedfor.

Find Selection
Command-H
Shift-Command-H

Finds the next occurrence of the currently selectedtext in a

messagepane or draft window. If the shift key is down, the
previous occurrenceis searchedfor.

Replace Replace the currently selected text with that previously
Command-B specified in the Find dialog.
Replace & Find Next Replace the currently selected text with that previously

Command-T
Shift-Command-T

specified in the Find dialog, and then find the next occurrence of

the text. If the shift key is down, the previous occurrenceis
searchedfor.

Replace All

Replace all occurrences of the text to find with the text specified
in the Find dialog.

Text Macros

Displays a dialog box that allows you to edit text macros, which
can be used to quickly insert commonly used text into a draft
message.SeeSection!5.9.4.for more details.

DetailsE
Command-I|

Displays a dialog box that gives detailed information about the
selected item.

Change PasswordE

Mulberry Reference Guide v4

Allows passwords for accountssetup in the preferencesto be
changed using password plugins installed in the Plug-ins folder.
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MAcC OS X & WIN32 ONLY

Speak Selection
Option-Command-T

or

MAC OS X & WIN32 ONLY

Speak Message

Options-Command-T

or

MAcC OS X & WIN32 ONLY

Stop Speaking
Option-Command-T

MAc OS X & WIN32 ONLY
Speaksthe selectedmessagesn the active mailbox pane.

MAc OS X & WIN32 ONLY
Speaksthe messagein the active messagepane.

MAc OS X & WIN32 ONLY
Cancelsthe current text to speechoperation.

Check Spelling
OptionBbCommand-L

Checksthe spelling of the currently selectedtext in a message
pane or draft window. If there is no selection the entire text will
be checked. Only text in a draft window can be replaced with
corrections.
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Mailbox Menu

Create...
Rename...

Mark Contents Seen
Delete Mailbox...
Expunge
Synchronise. ..

Clear Disconnected...

Display Hierarchy
Cabinets

Subscribe
Unsubscribe

Checlk Mail
Check Favourites

Sort By

Goto Message. ..
Load All Messages

Update Current Match

Search Mailbox...
Search Again
MNext Search

Rules...
Apply Rules
Make Rule...

Mulberry Reference Guide v4

NdEP

dEE

JEL
{r3EL

b

G

U

3By
{r3eY
Y

New Display Hierarchy...
Edit Display Hierarchy...

Remove Display Hierarchy...

Reser All

Refresh

MNew Cabinert...
Edit Cabinet...
Remove Cabinet...

Add Wildcard ltem...
Edit Wildcard ltem...

Eemove |tem

To

From
Reply To
Sender
Cc
Subject
Thread
Date Sent
Date Received
Size
Flags

v Number

Smart Address
Artachments
Parts

Matching
Disconnected
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CreateE Createsand opens a new mailbox on the server. A dialog
appears asking for the name of the new mailbox.
RenameE Renamesany mailboxes selectedin the active server pane. A

dialog appears asking for the new name.

Mark Contents Seen
OptionbCommand-P

Marks any unseen messagesas seenin the entire mailbox.

DeleteE

Deletesany mailboxes selectedin the active server pane.

Expunge
Command-E

Expunges the deleted messages in the active mailbox pane. This
will permanently remove any messagesflagged as deleted
from the mailbox.

SynchronizeE

Synchronizes the messagesin the active mailbox pane or any
mailboxes selectedin the active server pane.

Clear DisconnectedE

Clears the disconnected messagecachefor the active mailbox
pane or any mailboxes selectedin the active server pane.

Display Hierarchy

New Display HierarchyE
Createsanew display hierarchy in the currently selected
server. This can be used to createa new hierarchy of
mailboxes to view.

Edit Display HierarchyE
Edits the root name for the currently selecteddisplay
hierarchies in the active server pane.

Remove Display HierarchyE
Removesthe currently selecteddisplay hierarchies from
the server pane. This does not delete any mailboxes, it
merely removes them from the server pane display.

Reset All
Displays the Choose Mailbox Locations dialog, described
in Section!5.4.4.4.1.

Refresh
Refreshes any selected display hierarchy, or all the display
hierarchies in a selectedserver. Refreshing forces the
mailbox list to be updated from the server.
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Cabinets

New CabinetE
Createsa new mailbox cabinetin the server pane.

Edit CabinetE
Edits the name of the currently selectedmailbox cabinets
in the server pane.

Remove CabinetE
Removesthe currently selectedmailbox cabinetsfrom the
server pane. This does not delete any mailboxes, it merely
removes the cabinet and its contents.

Add Wildcard IltemE
Createsa new cabinetitem that is able to match a group
of mailboxes using search criteria.

Edit Wildcard ItemE
Edits the name of a cabinet item that is able to match a
group of mailboxes using searchcriteria.

Remove ItemE
Removesan item from a mailbox cabinet. This does not
delete any mailboxes, it merely removes the cabinet item
from the server pane.

Subscribe
Command-=

Adds any mailboxes selectedin the active server pane to the
serverOs list of OsubscribedO mailboxes.

Unsubscribe
Command--

Removesany mailboxes selectedin the active server pane from
the serverOs list of OsubscribedO mailboxes.

Check Emaill
Command-L

Checksfor new email arriving in any mailboxes selectedin the
active server pane, or in the active mailbox pane.

Check Favorites
Shift-Command- L

Checksfor new email arriving in any mailboxes marked for
automatic checking.

Sort By

Provides a hierarchical menu to choosethe sorting method for
the active mailbox pane.

Goto MessageE
OptionBbCommand-G

Allows the selectionin the active mailbox pane to be moved to
a specific messagenumber.

Load All Messages

Forcesthe loading of all messagedetails when a mailboxes
messagecacheis not complete.

Update Current Match
Command-U
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When Matching is being used (seeSection!5.5.5for more
details) this command can be used to update the setof
matching messagesbasedon current criteria.
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SearchE
Command-Y

Allows messagesto be searchedfor in the current mailbox or
any mailboxes selectedin the server pane.

Search Again
Shift-Command-Y

Applies the previously used search criteria to the current
mailbox or currently selectedmailboxes in the server pane.

Next Search
OptionbCommand-Y

Closesthe current mailbox and opens the next mailbox which
has searchresults from the last searchcarried out.

Rules Brings the rules manager window to the front, and shows it if it
was hidden.

Apply Rules Applies rules chosenfrom the sub-menu to the currently
selectedmessagesn a mailbox pane.

Make Rulesg Createsa new rule with searchcriteria setbasedon the
messagescurrently selectedin a mailbox pane
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6.4 Message Menu

Read Previous 3 [
Read Next 3£ |
Delete & Read Next 3/
Copy & Read Next 3,
Reply 46 R Seen Ml

Important 362
Answered TC3E3
Deleted N34

Reply to Sender
Reply to From

Reply to All KK -
Forward %) Draft N385
RE'.jirE[t 3] Labell
Reject . Label2
Send Again Label3
Create Digest Labeld
Move to Mailbox > Label5
Move Now {+38C Label6
Label?
Flags » — Label8
View Parts
Extract Parts 18
Decode Embedded P —  BinHex
Verify/Decrypt uu
Delete 38
Show Header C#H
Read Previous Displays the previous message in the mailbox in the active
Command- [ Messagepane.
Read Next Displays the next messagein the mailbox in the active message
Command-]  Pane
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Delete & Read Next

Deletesthe messageand displays the next messagein the
mailbox in the active messagepane.

Command-/
Copy & Read Next Copies the messageto the mailbox selectedin the OCopyToO
Command-\ pop-up menu, and displays the next message in the mailbox in
the active messagepane.
Reply Createsareply to the messagein the active messagepane. A
Command-R draft message window is created and the OTo:O and OSubject:O

fields automatically filled in.

Reply to Sender

Createsareply to the sender of the messagein the active )
messagepane. A draft messagewindow is created and the OTo:(
and OSubject:O fields automatically filled in.

Reply To From

Createsa reply to the OFrom:&ddress of the messagein the
active messagepane. A draft messagewindow is created and
the OTo:0 and OSubject:O fields automatically filled in.

Reply to All
Command-K

Createsareply to all the recipients and the sender of the
messagein the active messagepane. A draft messagewindow

is created and the OTo:0, OCc:O and OSubject:O fields automatis
filled in.

Forward
Command-J

Forwards the messagein the active messagepane. A new draft
message window is created and the OSubject:O field is
automatically filled in. The original message is automatically
guoted in the draft

Redirect

Bouncesthe messagein the active messagepane. A new draft
message window is created, the OSubject:O field is automatically
filled in, and the MIME parts of the original message are

included in the new message.

Send Again

Resendsthe messagein the active messagepane. A new draft
message window is created and all the fields filled in with the
samevalues asthe original message.

Create Digest

Makes a multipart/digest draft from the selectedmessagesn
the active mailbox pane.

Reject

Rejectsthe messageby returning a'delivery failed' status
messageto the sender.

Copy to Mailbox

Copies selectedmessagesin the active mailbox pane or the
messagein the active messagepane to the mailbox chosen
from the sub-menu.

Copy Now
Shift-Command- C

Copies the messagein the active messagepane to the mailbox
selectedin the OCopyToQpop-up menu in the active message
pane.
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Flags Changesflags or labels for the messagesselectedin the active
mailbox pane or the messagein the active messagepane.
View Parts View the parts selected in the parts list in the active message
pane in their respective applications.
Extract Parts Extracts the parts selected in the parts list in the active message
Command-:  Pane to disk.

Decode Embedded

Decodes the text currently displayed in a message pane as a
BinHex attachment, or a UU attachment basedon the choice
from the hierarchical menu.

Verify/Decrypt Verifies a digital signature or decrypts and encrypted message
part or the entire message.
(Only available if the PGP or S/MIME Plugins are present)

Delete Deletesthe messagein the active messagepane. This only flags

Command-D the messageas deleted, it does not permanently remove it

from the mailbox.

or

Undelete Undeletes the messagein the active messagepane.

Command-D

Show Header
OptionbCommand-H
or

Hide Header
OptionbCommand-H

Shows the email header of the messagein the active message
pane.

Hides the email header of the messagein the active message
pane.
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6.5 Draft Menu

Quote Original Message  1r 3£l

Insert Signature {1365 .
Plain
Add Cc Address Field Enriched
Add Becc Address Field HTML
Attach File... Mixed “C3EM
New Text Part P —
. Parallel
New Multipart r — Digest
Current Text Part p — 98t
Alternative
Send 3 M
Append to Mailbox b Plain
Append Now {3EM Plain Wrapped
Also Copy Original Message Enriched
. v HTML
Sign
Encrypt
Read Receipt
MNotifications p —
Delivery Success
Wrap Lines i A )
. Delivery Failure
Unwrap Lines i
: Delivery Delay
Quote Lines .
. Return Entire Message
Unguote Lines
Requote Lines {r 38
Shift Left {0 38 [
shift Right {r 28]
Font b
Size b
Style b
Alignment >
Colour b
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Quote Original Includes the message being replied to in the active draft
messagewindow. This will copy the text of the messagebeing
_ replied to into the active draft messagewindow at the selection
Shift-Command- | hoint and quote it using the quotation character.

Message

Insert Signature Inserts the signature for the current identity at the insertion
Shif-Command- S point in the text display.
Add CCAddress Field Add the Cc address field to the draft window if not already

present.

Add Bcc Address Field Add the Bcc address field to the draft if not already present.

Attach FileE Attaches a file to the active draft message window. Specified
files can be attached and sentwith the message.
New Text Part Adds a new MIME text part to the active draft message window
and switches the text display to the new part.
i Theaddedpartlsatext/plampart ...................................................................................
o Theaddedpart|satext/enr|chedpart ........................................................................
L Theaddedpart|satext/htm|part ....................................................................................
New Multipart Adds a MIME multipart part to the active draft message
window.
e Theaddedpart|samult|part/m|xedpart ..................................................................
OPHONDCOMMANG- M | eesssmsesmsesssesmsmssssesesesesssetmsesessetesesesssesesesnsesni
Parallel The added part is a multipart/parallel part.
oiges Theaddedpart|samuIt|part/d|gestpart ..................................................................
orrarive Theaddedpart|samu|t|part/a|ternat|vepart ......................................................
Current Text Part Change the formatting of the current text part.
i PlalnteXtW|thwrapp|ngtotheedgeofthecurrentwmeWWlII ..........
be used.
lain Wrappe PlalnteXtW|thwrapp|ngtotheflxedwrapIengthchosen|nthe .........
preferences will be used.
. e
o e
Send Sendsthe messagein the active draft messagewindow.
Command-M
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Append to Mailbox

Copies the draft messagein the active draft messagewindow
to the mailbox chosenfrom the sub-menu.

Append Now
Shift-Command-

Copies the draft messagein the active draft messagewindow
to the mailbox selectedin the OCopyToCpop-up menu in the
active draft messagewindow.

Also Copy Original

When turned on, the original messageof areply will be copied
into the chosenCopy to mailbox immediately before the copy

Message of the reply being sent.

Sign Digitally signs the current draft message.
(Only available if the PGP , GPG or S/MIME Plugins are present and
active)

Encrypt Encrypts the current draft message.

(Only available if the PGP , GPG or S/MIME Plugins are present and
active)

Notifications

Turns on Delivery Status Notifications for different delivery
conditions.

Read Receipt
Turns on or off the request for aread receipt when the
messageis read by arecipient.

Delivery Success
Selects a status notification for successful delivery.

Delivery Failure
Selects a status notification for failed delivery.

Delivery Delay
Selects a status notification for delayed delivery.

Return Entire Message
Turns on or off the return of the entire messageor just it
headers in the status notification.

Wrap Lines

Insert carriage returns into the selectedtext sothat eachline is
no longer than the wrap length specified in the preferences.

Unwrap Lines

Removescarriage returns from the selectedtext so that the text
can be reflowed within eachparagraph. Only one carriage
return will beremoved from a consecutive set of carriage
returns so that the paragraph formatting is unaffected.

Quote Lines

Inserts the currently defined quotation string at the start of
each line of selected text, and ensures that each line is
terminated by a carriage return and is no longer than the wrap
length specified in the preferences.
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Unquote Lines

Removesthe currently defined quotation string from the start
of each line of selected text.

Requote Lines
OptionbCommand- O

Performs the Unquote Lines, Unwrap Lines, and Quote
Lines commands in sequence.

Shift Left Removesa tab or an equivalent number of spacesfrom the
Shift-Command-[ start of eachline of selectedtext.
Shift Right Adds atab or an equivalent number of spacesto the start of

Shift-Command-]

each line of selected text, and ensures that each line is
terminated by a carriage return and is no longer than the wrap
length specified in the preferences.

Font

Changesthe font of the selectionin the active draft message
windowOs text display, when composing a styled text message.

Size

Changesthe font size of the selectionin the active draft
message windowOs text display, when composing a styled text
message.

Style

Changesthe text style of the selectionin the active draft
message windowOs text display, when composing a styled text
message.

Alignment

Changesthe line alignment of the selectionin the active draft
message windowOs text display, when composing a styled text
message.

Color

Changesthe text color of the selectionin the active draft
message windowOs text display, when composing a styled text
message.
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6.6 Address Menu

Address Book Manager

MNew Address Book
Open Address Book...
Rename Address Book...

Import Addresses b
Export Addresses >

Delete Address Book...

Login...
Logout
Refresh List

Synchronise. ..
Clear Disconnected...

Expand Address 36+
Capture Address {r3EA

Search for Addresses. ..

Address Book
Manager

Brings the address book manager window to the front, and
shows it if it was hidden.

New Address Book

Createsa new local or remote address book depending on
what is selectedin the Address Book Manager pane, or whether
any remote address book accounts are available.

Open Address Book

Createsa new local or remote address book depending on
what is selectedin the Address Book Manager pane, or whether
any remote address book accounts are available.

Rename Address
BookE

312

Renamesthe currently selectedaddressbooks in the address
book manager pane, or the active address book.
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Import Addresses

Imports addressesfrom a different format address book into
the active address book.

Export Addresses

Savesthe active address book in a different address book
format.

Delete Address

Deletesthe currently selectedaddressbooks in the address
book manager pane, or the active address book.

BookE
LoginE Logs in to the currently selectedremote address book server.
Logout Logs out from the currently selectedaddress book server.

Refresh List

Refreshesthe list of address books for the server selectedin the
address book manager pane.

SynchronizeE

Synchronizes any address books selectedin the address book
manager pane.

Clear DisconnectedE

Clearsthe disconnected address cachefor any address books
selectedin the address book manager pane.

Expand Address
Command-return

Expands an address in an address entry field by doing a search
of address books.

Capture Address
Shift-Command- A

Takesany selectedtext and extracts email addressesfrom it,
and then placesthose email addressesinto the address book
specified in the Preferences (see Section!4.10.2).

SearchE

Brings the address search window to the front, and shows it if it
was hidden.
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6.7 Calendar Menu

Calendar Manager
Subscribed Calendars

Create...
Rename...
Refresh List

Delete Calendar. ..

Add Web Calendar...
Refresh Web Calendar
Upload Web Calendar

MNew Event...
Mew To Do...
Edit Item...
Duplicate Item...
Delete Item...

Goto Today
Goto Date. ..

Calendar Manager

Displays the calendar store manager window.

Subscribed Calendars

Displays the subscribed calendar view window.

CreateE

Createsa new calendar.

RenameE

Renamesthe selectedcalendars.

Refresh List

Refreshes the list of calendars in the selected accounts.

Delete CalendarE

Deletes the selected calendars.

Add Web Calendar

Adds a web calendar via a URL.

Refresh Web Calendar

Refreshesthe content of the selectedweb calendars.

Upload Web Calendar

314

Uploads aweb calendar to its server.
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New EventE Createsa new event.

New To DoE Createsa new to do.

Edit ltemE Edits the selectedevent or to do.

Duplicate ItemE Duplicates the selectedevent or to do.

Delete ltemE Deletesthe selectedevent or to do.

Goto Today Switch the current calendar view to show a date range that
includes the current day.

Goto DateE Allows a date to be chosenand then switches the current
calendar view to show a date range that includes the chosen
day.
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6.8 Window Menu

Save Default Window Hide Toolbar
Reset To Default

Small lcons
Expand Window Header "_3A Show |
Show Parts CHB Shnw _In_:nr"lts
Show Quick Search it 3£ S R
/ v Show lcons & Text
Toolbars > _
Layout > v Use 3-pane Window
Hide List Use Separate Windows
E!ge ::EEITIIS v B List Vertical
ae Freview , .
. B List Horizontal
Options... _
B Items Vertical
v Status B ltems Horizontal
Mulberry (Connected) 20 B Preview Vertical
B Preview Horizontal
m All Vertical
B All Horizontal
WinDOWS & UNIX ONLY WinDows & UNIX ONLY
Cascade Stackthe windows one on top of another with a horizontal and
vertical offset between each.
WINDOWS & UNIX ONLY WINDOWS & UNIX ONLY
Tile Horizontally Tile the windows so they fill the full width of the main window.
WINDOWS & UNIX ONLY WINDOWS & UNIX ONLY
Tile Vertically Tile the windows so they fill the full height of the main window.

Save Default Window Saves the current windowQOs position and size as the default for
that type of window.

Reset to Default Resetsthe current windowOsposition and size to the default for
that type of window.
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Expand Header
OptionBbCommand-A

Collapses or expands the active windowOsheader area.

Show Parts
OptionbCommand-B

Collapses or expands the active windowOs or paneOs parts list.

Show Quick Search
Command-Shift-S

Shows or hides the quick searchareain a mailbox pane.

Toolbars

Controls the display of all toolbars in each window:

Show/Hide Toolbar
Shows or hides the entire toolbar in every window.

Small Icons
When selected, each toolbar will use small icons for
display in each button.

Show Icons
When selected, only icons will be displayed in every
toolbar button.

Show Text
When selected, only the name will be displayed in every
toolbar button.

Show Icons & Text
When selected, both names and icons will be displayed in
every toolbar button.

Layout

Mulberry Reference Guide v4

Controls the behavior of windows in Mulberry:

Use 3-Pane Window
Select this to use the 3-pane windowing mode in
Mulberry.

Use Separate Windows
Select this to use separate windows in Mulberry.

List Vertical
List Horizontal
ltems Vertical
ltems Horizontal
Preview Vertical
Preview Horizontal
All Vertical
All Horizontal
Thesecontrol the layout of panesin the 3-pane window.
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Show/Hide List

Shows or hides the list (server or address book manager) pane
in the 3-pane window.

Show/Hide Items

Shows or hides the items (mailbox or address book) pane in the
3-pane window.

Show/Hide Preview

Shows or hides the preview (messageor address)pane in the 3-
pane window, or in separatemailbox or address book
windows.

OptionsE

Displays adialog allowing options that control the behavior of
actions in windows.

Status

Shows or hides the Statuswindow basedon its current state. If
it is currently visible, this item will have a ! mark.

Other menu items

Other menu items correspond to other windows that are open.
Selectan item to bring the corresponding window to the front.
If an item appears in brackets O(...)O then the window is hidden.
Selectthe item to make the window visible again.
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6.9 Help Menu

Mulberry Help 367
Detailed Tooltips

Mulberry Online
Online FAQ
Check for Updates

Mulberry Support

About Mulberry

Displays a dialog with information about the Mulberry
application

About Plugins

Display information about the plugins currently loaded into
Mulberry.

Mulberry Help

Displays the online help system for Mulberry.

Detailed Tooltips

Turns on or off the display of tooltips in server and mailbox
panesdisplaying information about the mailbox or messageat
the location of the cursor.

Mulberry  Online

Displays the main Mulberry web pagein abrowser.

Online FAQ

Displays the Mulberry Frequently Asked Questions web page
in a browser.

Check for Updates

Displays information about the latest version of Mulberry
available, with an indication of whether the copy being used is
older than that.

Mulberry  Support

Createsadraft window with the draft addressedto the
Mulberry support email address, and containing information
about the state of Mulberry. The draft can be filled in with
information relating to any problem with Mulberry and sent.

Buy Mulberry

Displays the Mulberry Order Form web pagein a browser to
allow purchase of a license for Mulberry. This item only
appearswhen using a demo (unlicensed) copy of Mulberry.
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8. LICENSE

A separatelicense agreementis provided with this software. You must read the license
agreement and agreeto its terms before using the software.

9. DISCLAIMER

Whilst the developers have fully tested this software to the best of their ability there may
still be bugs. In no event will the develoeprs be liable to you for any consequential,
incidental or indirect damagesdue to the use of or inability to usethis software or
accompanying documentation.
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10. REPORTS or SUGGESTIONS

To get up-to-date information about Mulberry look at the Web page at:
http://www.mulberrymail.com

Here you canfind alist of known problems aswell asa list of features being considered for
future versions.

Mailing lists are available to promote discussion of Mulberry and related issues and for
announcements about Mulberry. A Frequently Asked Questions (FAQ) page is also
maintained. Information on all theseis available on the Web page:

http://www.mulberrymail.com/faq

If you have any comments or reports please email them to:

mailto:mulberry@mulberrymail. com

Mulberry is © Cyrus Daboo, 2006.
Mulberry is a Registered Trademark.
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11. INDEX

ACAP, 15, 26, 33, 35, 45, 46, 131, 132,153
AccessControl, 23, 24, 27, 148, 149, 150, 240, 266
Settingand Viewing, 148, 239, 266
ACLs. See AccessControl[Lists]
AddressBook Manager,61, 115, 122, 234, 235, 236, 238,
312, 313, 318
AddressBook Window, 122,234, 249
AddressBooks
Creatinga New AddressEntry, 251
Eudora,255, 256
Exporting Addresses241, 256, 313
Groups, 249, 252, 253, 256
Importing Addresses240, 255
Netscape 255, 256
Opening
On Startup,238
Pine, 255, 256
SavingAddressBooks, 256
Searching47, 48, 49, 91, 241, 242, 243, 245, 246,
313
Results, 245
Sorting Entriesand Groups,253
AddressFields, 57, 206, 224, 225, 244, 248, 250
Automatic Expansionand Collapseof, 206
Addresses|5, 20, 26, 47, 57, 72, 85, 86, 88, 91, 92, 93,
102, 115, 121, 155, 162, 169, 177, 190, 196, 198,
199, 204, 206, 214, 220, 222, 224, 225, 227, 235,
238, 239, 240, 241, 242, 243, 244, 245, 246, 247,
248, 249, 250, 252, 253, 254, 255, 256, 257, 286,
297, 313
Copying into Addressbooks20
PreferencesSee Preferences:Address
Searchingfor, 15, 26, 132
Administrative and ConfigurationInformation see also the
Mulberry Administrator’s Guide, 19, 20, 22, 29, 31, 36,
173
Aliases.See Nick-Names
Alt key uses,70, 91
AppendNow, 77,226,310
AppleDoubleEncoding,96
Attachments,15, 20, 53, 72, 79, 95, 97, 98, 99, 100,
123,165, 207, 210, 230, 233, 292, 293. See also
MIME
Saving, 98, 210, 211, 220, 306
Sending,229, 231
Viewing in a Message;165
Binhex EncodedMessages221, 306
Bounce,216
Bulletin Boards.See Mailboxes;seealso AccessControl
Cabinet,52, 55, 65, 128, 139, 140, 141, 153, 172, 188,
302
CalDAV, 15, 27, 28, 35, 50, 132,261
Calendar,1, 26, 28, 50, 94, 111,112,116, 117,122,
257, 258, 260, 261, 262, 263, 264, 265, 266, 267,
268, 280, 281, 289, 290, 292, 314
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CC Field, Sortingon, 162

Column Headers,126, 127, 129, 158, 160, 161, 235, 242,
244, 250, 251, 259
ServerWindow, 126

Configuration, 25, 26, 31, 105, 106, 195

ContextMenu, 21, 127, 161, 232, 235, 245, 250, 259

Copy Now, 305

Copying MessagesSee also Messages:Copying
Copy To Pop-Upand Options, 65, 87, 140, 144, 226,

227, 305, 310

CRAM-MD5, 29, 36

Deletekey, usesof, 164, 201, 202, 246

Deletedmessages
Display style, 57

Delivery StatusNotifications, 88, 89

Desktop, Macintosh, 164, 181

Dial-in Protocolssee also Network Protocols,16

Digests.See Mail Digests

Directory Separator38

Directory Servicessee also LDAP, IMSP, 26, 38

DisconnectedOperations 23, 24, 28, 38, 41, 46, 50, 67,
144,151, 152, 153, 154, 155, 239, 295, 301, 313

Display Hierarchies,24, 133

Display Options.See Preferences:Displagndindividual
window entries

Display PreferencesSee Preferences:Display

Downloadingfiles and parts.See Attachments:Saving

Draft (IMAP Messagd-lag), 165,179

Draft Menu, 307

Draft Messagesl9, 70, 73, 77, 78, 79, 80, 105, 214,
216, 222, 226, 227, 229, 231, 233, 244, 246, 247,
248, 249, 250, 251, 252, 253, 256, 257, 294, 295,
297, 305, 309, 310, 311
Creatingwith AddressBooks, 249
Saving, 232

Draft Window, 222

Drag and Drop capabilities, 15, 20, 84, 110, 112, 140,
141, 164, 180, 181, 189, 193, 206, 210, 220, 231,
246, 247, 252, 253, 257

Edit Menu, 296

Email AddressesSee also Addresses
AcceptableFormats,225

Email, is our life. pp. I-

EudoraSee AddressBooks:Eudora

ExpungingMessages40, 64, 149, 158, 181, 186, 301

Favourite Folders,56, 126, 139, 157, 188, 302

Favourites.See New Mail Checking

FCC.See Messages:Copying:AutomatltiBOX Reply
Copying

File Menu, 294

Files. See also AttachmentsSee also Draft Messages
Saving Multiple, 164

Filters. See Rules

Finder, Macintosh, 20, 33, 164, 181, 210, 220, 233

Finding AddressesSee AddressBooks:Searching
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Flags.See also individual flag names
ChangingMessageFlags, 181
Flags,IMAP, 30, 56, 65, 114, 121, 148, 152, 158, 159,
164, 169, 181, 183, 184, 186, 220
Folders.See Mailboxes
Font. See also Preferences:Display
FormattedText. See also StyledTextSee also URLS,
Headers, Quoted Text
Defined, 212
Forward,220
From field, changingvalues.See also Identities
From/To.See SmartAddresses
Groups.See AddressBooks:Groups
Headers
Fields
Cycling through.See Tab key configuration
Display Styles, 60, 212
Savingwith a message71
ShowingMessageHeaderdn awindow, 71
Help, 18, 22, 25, 27, 107, 128, 165, 319
Help Menu, 319
HierarchiesSee Mailboxes:Hierarchiesand
Mailboxes:Lists
Hierarchy
SeparatoCharactersSee Directory Separator
HTML. See Styled Text:HTML
Hyper Text TransferProtocol,27
Identities, 28, 39, 78, 79, 82, 84, 85, 86, 87, 88, 89, 90,
144,196, 198, 199, 227, 228, 229, 262, 291, 292,
309
PreferencesSee Preferences:ldentities
IMAP, 15, 21, 23, 24, 25, 26, 28, 35, 38, 39, 68, 113,
125, 127,128, 129, 131, 132, 133, 135, 137, 140,
142, 143, 144, 146, 151, 152, 153, 154, 160, 165,
173, 191, 207, 229, 231
CAPABILITY optionssee also AccessControl and
Quota, 146
Servers,146
ServerNames,35
Servers,21, 23, 24, 113, 125, 128, 131, 133, 137,
142, 144, 152, 165, 173, 191, 207, 229, 231
IMSP, 15, 21, 26, 33, 35, 44, 45, 46, 131,132,153
INBOX, 51, 64, 79, 104, 120, 124,125,129, 131, 132,
133, 138, 141, 191
Installation of Mulberry, 17, 18
Internet Config, 25
InternetMessageAccessProtocol.See IMAP
InternetMessageSupportProtocol.See IMSP
InternetPreferencesSee InternetConfig
Kerberos,29, 36, 37
LDAP, 15, 26, 35, 47, 48, 49, 92, 132, 243
Displayingraw LDAP schema49
Lightweight Directory AccessProtocol.See LDAP
List Mail, Sorting.See MessageWindow:Columns
Local mailboxes,160
Logins, 38, 46, 50, 131
Logouts, 28, 125, 241, 313
Macintosh System Compatibilities, 16
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Mail Checking
Automatic, 144
Mail Digests,Creating,72, 181, 229
Mailbox Window, 52, 57, 58, 63, 140, 158
Mailboxes
Creating, 137
Lists of, 23, 126, 128,129, 132, 137, 138, 153, 155,
211, 301
Searching,166
SearchingPlaces to Search, 135
Settingthe Numberof Messageso Display, 166
Status,146, 263
Memory Requirements16, 166
MessageNindow
HeaderControls, 159
SelectingMessages163
Sorting, 162
message/rfc822MIME type), 70, 216, 231
Messages
Copying, 20
AutomaticINBOX Reply Copying,79
Delete Options, 71
Deleting, 156, 179, 201, 213, 218, 241, 256
Manipulating (general),164
Navigating Between,218
Opening, 179
Printing, 180, 218
Read-OnlyPrivileges,158, 213
Replying, 214
Multiple Recipients,215
Saving, 218
File Extensions,70
Mac OS File CreatorType, 69
Searching,166
Sending,43, 79, 97, 226
Sentmail indicator, 226
Size Limits, 70
Undeleting,179, 180
Wrap Length, 77
Message®Window
Display Style, 166
MIME, 15, 24, 25, 29, 82, 83, 96, 97, 99, 100, 204, 207,
208, 209, 210, 211, 212, 214, 222, 223, 229, 230,
231, 305, 306, 309, 310. See Multipurposelnternet
Mail Extensions
CreatingMIME Multiparts, 231
Editing MIME Information, 230
Mappings, 100, 106
Mappingsbetweerfile typesand MIME types,99
Multiparts, 71, 72, 82, 83, 208, 210, 231, 305, 309
Modems,see also Dial-In Protocols,16, 67, 163, 166
MouseButton, Right. See ContextMenu
multipart/alternativeMIME structures,71, 309
multipart/appledouble210
multipart/digest,72, 305, 309
MultipurposelnternetMail ExtensionsseeMIME see also
InternetConfig see also Attachments
Defined, 24
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Navigation BetweenMessages204
NetscapeSee AddressBooks:Netscape
Network, 16, 21, 29, 68, 123
CancelingNetwork Operations 21
Errors, 226
Network Protocols,16, 17
New Mail Checking,156, 180
Automatic, 126
New Messagédndicator(ServerWindow), 145
New MessagesSee Draft Messages
Nick-Names,48, 225, 235, 238, 248, 251, 252, 254, 288
Using in AddressBook Searching238
NOTES
Specialadvisorynotesare on thesepages-, 19, 20, 29,
35, 39, 43, 82, 86, 89, 125,127,128, 129, 130,
131, 133, 137, 140, 141, 142, 143, 159, 162, 163,
186, 206, 208, 211, 212, 213, 214, 215, 217, 226,
229, 230, 236, 248, 260, 261, 279
NTLM, 29, 36
Option Key uses,70, 91, 149, 164
OutgoingQueues43, 182,295
PartsTablesee also MIME, 207,208
Display, 211
Passwords
MatchingUserID andPasswords35
Pine.See AddressBooks:Pine
Port Numbers,35
PostOffice Protocol(POP),15, 23, 24, 25, 28, 35, 38, 40,
41, 42, 68, 93, 125,127,128, 131, 133, 146, 154,
160
Preferences]5, 18, 19, 26, 28, 30, 31, 32, 33, 36, 37,
44, 54,58, 123,124,129, 131, 142, 146, 158, 162,
164, 166, 175, 188, 207, 208, 211, 212, 213, 215,
216, 217, 225, 226, 227, 232, 260, 272, 274, 275,
277,292, 295, 297, 309, 310, 311, 313
Identities, 84
Local vs. Remote,33
Outgoing, 224
Remote,21, 33, 132
Saving, 33
Prefixes, 77
Printing, 70, 75, 77, 180, 218
Messages 180
Quota, 24, 142,143,150
Quoted Text
Optionswhen replying, 215
Raw Text, defined,212
Recent(IMAP MessageFlag), 165
REFERENCEsectionsappearon thesepages-, 1, 112,
156, 179, 201, 218, 232, 240, 246, 255
Registry.See  Windows Registry
RemotePreferencesSee Preferences:Remotte also
IMSP
Replyingto a Messagesee also Messages Replying
Choosingfrom Multiple Addresses70
Reply-Tofield, 86, 90, 196, 214,219
Returnkey, usesof, 156, 164, 179, 240, 244, 246
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Rules, 169, 174, 184, 185, 187, 189, 190, 191, 192, 193,
194, 200, 303
RulesManagerWindow, 191, 192
Scripts, 191
Triggers, 185, 187, 188, 189, 192, 193, 200, 201
SearchWindow, 166
Searching
AddressesSee AddressBooks:Searching
Mailboxes. See Mailboxes:Searching
MessagesSee Messages:Searching
Security, 28, 29, 82, 86, 89, 207
Seen(IMAP Messagd-lag), 165
SeenMail folder, setting.See
Messages:Copying:AutomatiNBOX Reply Copying
SendAgain, 21, 216, 220
Sendeffield, 219
SendingMessagesSee Messages:Sending
Sent-Mail Folder. See Messages:Copying:Moving
Automatically
ServerWindow, 117,124,125
SharedFolders.See AccessControl, Quota,and
Subscriptions,Mailbox
SIEVE, 184,190, 191, 192, 193, 194, 201, 202
Simple Mail TransportProtocol.See SMTP
Slash(/) character38
SmartAddresses85, 162
SMTP, 15, 21, 25, 28, 35, 43, 86, 89, 132,182, 183, 207
Sorting
AddressBook Entries, 253
AscendingOrder, 162
DescendingOrder,162
Messages]162
SpecialMailboxes. See Subscriptions Mailbox
SpeechSupport,17, 53, 104, 105, 106, 186, 286, 298
SSL, 29, 36, 83, 147, 264
Stationery.See Draft Messages
StatusLine, 123
StatusWindow, 123
Styled Text, 60, 61, 62, 80, 165, 166, 207, 211, 212,
213,232,311
Displaying as default, 71
Generatingmultipart/alternativesg81
HTML, 61, 62, 80, 81, 309
Text/Enriched,61, 62, 80, 309
Toggling betweenformattedand plain text displays,
207
Subjectheader,163, 206, 224
Subscribe See Subscriptions Mailbox:Subscribing
SubscriptionsMailbox, 23, 51, 112, 124, 125, 129, 130,
132, 140, 146, 156, 259, 262, 263, 267, 268, 293,
302, 314
Subscribing,27, 138, 156, 302
Unsubscribing,156, 302
SystemRequirements16
SystemSoftware,16
SystemSoftwaresee also WindowsNT, Windows95 and
Windows 98, 17
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TCP/IP see also Network Protocolsand Dial-In Protocols,
16, 17

TemplatesSee Draft IMAP Messagéd-lag)

Text
Composing.See Draft Messageand Messages:Drafts
Copying, 20

Text Alternativessee also multipart alternatives213

Text Clipping (Mac OS feature),181

Text Display, 121, 204, 231

Text Files, Macintoshfile creation,69

text/enrichedSee Styled Text:Text/Enriched

text/html see also Styled Text
HTML, 61, 62, 80, 81, 309

text/plain MIME parts, 80, 81
viewing parts, 231

Three-Panel07, 111, 317

Toolbars,109, 113, 114, 115, 116, 117, 121, 124, 125,
158, 193, 204, 223, 234, 235, 249, 258, 268, 317
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Trash,Emptying.See ExpungingMessages
UID Validity, 146
Uniform Resourcd_ocators.See URLS
Unseen(IMAP Messaged-lag), 165
UnseenMessagdndicator (ServerWindow), 126, 145
UnsubscribeSee Subscriptions Mailbox:Unsubcribing
URLs, 19, 27, 49, 50, 60, 79, 97, 212, 213, 254, 265,
267, 314
Recognizing,60, 212
UUEncodedMessages221, 306
WebDAV, 15, 27, 28, 35, 50, 132, 261
Window Positions
Resettingto Factory Defaults,110, 316
Saving Default, 204, 222, 316
WindowsNT, 16, 17
Windows Registry, 33
Wrap Length.See Messages:Wrapength
X-Headers87
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